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Abstract

The development of Serial Block Face Scanning Electron Microscopy (SBF-SEM)
allows for acquisition of serially sectioned, imaged data of ultrastructure at high
resolution. In this project, optimisation of both SBF-SEM methodology and 3-D image
segmentation analysis was applied to the ultrastructural examination of two types of
biological tissues, each requiring a different experimental approach. The first project
was a connectomic based study, to determine the relationship between the neurons
that synapse upon the Lobula Giant Movement Detector 2 (LGMD 2) neuron, within
the optic lobe of the locust. A substantial portion of the LGMD 2 neuron was
reconstructed along with the afferent neurons, enabling the discovery of retinotopic
mapping from the photoreceptors of the eye onto the LGMD 2 neuron. A sub-class of
afferent neurons was also found, most likely vital in the process of signal integration
across the large LGMD 2 neuron. For the second project, two types of skeletal
muscle (psoas and soleus) obtained from fetal and adult guinea pigs were analysed
to assess tissue-specific changes in mitochondrial morphology with muscle
maturation. Distinct mitochondrial shapes were found across both muscles and age
groups and a classification system was developed. It was found that, in both
muscles, by late fetal gestation the mitochondrial network is well developed and akin
to that found in the adult. Quantitative and qualitative differences in mitochondria
morphology and complexity were found between the two muscles in the adult group.
These differences are likely to be related to functional specialisation. All data
collected during the experiments have also been made available online on Zenodo,
roughly 240GB, which can be used for further studies. Overall SBF-SEM was proven
to be a robust method of gaining new insights into the ultrastructure in both models

and has wide ranging capabilities for a variety of experimental objectives.
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Chapter 1. Introduction

1.1. Electron Microscopy

1.1.1. Development of Electron Microscopy and 3D-Electron Microscopy

The ambition of scientists to visualise subcellular structures at nanometre (nm)
resolution led to the development of Electron Microscopy (EM). An electron beam to
image was first utilised in the early 1930s with the development of the Transmission
Electron Microscope (TEM) (Knoll and Ruska, 1932) and followed by the invention of
the Scanning Electron Microscope (SEM) (von Ardenne, 1938). Since these first
introductions of electron microscopes in the 1930s they have continued to develop
and are now commonly used in a wide range of research areas. Both methods
produce high resolution images of the ultrastructure of biological tissues and have
answered many questions about the structure and function of cells and their

organelles.

Although both TEM and SEM each use electrons as their energy source, the
principles of application and subsequent images differ between the two techniques.
TEM, as the name suggests, works by transmitting electrons through a thin section of
tissue. The intention is to reveal spatial detail at nanometre resolution of intracellular
and intercellular structures in biological specimens. To do this, the tissue has to be
less than 100nm thick, and the electron beam has to be presented at a high voltage
for the electrons to penetrate through the tissue. In areas of higher electron density,
such as cell membranes, fewer electrons are transmitted through and these areas
appear darker in the 2D image produced. Whereas areas of lower electron density,

meaning more electrons pass through, appear lighter.

In the early stages of TEM, one of the major limitations was the need to have the
specimen to be thin for the beam to penetrate the sample and for tissue fixation and
staining procedures to be optimised to this end (Hall et al., 1946). A new embedding
method, using methacrylic resin as a medium, (Newman et al., 1949) combined with
a microtome and glass knife (Porter and Blum, 1953) allowed for thinner sections of
the resin embedded fixed tissue to be reliably prepared for analysis by TEM. The
fixation and preservation of sample membranes were first improved with the use of
Osmium Tetroxide, which both fixes and stains biological material (Palade, 1952).
This was followed by the development of the dual fixation method, where primary

aldehyde fixation is followed by post-fixation with osmium tetroxide (Sabatini et al.,



1963). Improved contrasting and staining of samples for visualisation started with the
shadow staining method developed by Williams and Wyckoff (1946), using metals to
stain samples. Following this it was found that the heavy metals lead and uranyl
acetate greatly improved membrane contrast (Cattini and Davies, 1983, Cattini and
Davies, 1984). The combination of dual fixation with subsequent staining with heavy
metals is the most commonly used method for sample preparation for TEM at
present. Fixation and staining are discussed in further sections of this Introduction

and for a review of developments in conventional TEM see Harris (2015).

In contrast to TEM, SEM uses an electron beam at a lower voltage. For SEM studies
the electrons need only to interact with the surface of the specimen, with minimal
penetration, so as to either examine the surface topology or the composition of the
samples. Within the SEM there are two types of electrons that are detectable, which
produce different images. These are backscattered and secondary electrons.
Backscattered electrons occur when electrons, originating from the beam, interact
with the sample surface, subsequently losing some of their energy and are scattered
backwards. These back-scattered electrons are then detected and indicate the
composition of the sample. Areas of the sample containing heavier elements will
result in the incident electrons having a higher energy loss, shown as lighter regions
in the final image. On the other hand, the secondary electrons originate from the
sample. When the electron beam interacts with the sample, electrons within the
sample become ionised and leave the sample. The topology of the sample will affect
the number of secondary electrons that leave the sample and are detected. Areas of
‘rises’ or ‘peaks’ in the sample produce more secondary electrons, as they have
more routes to exit the sample, whereas flatter surfaces produce fewer secondary
electrons. The higher surfaces will appear lighter and the flatter surfaces darker,
giving an indication of the overall shape of the sample as the beam scans the sample
and producing a 3D image. As with the TEM, techniques and protocols required for

the SEM have been optimised over time, for a review of these see Pawley (1997).

Both TEM and SEM share a restriction in the z direction that limits the ability of the
EM community to obtain data in three spatial dimensions (x-y-z) at the ultrastructural
level. Serial microtome sectioning and sequential TEM imaging of the sections, has
been used to try and overcome this. It results in a stack of images that can be
analysed to produce information in the z-axis (White et al., 1986, Kristen and
Stevens, 1988, Chklovskii et al., 2010, Rivera-Alba et al., 2011). However manually



sectioning and imaging consecutive sections is extremely time consuming and
challenging (e.g., aligning serial images and accounting for missing or damaged
sections). Recently serial section TEM (ssTEM) was used to create a dataset
encompassing the entire brain of Drosophila melongaster (Zheng et al., 2018),
around 7062 sections at 40nm thickness and 21 million images at 4nm resolution

were taken to produce the dataset: this took around 16 months.

To combat the limitations of using ssTEM, a method combining automated sectioning
and imaging was developed. This has been termed Serial Block Face Scanning
Electron Microscopy (SBF-SEM). The principle of combining a microtome within an
SEM was first rudimentary developed by Kuzirian and Leighton (1983) and opened
the way towards further developments of SBF-SEM (Denk and Horstmann, 2004).
The SBF-SEM combines an ultra-microtome with an SEM. The knife cuts ultrathin
sections from a piece of tissue embedded in a resin block, an electron beam scans
the block surface, and a detector records the back-scattered electrons, producing a
digital image. This process is repeated at an operator-specified depth to produce a
digitised stack of aligned images. It is possible to obtain tens to hundreds of serial
sections from resin blocks, and aligned digitised images, in a few hours. Since the
development of SBF-SEM there have been other 3D-EM methods formed, shown in

Figure 1.1.

10



Figure 1.1 — Diagram of 3D-EM techniques. (A) Shows SBF-SEM, with the
block face being imaged using electron interaction from an electron beam (green)
upon the sample surface being detected and producing an image. This is
followed by a knife-cut and the new face imaged and repeated to get the stack.
(B) Shows FIB-SEM, where the block is milled by an ion beam (blue) and then
imaged using an electron beam (green). (C) Principle behind serial section SEM
or TEM, where multiple sections are produced on a microtome and then taken
into an electron microscope to be imaged. (D) The multi-beam SEM (mMSEM)
splits the beam so that a larger area of a single section can be imaged at high
resolution.

11



A similar method to SBF-SEM is the Focused lon Beam-SEM (FIB-SEM), in that it
combines sectioning and imaging in one modality. Unlike in the SBF-SEM system,
the FIB-SEM system has an ion beam that mills the sample creating a trench
followed by an electron beam that scans the surface (Knott et al., 2011). By using an
ion beam instead of a diamond knife, thinner areas of the sample can be removed.
Initially 20nm thickness was achieved (Knott et al., 2008) but more recent FIB-SEM
studies have shown sections of the tissue, 5nm and below can be milled by the beam
(Rennie et al., 2014, Vanslembrouck et al., 2018). The FIB-SEM can produce
isotropic voxels, meaning they are the same length in x, y and Z, and this reduces
any loss of detail in the Z resolution. However, the FIB-SEM is limited in the size of
the area that can be milled away by the beam, roughly 100um by 100um, restricting
the area available for imaging to this size. This is significantly smaller than SBF-SEM,
which has a cutting area dependent on the width of the knife, which is 2mm in
standard SBF-SEM machines, although it is recommended for samples in SBF-SEM

to be below this.

A disadvantage of both SBF-SEM and FIB-SEM is that no physical section remains
after the cutting or milling, and the sample is lost and cannot be re-imaged for
additional analysis. Serial sectioning has previously been combined with SEM to try
and address this (Horstmann et al., 2012, Kuwajima et al., 2013a, Kuwajima et al.,
2013b, Hildebrand et al., 2017) but, as with serial sectioning for TEM, errors can
occur in collection of the sections. To reduce the error rate, an automated method for
sectioning was developed, the ATUMtome. The ATUMtome combines a tape
collection system with a microtome (Hayworth et al., 2014, Kasthuri et al., 2015,
Joesch et al., 2016, Vishwanathan et al., 2017). As sections are cut, they are
deposited onto the tape situated close to the knife. The tape is constantly moving as
the sample is sectioned, resulting in a reel of tape with sections in their cutting order
on top. The number and thickness of sections to be taken can be programmed into
the microtome and left to run. As the sectioning occurs without the presence of an
electron beam, the resin remains stable allowing for acquisition of thin sections,
roughly 30nm. The tape is collected, cut and placed on specially designed wafers,
which are then imaged in a SEM. The sections of the sample can be kept and re-
imaged multiple times without damage. The tape mechanism reduces the rate of
error seen in the manual sectioning used for 3D TEM work, but there is still
compression on the sections caused by the knife (Jesior, 1989, Studer and Gnaegi,

2000) and potential for missing or damaged sections. In contrast, as SBF microscopy

12



images the block face and not the sections, this problem does not occur and is only

seen in the ATUMtome and serial section TEM or SEM methods.

For serial sectioning, as with the SBF-SEM, the size of the sample is restricted to the
width of the knife and the cutting window although this can be up to 4mm wide for the
ATUMtome. With the ability to cut larger samples there is a need to be able to
increase imaging size and output from the serial section methods. For this, a new
technique was developed known as the multi-beam SEM (mSEM) (Eberle et al.,
2015, Pereira et al., 2016, Haehn et al., 2017). The mSEM works by splitting the
electron beam into multi-beams which can scan an area of the section and collect
data simultaneously. This allows for acquisition of a larger area of a sample, up to
3mm? has been achieved so far (Eberle et al., 2015), with a 1mm? of rat cortex also
acquired using mSEM (Schalek et al., 2016). Another limitation for all 3D-EM
techniques is the preparation of the sample. Currently the size of the samples that
can be reliably stained with heavy metals is limited to around 1um?3 (Hua et al., 2015),
however this is continually being improved upon (Mikula and Denk, 2015). Overall,
current automated methods for collection of 3D-EM data are continually being

improved upon and new methods developed.
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1.1.2. Serial Block Face-Scanning Electron Microscopy

When comparing the automated 3D-EM techniques widely available, SBF-SEM is the
most applicable technique to be used for a range of experiments. It has a wider field
of view than FIB-SEM and larger datasets, in X, y and z, can be collected. A single
SBF-SEM dataset can cover a larger area of the sample and reduce the need for
multiple datasets, samples and animals for experiments. Although FIB-SEM has
superior resolution capabilities in both directions, a single SBF-SEM block face can
be imaged multiple times at different magnifications and resolutions, taking both low-
and high-resolution images if needed. This makes SBF-SEM appropriate for imaging
structures that are both large and small within the same dataset, such as a large
neuron (>7um in diameter) and the smaller neurons and processes extending from it
(<1um in diameter) or a large muscle cell (>40um in diameter) and small organelles
such as mitochondria (0.5-2um in diameter). To cover as many potential experiments
as possible SBF-SEM is the most appropriate technique to use and was chosen for

this reason.

With the development of any new technique the steps required to obtain information
using it have to be developed. This is the case for how a sample is processed for
imaging using SBF-SEM and the data collected analysed. A sample for SBF-SEM
has to be processed accordingly to withstand the serial sectioning and imaging it
undergoes within the microscope. First, the tissue is fixed. For EM tissue fixation is
with glutaraldehyde (Hayat, 1986) or a combination of glutaraldehyde and
formaldehyde or paraformaldehyde (Wilke et al., 2013, Wernitznig et al., 2016),
depending on the sample type. Another option of fixation that has been used to fix
material is high pressure freezing (McDonald, 2007, Mdbius, 2009) or freeze
substitution has also been used to fix material for SBF-SEM (McDonald and Webb,
2011). Following fixation, the samples are then processed with a number of heavy
metals, so that the membranes and organelles can be visualised under the SEM

beam.

Processing the sample for SBF-SEM depends upon sample type and specific
staining requirements for the experiment. The most common protocol followed is the
reduced osmium, thiocarbohydrazide, osmium (rOTO) with lead and uranyl acetate
(Wilke et al., 2013). The first step is reduced osmium tetroxide, a combination of
osmium with either potassium ferricyanide (Rivlin and Raymond, 1987) or

ferrocyanide (Goldfischer et al., 1981), a reducing agent (White et al., 1979). Osmium
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tetroxide acts as both a fixative and a stain, readily binding to and staining cellular
structures and membranes (Litman and Barrnett, 1972, Geissinger et al., 1983). The
first step is followed by thiocarbohydrazide (TCH) and a secondary osmium step
(Friedman and Ellisman, 1981, Furness and Hackney, 1986). The TCH acts as a
ligand, bridging membrane bound osmium (from the first step) with osmium from the
second osmium infiltration, increasing the amount of osmium present in the sample
(Seligman et al., 1966). Following rOTO, uranyl acetate is added, which interacts with
osmium tetroxide, preserving structure and adding additional staining (Hayat, 1981,
Cattini and Davies, 1984). The last heavy metal is lead, added in combination with an
acid to increase penetration and stability of the metal (Karnovsky, 1961). As with the
other heavy metals, lead stains the sample and improves conductivity of the sample
(Walton, 1979, Cattini and Davies, 1983).

The heavy metal protocol layers the chemicals on top of samples which can thicken
the appearances of membranes. This can reduce the visibility of smaller structures
(e.g., ribosomes) and make it more difficult to determine separate cells in dense
areas, differentiate between membranes, and visualise small structures such as
synaptic vesicles and smaller organelles within cells. Thus, there are continual
developments in the heavy metal protocol being adapted to different tissue types and
also with experimental need. The size of a sample is becoming less of a restriction
due to the development of large tissue staining procedures such as that applied to
whole mouse brain staining (Mikula and Denk, 2015, Hua et al., 2015). The addition
or change of specific metals can also improve the visibility of certain structures, such
as addition of tannic acid to improve membrane visibility (Geissinger et al., 1983,
Stirling, 1993), platinum blue for chromosomes (Yusuf et al., 2014) and dithizone for
staining islets in the pancreas (Laif et al., 1988, Pisania et al., 2010) . The
introduction of microwave processing decreases the sample preparation time and is
becoming commonly used. However, it has to be treated with caution as to how it
may affect the heavy metal interactions with structures, with each other and also the
sample type. It is a benefit of the heavy metal staining procedure that it still lends the
sample open to examination, should the experimenter wish (e.g., to obtain highest

resolution images of specific areas of interest), by TEM.

Once the tissue samples are processed with the heavy metals and dehydrated with
acetone or ethanol they are embedded into a hard resin and polymerised. The resin

used has to be hard to account for the time spent under the electron beam and the
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sectioning within the chamber. Once embedded the resin block is trimmed, so as to
fit on pins specially designed for SBF-SEM. The size of the block on the pin is limited
by the size of the knife (2mm) and cutting area (1-2mm) and is typically <0.75mm by
<0.75mm. The sample and the pin are then coated in silver and/or gold, to increase
conductivity of the sample and reduce the charging due to the electron beam
interaction with the sample (Braten, 1978, Titze and Denk, 2013).

The entire process from sample collection to sectioning can last more than 5 days,
using the standard bench processing. The heavy metal staining and resin embedding
steps take 3 to 4 days, followed by at least 48 hours in the oven for the resin
polymerisation step. However the use of a microwave can speed up the processing
greatly (Webster, 2014). Microwave assisted processing has been widely used in
electron microscopy to improve fixation and staining penetration into the sample,

reducing the time and allowing for larger sample sizes.

Once placed inside the microscope, the electron beam interacts with the heavy
metals within the sample, and this produces the back-scattered electrons that are
detected to form an image of the sample surface (Pawley, 1997, Denk and
Horstmann, 2004, Wilke et al., 2013). As mentioned previously, the heavier elements
appear lighter, so in the resulting image the electron dense areas have been stained
more by the heavy metals and so appear white. The result is then inverted into a
TEM-like image, which biologists are accustomed to (Denk and Horstmann, 2004).
the imaging parameters and cutting thickness all depend upon the objectives of the

experiment and also the type of sample. This is discussed further in the methods.

In many ways the challenges of 3D-EM have now shifted from how to capture the
difficult-to-measure to what to do with all this data? At the outset of an experiment
one, ideally, needs to know how the resultant images are to be analysed. These
considerations vary from simple to complex, depending upon the experimental
question, the tissue or cell constituency, the resolutions of structures of interest and

their contrast to neighbouring structures.

The dataset obtained can be visualised in a number of ways. The series of images
can be viewed sequentially to gain information on appearance of the tissue, cells and
organelles. The 3D stack can be further analysed by segmenting the structures of
interest and creating 3D reconstructions, which can yield volumetric, surface area

and length measurements. There are a number of software packages available to
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perform this type of analysis, ranging from freeware to licensed software (Borrett and
Hughes, 2016). Segmentation is the process of annotating a specific structure on

each image so as to follow it in each consecutive image in the z-axis.

The segmentation can be achieved using a variety of tools, primarily depending upon
the nature of the subject, for example its contrast and size (Tsai et al., 2014, Cocks
et al., 2018). The labelling of the structure can occur in two ways, depending on the
software being used and regardless of the method of segmentation. In the first
method, the object is segmented by adding a coloured layer on top of the image. A
single structure can be attributed to multiple labels if the structures overlap, for
example a nucleolus within a nucleus. In the other labelling process, the individual
image pixels are assigned to one structure. If a pixel is reselected during further
segmentation, it will be reassigned to the new model. This allows for mistakes made
during segmentation, such as incorrect labelling, to be corrected. However, when
segmenting a larger object and smaller target structures contained within, such as a
cell and its’ organelles, if the cell is segmented first, then followed by the organelles
the resulting cell model will be minus the pixels selected after during segmentation of
organelles. The method of labelling utilised has to be known and understood by the

user prior to starting segmentation.

The methods of segmentation can be divided into manual, semi-automated and
automated categories. Manual segmentation tools require the user to annotate the
object by hand, e.g., by colouring the object in over every section. Semi-automated
tools use a combination of user input and program predictions, to highlight a
structure. An example of this is interpolation. The user manually annotates the
structure every nth slice and the program will fill in the empty slices using the
annotated image as a guide to predict the possible shape of the object. Another is
the thresholding tool, which selects pixels based on the contrast limits set by the
user. These limits allow for the selection of light or dark pixels depending on the
appearance of the object. There is the option available in some programs for
machine learning automated segmentation. Here, the program ‘learns’ object
selection based on trial runs performed by the user on a sample dataset. These
settings are then automatically applied to the full dataset to be analysed and can be
implemented on other datasets as well. There has been a rise in the development
and use of semi-automated and automated segmentation programs for analysing
SBF-SEM data (Berning et al., 2015, Kasthuri et al., 2015, Kaynig et al., 2015,
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Hussain et al., 2018, Krasowski et al., 2018). Although the majority of these

programs are targeted towards segmentation of neural data.

Manual segmentation requires an individual or individuals to draw around a structure
of interest over each section, which is time consuming and is currently the largest
limitation for all 3D-EM techniques. Hence the drive-in recent years to develop
software for more automated methods of segmentation (Berning et al., 2015,
Kasthuri et al., 2015, Kaynig et al., 2015, Beier et al., 2017, Dorkenwald et al., 2017,
Hussain et al., 2018). However, some the programs developed and made available
to people to use can be difficult for novices or those with limited computing
background, often requiring some knowledge of coding to run the software. In
addition, the majority of the newer software is based solely on neuronal datasets and
focuses on the dense segmentation these types of experiments need, such as
webknossos (Boergens et al., 2017) and SegEM (Berning et al., 2015). However,
with the increasing use of 3D-EM for experiments outside of the brain and nervous

system a program that can be used to segment a range of datasets is needed.

A subsequent factor in the imaging parameters is the computing power available.
Both an image at high resolution and low magnification and a long series of images
(regardless of size) will result in large data. Large datasets can be difficult to store
and for analysing, due to small computer processing or graphics card memory size,
for example <16GB RAM. This can be alleviated by the use of cloud storage for
storing the data and running analysis and use of high-powered computers (>32GB

RAM) with multiple graphics cards.

Overall, analysis of SBF-SEM data is the most time-consuming portion. Datasets can
range in size from a few sections (<50), to several 1000 sections. The most popular
segmentation method is manual, and sometimes used in conjunction with semi-
automated or automated methods as well. From a review of literature using SBF-
SEM (Appendix A) around half of the publications used manual segmentation solely
or in combination with other semi-automated methods. The most popular pieces of
software for analysis used are TrakEM2 (Fiji) (Cardona et al., 2012), IMOD (Kremer
et al., 1996) and Amira (Thermofisher).
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To provide an indication of the increased application of SBF-SEM in biological
research and assess the types of experiments and sample type analysed, a review of

SBF-SEM literatures was performed. Publications were found using the search term:

((((((((serial block face) OR sbfsem) OR sbf-sem) OR sbem) OR sbf-em) OR 3VIEW)

OR volume scope)) AND microscopy

in PubMed, and checked that SBF-SEM was used, from 2004 to 2019. All the
publications are compiled in table in Appendix A. From the development of SBF-SEM
to the beginning of this project (2004 — 2015), there were 84 publications using SBF-
SEM, Figure 1.2. Between 2015 and 2019 the number of publications increased up to
234. Although there has been a large increase in the number of publications using
SBF-SEM per year, in comparison to other microscopy techniques it is still not as
widely used even within the EM field, a search in PubMed for publications using TEM
(search term used is transmission electron microscopy) for the year 2019 yields 7345
results. This is most likely due to the large cost and limited availability of SBF-SEM

instruments.
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Figure 1.2 — Graph showing number of publications using SBF-SEM per year
from 2004-2019. Graph shows the number of publications per year from 2004 to
2019 using the search term ((((((((serial block face) OR SBFSEM) OR SBF-SEM)
OR SBEM) OR SBF-EM) OR 3VIEW) OR volumescope)) AND microscopy’ in
PubMed.
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From these publications the most common sample type studied using SBF-SEM was
nervous tissue (46%) followed by muscle, including skeletal, smooth and cardiac
(14%) (Figure 1.3(A)). In half of the publications SBF-SEM was used in conjunction
with other methods or ‘experimental’. For the purpose of this comparison
‘experimental’ was used to describe the projects in which SBF-SEM was used to
compare between groups, such as between control cases and mutants or disease
models, differences between ages groups and/or exploratory analysis of known
structures. The majority of the other publications were methods papers; detailing how
to use SBF-SEM to study specific sample types, sample preparation, analysis of the

data, and technical papers, due to the new nature of the technique.

As SBF-SEM was developed by neuroscientists for connectomic based studies it is
most commonly used in the neuroscience field (as detailed already). Connectomic
studies map the connections between neurons within an area of the brain. However,
connectomic studies are a small proportion of studies, Figure 1.3(B). This is most
likely due to the time it takes to collect the large datasets and analyse the data for
these types of studies (see Helmstaedter et al. (2011), Briggman et al. (2011) for
examples). SBF-SEM is primarily used for experimental studies, mostly in
conjunction with other methods and often just to show a small portion of structural
data. In a lot of the publications the authors use one dataset and sometimes it is a
small portion of the tissue or sample of interest. Use of one dataset is standard in
connectomic studies, due to the size of the projects and the robust nature of the
results from the extensive reconstruction and analysis of a neuronal network, which
can extend into the 1000s. Within the publications that use SBF-SEM in conjunction
with other methods often only 1 dataset is analysed or presented, and often the
datasets are small. There are few publications that use SBF-SEM solely or
extensively, for example comparing different experimental conditions. Even though
the usage of SBF-SEM has grown since 2015 the publications available using the

technique are still limited.
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Figure 1.3 — Graphs showing number of publications divided by sample type
and category. (A) Shows the number of publications by sample type, including
nervous tissue (cornea, retina and brain), muscle (skeletal, smooth and cardiac),
organ (kidney, liver, lung, pancreas and skin), cells (single and cultured cells),
material or plant, bacteria or parasites, connective tissue (bone, tendons and
cartilage) and others that could not fit into the other categories. (B) The number of
publications by purpose, including experimental and connectomic studies and
methods (analysis, staining and technical).
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Overall, the development and usage of 3D-Electron Microscopy has increased over
the past decade. Although the maijority of the electron microscopy techniques were
developed by neuroscientists for studying the brain, they have now been expanded
to other areas of biology and material sciences. It is for this flexibility that SBF-SEM
is being applied here to the study of two different tissue types with two different
objectives, the connectomics of a neural network within the locust brain and changes
over development in the ultrastructure of guinea pig skeletal muscle. With an overall
aim to compare and contrast the different approaches required and applicability of
the technique for each project. With the continued development of the techniques
and greater knowledge in the subject area there will continue to be an increase in

studies using 3D-EM and in a range of sample types.
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1.2. Locust Visual System

The simplicity of the insect nervous system has led to it being widely used as a
system for studying neuronal networks and computation. Insect eyes are compound,
made up of thousands of lenses, each with the same dedicated circuit interpreting
the image seen at one point before circuits come together in various combinations.
Their crystalline structure, made up of simple repeated and ordered components,
makes insect visual systems amenable to circuit analysis (Meinertzhagen and O'Neil,
1991). The locust visual system is one such system and has been studied for over 40
years. One aspect that is of particular interest is the neurons and the network
involved in collision avoidance behaviour. When an object approaches the locust, on
a collision course, a jumping, escaping or hiding behaviour is produced in adult and
juvenile locusts (O'Shea et al., 1974, O'Shea and Williams, 1974, Sztarker and Rind,
2014). Collision avoidance pathways can be found in many insects and in the locust
serves two main functions, one for predator evasion and the other for avoiding
approaching objects. Avoiding approaching objects is especially important in locusts,
as they fly in swarms that may contain millions of individuals. Some of the neurons
involved in these specific behaviours have been studied extensively, although at the
ultrastructural level there are still unanswered questions. The development of 3D-EM
techniques allows for the visualisation of neurons and small processes

simultaneously with the synapses between them.

The visual system of the locust consists of the eye and the optic lobe. The eye is
estimated to be made up of 8134 individual facets (Simmons et al., 2013). Locusts
have a fused rhabdome, made up of the light absorbing microvilli of all 8
photoreceptors. Photoreceptors 1-6 project into the lamina, while the photoreceptors
7 and 8 projects into the medulla (Nowel and Shelton, 1981, Schmeling et al., 2015).
The photoreceptors that extend into the lamina synapse with, the lamina monopolar
cell (LMC) (Nowel and Shelton, 1981). LMC neurons project into the medulla, where
they synapse with a Trans-medullary afferent (TmA) neuron (Rind and Simmons,
1998, Rind et al., 2016). These TmA neurons cross the chiasm, from the medulla
neuropil to the lobula neuropil, to synapse upon the Lobula Giant Movement Detector
(LGMD) neurons, of which there are two, the LGMD 1 (O'Shea and Williams, 1974)
and the LGMD 2 neuron (Rind, 1987, Simmons and Rind, 1997). A diagram of the
input network onto the LGMD 2 neuron can be seen in Figure 1.4. The LGMD 1 in

turn synapses onto the Descending Contralateral Movement Detector (DCMD)
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neuron (Rowell, 1971, O'Shea et al., 1974), within the protocerebrum of the locust. .
As there is a one-to-one transmission of spikes from the LGMD 1 to the DCMD and
DCMD spikes can be recorded in behaving locusts (Rind, 1984, Santer et al., 2005).
However, the postsynaptic partner of the LGMD 2 neuron is still unknown. Overall,
the collision avoidance network is small, consisting of around 4 synaptic levels of
neurons, from eye to protocerebrum (Rind and Bramwell, 1996, Peron et al., 2009,
Jones and Gabbiani, 2010).

Photoreceptor
_~—_, Lamina
Stimulated Facet  Eye Medulla
Lobula
TmA LGMD2

Figure 1.4 — Diagram of Locust eye with pathway from retina to lobula. The
diagram shows the structure of the 6-sided facets present on the eye of the locust.
Each facet is associated with 8 photoreceptors (green) which extends into the
lamina. When a facet is stimulated the associated photoreceptor is as well. Then
via a connective neuron between the lamina and medulla (black), a specific TmA
neuron (red) becomes excited. This TmA neuron travels across the medulla and
enters into the lobula region and synapses upon the LGMD 2 neuron (blue).
These synapses are excitatory and thought to occur along a branch, (up-down
arrows) and across other branches (left-right arrows), based on LGMD 1 neuron
evidence.
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Both neurons respond to looming objects. The LGMD 1 exhibits invariance, it
responds to a looming object regardless of its texture, shape, angular subtense or
trajectory (Gabbiani et al., 2001b, Gabbiani et al., 2004).. The LGMD 2 neuron has
also been shown to respond selectively to looming objects but it has a preference for
dark approaching objects (Simmons and Rind, 1997). Behavioural studies on
flightless immature locust instars have used the LGMD 2 neuron’s preference for
dark objects to show that the LGMD 2 neuron is involved in hiding behaviour
(Sztarker and Rind, 2014). Physiological recordings show the DCMD neuron, and
hence the LGMD 1 neuron is selective for looming from the time the locust first
hatches, through the 5 juvenile instars until adulthood, although its responses
sharpen as the locust matures. EM studies show that synapses onto the LGMD 1
and 2 neurons in the first instar resemble the back-to-back, reciprocal pattern seen in
adult synapses (Simmons et al., 2013). This suggests that the LGMD neurons are
also well developed upon hatching to produce this behaviour via the looming
selective network. 3D reconstructions, using light microscopy and silver-stained
sections (see Sztarker and Rind (2013) figure 1), of both the LGMD 1 and LGMD 2
neurons and behavioural studies show this to be the case (Simmons et al 2013;
Sztarker and Rind, 2014).

Each spike in the LGMD neuron elicits a spike in the DCMD neuron; this means that
the spike rate of the DCMD neuron represents the spike rate of the LGMD neuron.
The action of excitation is well documented onto the LGMD 1 neuron dendritic field
(Krapp and Gabbiani, 2005). The LGMD neurons are able to discriminate between
approaching and translating objects (Rind and Simmons, 1992, Simmons and Rind,
1992, Judge and Rind, 1997, Rind and Simmons, 1997). If the object alters direction
and moves across the eye the excitation decreases and the threshold for signal
propagation is not met and the action is not triggered (Rowell and O'Shea, 1976,
O'Shea and Rowell, 1976, Rowell et al., 1977). The object approaching stimulates
multiple facets and causes a spread of excitation across the dendritic field of the
LGMD neurons, the signals converge in the larger dendrites and spikes are produced
when the threshold for spiking is exceeded (Jones and Gabbiani, 2010, Jones and
Gabbiani, 2012).

The excitatory inputs onto the LGMD 1 and 2 neurons, the TmA neurons, cross the
medulla and enter into the lobula to synapse upon the LGMD neurons (O'Shea and

Rowell, 1976, Rind et al., 2016). One of the main neurotransmitters found in insect
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sensory nervous system synapses is acetylcholine (ACh) (Sattelle, 1980, Trimmer,
1995). ACh can either be excitatory or inhibitory depending on the receptors present
on the postsynaptic neurons (Le Corronc et al., 1991, Parker and Newland, 1995).
There are two main types of receptors involved in the cholinergic synapses in
insects, the fast excitatory nicotinic synapses (Sattelle, 1980) and the slower
muscarinic receptors, which ca cause inhibition or excitation based on the type of
receptor (Trimmer, 1995, Collin et al., 2013). Through staining it was determined that
the transmitter present at the TmA neuron synapses on the LGMD neurons is
acetylcholine, based on the presence of the enzyme acetylcholine esterase (Rind
and Simmons, 1998) found at cholinergic synapses. This was, subsequently verified
using antibodies against choline-protein conjugates and a polyclonal antiserum
against choline acetyltransferase, that the LGMD 1 and 2 neurons and their pre-
synaptic neurons contain ACh (Rind and Leitinger, 2000). It has been determined
that the excitatory nicotinic ACh receptors are activated by the TmA neurons that
synapse upon them(Rind and Simmons, 1998, Rind and Leitinger, 2000, Jones and
Gabbiani, 2010).

Unlike mammalian synapses, synapses in an insect nervous system have been
found to be dyadic and reciprocal (Watson and Burrows, 1985). A dyadic synapse
occurs when one pre-synaptic cell has two post-synaptic targets. Back-to-back
dyadic synapses where two presynaptic neurons share the same post-synaptic target
and where each is the target of the other one, and both share the same synaptic cleft
has currently only been found in the lobula and mushroom bodies of the locust (Rind
and Simmons, 1998, Leiss et al., 2009, Rind et al., 2016). Within the lobula, these
types of back-to-back synapses have been seen between the TmA neurons and the
LGMD neurons (Rind and Simmons, 1998, Rind et al., 2016). Each TmA has two
post-synaptic targets, the LGMD neuron and a secondary TmA neuron with which it
forms a reciprocal dyadic synapse (Figure 1.5) (Rind and Simmons, 1998, Rind et al.,
2016).
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Figure 1.5 — Schematic of TmA neuron synapses onto the LGMD 2 neuron in
the lobula of the locust. A schematic of two TmA neurons (blue and red) forming
a dyadic and reciprocal synapse upon the LGMD 2 neuron (blue). The arrows
show the direction of the synapse and the identity of the synapse, excitatory or
inhibitory, is indicated.

The connection between the two TmA neurons occurs at the same point, that is when
the two TmA neurons synapse upon a portion of the LGMD neuron. Evidence shows
that release of acetylcholine from one of the TmAs also affects the neighbouring TmA
neuron, and vice versa (Rind and Simmons, 1998, Rind et al., 2016, Zhu et al.,
2018). It was originally proposed that inhibitory cholinergic receptors are present on
the TmA neurons, enabling each TmA neuron to inhibit its neighbours at the
reciprocal synapse (Rind et al., 2016). However, excitation occurring through
excitatory muscarinic acetylcholine receptors has also been shown (Zhu et al., 2018).
Although the presence of these receptors on the TmA neurons potentially explains
the existence of the overlap of excitation over the branches of the LGMD 1 neuron
(Zhu and Gabbiani, 2016) but the presence of inhibition between the TmA neurons
has not been ruled out (Zhu et al., 2018). Overall, the identity of the TmA neuron to

TmA neuron interaction is still debated.
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There are a number of proposed methods for protection of the circuit against
habituation. One such way, and most well-known, is via post-synaptic inhibition
(Hatsopoulos et al., 1995, Gabbiani et al., 1999, Gabbiani et al., 2001a, O'Shea and
Rowell, 1975). The post-synaptic inhibitions occurs due to inhibitory inputs onto the
dendritic sub-fields (B and C) of the LGMD 1 neuron (Rind and Bramwell, 1996,
Gabbiani et al., 2005). It is proposed that the spike in in the LGMD 1 neuron, in
response to a stimulus, is due to computation of combination of excitatory and
inhibitory inputs onto the dendritic fields (Gabbiani et al., 2001a, Gabbiani et al.,
2004). It was proposed that, when a large part of the visual field becomes excited,
there is a rise in inhibitory potentials across the sub-fields B and C; stopping the
spiking of the LGMD 1 neuron (Rind, 1996). As the LGMD 2 neuron does not have
distinct sub-fields, it is thought that direct inhibition is non-specific and occurs across

the entire area of the dendritic branches (Rind et al., 2016).

Another method for the protection of the circuit against habituation is through the
action of lateral inhibition which would act to protect decrement prone TmA synapses
by preventing them spiking to non-looming stimuli (O'Shea and Rowell, 1975, Rowell
and O'Shea, 1976, Rind and Bramwell, 1996, Rind and Simmons, 1998, Rind et al.,
2016). Lateral inhibition is thought to occur between or onto the pre-synaptic cells
prior to the synapse on the LGMD 1 neuron branches (O'Shea and Rowell, 1975,
Rowell and O'Shea, 1976, Rind and Bramwell, 1996, Rind and Simmons, 1998, Rind
et al., 2016). Lateral inhibition was proposed to form part of the network of the
excitatory and inhibitory potentials that all play a role in controlling the output from the
LGMD 1 neuron but is not essential (Rind and Bramwell, 1996).

The action of lateral inhibition, besides preventing habituation at the decrement prone
synapses of the TmA neurons onto the main dendritic fan of the LGMD 1 neuron, is
most likely due to the inhibitory muscarinic receptors on the TmA neurons. The
reaction from these receptors is slower than the excitatory synapses. As an object
approaches, the rate of excitation increases and the action of inhibition lags, causing
a spike in the LGMD neuron. However, if the object moves away from a collision
course the excitation does not increase, allowing for inhibition to overtake and stop
the signal. The purpose of this lateral inhibition was thought to distinguish
approaching and passing objects (Rind and Bramwell, 1996). Although it is now
thought, that the action of lateral inhibition helps to sharpen the response of the

LGMD neurons, in combination with other factors such as spike frequency adaptation
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and locally synchronised input caused by a looming object that reinforce the

preference for motion caused by looming objects.(Rind et al., 2016).

Although, the exact identity of the ACh receptors at the TmA neuron to TmA neuron
synapses is not known, a recent study provides evidence that the main lateral effect is
excitation occurring, through excitatory muscarinic acetylcholine receptors on the TmA
neurons, but does not rule out the presence of inhibition between the TmA neurons
(Zhu et al., 2018). Although the presence of these receptors on the TmA neurons
potentially explains the existence of the overlap of excitation over the branches of the
LGMD 1 neuron (Zhu and Gabbiani, 2016).

For the LGMD neurons, a retinotopic map is preserved from the locust eye facets, via
the TmA neurons and onto the branches of the LGMD neurons. An individual facet is
assumed to be associated with a single TmA neuron, which in turn synapses onto
branches in a specific area of the LGMD neurons (Rowell et al., 1977, Rind and
Bramwell, 1996, Rind and Simmons, 1998, Krapp and Gabbiani, 2005, Peron et al.,
2009, Rind et al., 2016, Zhu and Gabbiani, 2016). However, a similar study has to be
performed on the LGMD 2 neuron to determine whether it is conserved for both
LGMD neurons.

Currently the LGMD 1 neuron has been studied far more than the LGMD 2 because
of the ease of recording from the LGMD 1 neuron via the DCMD axon. The majority
of the knowledge of the LGMD neurons’ input network, and the action of excitation
and inhibition, is based upon studies of the LGMD 1 neuron, but TmA neurons also
form excitatory synapses onto the LGMD 2 neuron as they do onto the LGMD 1
neuron (Rind et al., 2016). The LGMD 1 and 2 neurons share some similarities but
differ in their structure in the lobula. The LGMD 1 neuron has three distinct dendritic
fields, the larger sub-field receives excitatory inputs and the two smaller sub-fields
receive inhibitory inputs (Rind and Bramwell, 1996, Gabbiani et al., 2005). Whereas
the LGMD 2 neuron only has a single large dendritic field (Simmons and Rind, 1997,
Rind et al., 2016).

The nature of synapses within the lobula region of locust’s optic lobe (and that of
other insects) indicate a potential network between the TmA neurons as they
synapse with the LGMD 1 or 2 neurons. Studying the connectomics of the TmA
neurons could elucidate more information about the TmA neurons and how they

confer on the LGMD neurons the tuning for approaching objects. Within the locust
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visual system understanding the principles behind signal integration and the TmA
neuron network can be applied to other visual systems (Fotowat and Gabbiani, 2011)
but also within the field of robotics (Yue and Rind, 2006).

The output of the LGMD 2 neuron is not known and the mechanism of inhibition onto
the neuron is unknown. As shown by other studies (Kasthuri et al., 2015, Kaynig et
al., 2015, Zheng et al., 2018) SBF-SEM can be used to map the connectomics of
neural circuits. For this study SBF-SEM will be used to map the TmA neuron circuitry
onto the LGMD 2 neuron, with the objective of discovering how the degree of TmA
neuron connectedness may confer the tuning for approaching objects and the

position invariance of this tuning on the LGMD 2 neuron.
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1.2.1. Choice of Experimental Animal Rationale (Locust)

Motion detection can be found in other insects, like Drosophila with some variation
(Vogt and Desplan, 2007) and in a more complex form in primates (Appleby and
Manookin, 2020). The locust is a simple organism when compared to other animals
used to study the neuronal system, such as mice and rats. The collision avoidance
network can be used to study the integration of sensory information within a neural
circuit and for studying the behavioural output based on the sensory input. The
relative simplicity of the circuit lends itself to easy experimentation. It is well
conserved across locust populations, as without the network they would not survive,
so there is little to no variation between individuals. (Santer et al., 2008, Fotowat and
Gabbiani, 2011, Santer et al., 2012). This means that it can be studied using
connectome based dense reconstruction without the need of multiple individuals to

account for variation.
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1.2.2. Hypothesis/Aims

The LGMD 1 responds to changes in light across the locust retina, with inputs
occurring from retinotopic units. It is thought that the TmA neurons retain the
retinotopy from the facets of the eye onto the dendritic trees of the LGMD 1 neurons.
The processes of the LGMD 1 neuron are responsible for the summation of the
inputs. It can be hypothesised that the TmA neurons also maintain retinotopic
mapping onto the LGMD 2 neuron. Each of these TmA neurons synapses upon the
LGMD 2 neuron are reciprocal, with a single TmA neuron having two synaptic
partners at each location of a single synapse upon the LGMD 2 neuron (one partner
is the LGMD 2 neuron and second partner is neighbouring TmA neuron). Each TmA
neuron is responsible for one facet and are evenly weighted across the dendritic
trees, with all of them synapsing upon the same number of times, covering the same

area of the LGMD 2 neuron and with the same number of TmA neuron partners.

To map the connections of the TmA neurons onto the LGMD 2 neuron over a large
area, in x, y and z, a 3D electron microscopy technique is required, such as SBF-
SEM. It provides the resolution needed to identify synapses and follow the TmA
neurons through a sample and has a large field of view to be able to image an
extensive area of the lobula. Mapping the inputs onto a portion of the LGMD 2
neuron will show whether the TmA neuron synapses are all reciprocal and by
identifying the neurons involved the neural network can be mapped. Mapping the
network of the TmA neurons onto the LGMD 2 neuron will determine the structural
organisation and subsequently whether there is even retinotopic mapping.
Additionally, the relationship between TmA neurons can be determined and this will
indicate the weighting of individual TmA neurons onto the LGMD 2 neuron. The
objective will be to discover how the degree of TmA neuron connectedness may
confer the tuning for approaching objects, which expand outwards in all directions
and the position invariance of this tuning on the LGMD 2 neuron. The steps to
performing a connectomic analysis on the LGMD 2 neuron using SBF-SEM have yet
to be undertaken. SBF-SEM will be used, and analysis provided in detail to ensure

that further connectomic type studies can be performed on less common systems.
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1.3. Skeletal Muscle

1.3.1. Structure and Function

The skeletal muscles provide support to the skeletal frame as well as being vital for
limb and body movement via muscle contractions and relaxations. The structure of
skeletal muscle is well-known (Rozsa et al., 1950, Spicer and Rozsa, 1953). It is
made up of groups of individual muscle fibres, each of these fibres consists of
bundles of myofibrils. These are made-up of thin actin- and thick myosin-containing
filaments (Frontera and Ochala, 2015). The thin and thick filaments are arranged
within the myofibril with overlapping and non-overlapping regions, each contained
within defined boundaries of structures known as sarcomeres. A single sarcomere is
denoted by ‘Z-lines’, structures that serve as anchorage points for other proteins
involved in holding the thick and thin filaments in line (Hall et al., 1946, Draper and
Hodge, 1949, Frontera and Ochala, 2015), Figure 1.6. This arrangement of
structures gives rise to the light and dark (striated) sarcomeric banding pattern

evident under light and electron microscopy.

33



—

~

A

------ — S‘\\\\{/MQ

T

-
-
-
-
——
————
-
e
e
o
o

/
/’, \\ G-Actin Molecules
P H— \, o}
/ | S O 0
B (UM I S NN N E 00
\'1 ] 4

} g
__45\ *q%m
IR 000

_________ 000
’ o s R 00T TRPTRRRLS K
o l W‘\‘j\)-‘ F-Actin Filoment
S~
z .' ! | z ‘\‘s | 3|
. - X L
| \ \ ey
\ Myosin Filament
\
l \
\
/ 3 '
/ \ Myosin Molecule
F / G / H | S V
o _ [ I B 999 4 =g
& 921 39 eo o0 o.e 000 ! s
o8 i a8 eeoecoe ol0le 0’0 — - )
et PRI e.0:0’0
MR eisie quh' Heov
L) e°e’e Meromyosin Meromy’osin

Figure 1.6 — Diagram of muscle structure. The diagram shows the components
of a muscle (A). Muscles consist of bundles of muscle fibres (B) and a single
muscle fibre (C) is made of numerous myofibrils (D). Each myofibril consists of
myofilaments (E), actin (K) and myosin (L), the myofilaments are arranged in

overlapping and non-overlapping regions, which from the sarcomeres. Diagram
taken from Fawcett and Bloom (1994).
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Within the muscle fibres there is a complex organellar system, the sarcoplasmic
reticulum (SR) (Porter and Palade, 1957, Andersson-Cedergren, 1959) and
transverse tubular (T-Tubule) system. The latter is part of the plasmalemmal
continuum and therefore open to the extra cellular matrix (Endo, 1964, Franzini-
armstrong and Porter, 1964, Huxley, 1964, Endo, 1966). Both of these systems play
a vital role in the mechanism of contraction in skeletal muscle. Unlike other cell types,
skeletal muscle cells are multi-nucleated (Cheek et al., 1971, Cheek, 1985, Hall and
Ralston, 1989, Frontera and Ochala, 2015) and have a complex network of
mitochondria that runs through the length of the muscle fibre (Miyazaki et al., 2014,
Dahl et al., 2015).

The mechanism underlying muscle contraction is known as the ‘Sliding Filament
Theory’ (Huxley, 1974). As the name suggests the contraction of the muscle is
caused by the action of the actin- and myosin-containing thin and thick filaments
‘sliding’ over one another. A number of EM studies have shown that the width of the
sarcomere, as well as the A and | band within the sarcomere, alters during
contraction (Hall et al., 1946, Draper and Hodge, 1949, Rozsa et al., 1950, Spicer
and Rozsa, 1953, Huxley, 1967) due to the action of the flaments moving past one

another, Figure 1.7.
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Figure 1.7 — Schematic of muscle contraction. (A) Shows schematic of non-
contracted muscle with myofilaments, actin and myosin. The A band is the area
that consists of myosin filament, including areas of solely myosin and overlapping
areas with actin. The | band consists of only actin filaments. A sarcomere is the
area from Z line to Z line. (B) Shows the shortening of the | band and sarcomere
width during muscle contraction.
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This contraction is known to occur in the presence of adenosine triphosphate (ATP)
and a rise in intracellular Ca?* levels due to the entry of Ca?* from the sarcolemmal t-
tubules during an electrical action potential (Spicer and Rozsa, 1953). A dedicated
method of transference has to be present to account for the speed at which the
electrical impulse is linked to muscle contraction (Hill, 1949). This process became
known as ‘Excitation-Contraction’ (E-C) Coupling (Sandow, 1952). For recent reviews
on this topic see Rebbeck et al. (2014) and Frontera and Ochala (2015).

There are two main groups of fibre type found in skeletal muscle. The slow twitch
type, type 1, rich in myoglobin for continuous activity (red muscle) and the fast twitch
type, type 2, specialising in phasic activity and glycolytic metabolism (white muscle)
(Needham, 1926). Fast muscle fibres have been found to have three distinct sub-
types, -2A, -2B and -2X. Fast fibres-2A and -2B were first defined by morphology
(Schiaffino et al., 1970) and histochemical analysis of myosin ATPase (Guth and
Samaha, 1969). Through immunohistochemical examination a third type of fast twitch
muscle, type 2X, was identified and characterised later (Schiaffino et al., 1988,
Schiaffino et al., 1989). Advancements in proteomic studies now ensures that
characteristics of single fibres are not overlooked. Studies on Myosin Heavy Chain
(MyHC) expression and variation have shown that a single muscle fibre is not just
one type but can be heterogenous (Gorza, 1990, DeNardi et al., 1993, Bottinelli et
al., 1994). Further review on this topic can be found at Schiaffino et al. (2020).

Two well-studied muscles include the soleus (leg muscle) and the psoas (back
muscle), location shown in Figure 1.8. The soleus is involved in the movement of the
ankle, knee and hip, working in conjunction with the gastrocnemius muscle (Lenhart
et al., 2014). The psoas muscle is both a hip flexor and stabilises the lumbar area of
the spine (Arbanas et al., 2009). It is well established across multiple mammalian
species that the soleus is primarily slow twitch (~80%), supplemented with fast twitch,
as found in guinea pigs (Peter et al., 1972, Gorza, 1990), rabbits (Peter et al., 1972),
mice and rats (Gorza, 1990, Soukup et al., 2002) and humans (Johnson et al., 1973,
Gollnick et al., 1974). On the other hand, in the psoas there is a heterogeneous
distribution of both slow and fast twitch fibres, as found in human studies (Johnson et
al., 1973, Parkkola et al., 1993). Although, recent publications show a higher
percentage of fast twitch, specifically Type A, at ~60% (Arbanas et al., 2009). Fibre
typing in rats show that there is a higher proportion of fast type fibre (Erdstréom et al.,
1982, Hamalainen and Pette, 1993, Vlahovic et al., 2017).
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Figure 1.8 — Location of psoas and soleus muscle in the rodent. The diagram
shows the hind limb, pelvis and portion of the lower vertebrae and the location of
the soleus and psoas muscle. The soleus sits behind the larger gastrocnemius
muscle, connecting with the fibula bone. The psoas is located in the lower back
and pelvic region, connecting with the lower vertebrae and the femur. Schematic
was drawn based on Charles et al. (2016).
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1.3.2. Skeletal Muscle Development

The formation of muscle comes from the fusing of myoblasts, muscle precursor cells,
to form nascent myotubes, which go on to form muscle cells. Myogenesis occurs in a
number of steps during embryonic, fetal and neonatal development. The first wave of
myogenesis occurs from the embryonic wave, with the formation of the myotome
(Ordahl and Le Douarin, 1992). Myocytes then start to form from the myotome and
become early myofibres, driven by the expression of specific skeletal muscle cell
factors and proteins (Sassoon et al., 1988, Babai et al., 1990, Lyons et al., 1990,
Lyons et al., 1991). The role of these primary fibres is to act as a scaffold, dictating
the position and orientation of the individual muscles in a highly regulated process
(Buckingham et al., 2003, Abmayr and Pavlath, 2012, Fiorotto, 2012) and also form
the early limb muscles (Murphy and Kardon, 2011). Following the primary phase
comes the second wave of myogenesis. In this phase fetal myoblasts proliferate
under the basal lamina of the primary fibres, then fuse and form the secondary fibres,
these new fibres then separate from the primary fibres (Keller et al., 1992, Messina et
al., 2010, Fiorotto, 2012). This occurs in the neonatal stages of development. Post-
natal growth of muscle is facilitated by the addition of myofibrils in length and width
(Gokhin et al., 2008, Sparrow and Schock, 2009, Keefe et al., 2015) and myonuclei

(White et al., 2010). An overview of this is shown in a schematic in Figure 1.9.

The post-natal stages are vital for the development of the muscle fibres and
differentiation as they start to perform more functions related to their position and
specific role in the musculoskeletal system. In most mammals at birth, the system is
immature and requires a combination of factors to become adult muscle cells. The
post-natal specification is dictated by intrinsic factors, such as gene programming,
and extrinsic factors, like hormones (Gambke et al., 1983, d'Albis et al., 1990) and
neural influence with the formation of distinct motor units, an area of muscle cells
associated with a specific motor neuron (Slater, 1982, Fladby and Jansen, 1990,
Jansen and Fladby, 1990). Post-natal neural innervation and hormone interaction
drives the specification of fibres (Narusawa et al., 1987), shown by an accumulation
of associated proteins during this stage in development (Butler-Browne and Whalen,
1984). By post-natal weeks 2 to 4 developmental fibres have disappeared in rats,
mice and guinea pigs, the muscle fibres have formed distinct populations directly
related to the required function (d'Albis et al., 1989, Agbulut et al., 2003),
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Figure 1.9 — Schematic of myogenesis during fetal development. Myogenesis
starts with the proliferation of early myocytes from progenitor cells in the
embryonic myotome. These differentiate and fuse to form primary myofibres
(orange). During the second wave myoblasts differentiate into myocytes, which
fuse to form nascent myotubes. The myotubes undergo further fusion and growth
to form secondary myofibres (red), using the primary fibres as a scaffold.
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1.3.3. Nucleus

Skeletal muscle cells are multinucleated (Cheek et al., 1971, Cheek, 1985, Hall and
Ralston, 1989, Frontera and Ochala, 2015). Skeletal muscle cells are one of the
largest cells found in vertebrates, making the nuclei important in maintaining a variety
of cell functions over a large area (Cheek et al., 1971, Hall and Ralston, 1989). One
theory as to how this is achieved is through the existence of nuclear domains,
whereby a single nucleus occupies and maintains a given volume of the cytoplasm
acting like a unit (Cheek, 1985, Hall and Ralston, 1989, Cheek et al., 1971). This is
further corroborated by evidence suggesting that the ratio of nucleus to cytoplasm, by
volume, is maintained during the action of hypertrophy of muscle cells (Allen et al.,
1995, Allen et al., 1999, Shenkman et al., 2010).

Nuclei in skeletal muscle are known to follow distinct developmental stages. They
develop centrally and migrate to the periphery (Gundersen and Worman, 2013, Bone
and Starr, 2016). During development, myoblasts fuse and the nuclei align
themselves in the centre of the newly formed myocyte (Capers, 1960, Cadot et al.,
2012, Folker and Baylies, 2013, Falcone et al., 2014, Roman and Gomes, 2017).
Recent studies suggest that the movement of the nuclei to the periphery is driven by
myofibrils cross-linking, in a ‘zip-like’ fashion, altering the shape of the nuclei and
pushing them to the outer regions of the cell (Roman et al., 2017, Rosen and Baylies,
2017, Roman et al., 2018). Once at the periphery, they anchor to the region of the
cell they have moved to (Roman and Gomes, 2017). The distance between the
nuclei is proposed to be maintained by cytoskeletal interactions with the nuclear
envelope (D'Alessandro et al., 2015, Roman and Gomes, 2017, Manhart et al.,
2018). Then in adult skeletal muscle cells the nuclei are all located on the periphery
of the cell (Bruusgaard et al., 2003, Bruusgaard et al., 2006), except for in disease
cases of central nuclear myopathy (Chapman et al., 2014, Falcone et al., 2014,
Jungbluth and Gautel, 2014, lyer et al., 2017).

There has been limited studies analysing the relationship between nuclei size (e.g.,
surface area or volume) and whole cell size (surface area or volume) across different
stages of fetal development. From the current studies, a ratio of cell area to nuclei is
thought to be maintained during the process of muscle damage and regeneration that
occurs in mature muscle cells, as described above, but whether this ratio is seen
during development is unknown. With the use of SBF-SEM both nuclei and the cell

can be reconstructed in 3D to determine this.
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1.3.4. Mitochondria

Skeletal muscles require a significant amount of energy to produce its contractile
function and mitochondria therefore are important organelles. Mitochondria contain
the enzymatic system for oxidation of sugars, fats and proteins for Adenosine Tri-
phosphate (ATP) production (Ryan and Hoogenraad, 2007). For example, after
undergoing glycolysis sugar substrates enter the citric acid cycle within the
mitochondrial matrix (Bartlett and Eaton, 2004, Maechler et al., 2006). Following the
citric acid cycle the reduced Nicotinamide Adenine Dinucleotide (NADH) or Flavin
Adenine Dinucleotide (FADH2) produced move to the electron transport chain in the
inner mitochondrial membrane. This powers the transmembrane movement of
protons that helps for the synthesis of ATP via oxidative phosphorylation (Osellame
et al., 2012). The balance of energy requirements and production is maintained in
part via calcium signalling. Calcium from the cytosol can be taken up into the
mitochondria via the Mitochondrial Calcium Uniporter (MCU) (Kirichok et al., 2004,
Baughman et al., 2011, De Stefani et al., 2011). This regulates enzymes involved in
NADH uptake into the electron transport chain which increases respiration,
conversion of oxygen and other nutrients into ATP, and thus ATP production
(Duchen, 1992, Jouaville et al., 1999).

As well as producing ATP mitochondria contains a portion of DNA, mitochondrial
DNA (mtDNA) of maternal origin, which code for a small portion of proteins,
specifically involved in the electron transport chain (Picard et al., 2011, Picard et al.,
2012, Russell et al., 2014). Another major role for mitochondria is involvement in
apoptosis. Mitochondrial-associated proteins are able to directly stimulate the
process of apoptosis via regulating the permeabilisation of the outer mitochondrial
membrane (Li et al., 1997, Li et al., 1999, Susin et al., 1999, Li et al., 2000). These
factors play important roles in, for example, cellular responses in ischemia and
reperfusion injuries (Hunter and Haworth, 1979, Nakagawa et al., 2005, Forte et al.,
2007).

Light microscopy studies have revealed that mitochondria change morphology by the
action of fusion, two mitochondria coming together, and fission, the division of a
mitochondrion (Sugioka et al., 2004, Berman et al., 2008, Galloway et al., 2012). As
such, mitochondria are polymorphic organelles, although studies into the 3D shape of
single mitochondria are uncommon and light microscopy methods often, and TEM

certainly, do not provide the detail required to study the 3D shape. Not only do fusion
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and fission serve to regulate mitochondrial number and morphology but they are also
vital for distribution of mitochondrial DNA (mtDNA), and the maintenance of bio-
energetic functionality (Griparic and van der Bliek, 2001, Osellame et al., 2012).
Imbalance of fusion and fission leads to shifts in the morphology and loss of cell
viability (Palmer et al., 2011). If left unregulated, increases in fission can lead to
increased fragmentation, resulting in heterogeneous distribution of mtDNA, varied
ATP production capabilities, increase in reactive oxygen species (rOS) production

and an increase in the likelihood of apoptosis (Parone et al., 2008).

Fusion and fission will influence the individual shape of the mitochondria and also the
overall morphology of the network. The functional requirements of the muscle, linked
to fibre type, drive the action of fusion and fission. It is proposed that differences
observed are due to differing metabolic constraints in the different fibres, for example
the slow twitch fibres have a higher rate of fusion (Anderson and Neufer, 2006,
Picard et al., 2008, Mitra et al., 2009, Tondera et al., 2009, Gomes et al., 2011,
Mishra et al., 2015). In slow twitch fibres the mitochondria have been shown to be
more elongated parallel to the sarcomeres with a higher proportion of branching
(extensions from a mitochondrion) across the A band and | band (Kayar et al., 1988,
Ogata and Yamasaki, 1997, Picard et al., 2012, Fujioka et al., 2013, Mishra et al.,
2015). In comparison, the mitochondrial network in fast twitch fibres have been
shown to be thinner and primarily along the sarcomeric | band, with limited branching
across the A band (Ogata and Yamasaki, 1997, Picard et al., 2012, Mishra et al.,
2015).

The location of mitochondria within the cell may also impact on the function, and
possibly morphology, of the organelle. The skeletal muscle cell can be divided into 3
distinct areas, the sub-sarcolemmal (SS), between the cell membrane and the first
myofibrils, intermyo-fibrillar (IMF), the central portion of the cell, and peri-nuclear
(PN), the area surrounding the nuclei (including SS and IMF). Varying rates of protein
import and ATP production have been noted based on the location of the
mitochondria, higher in mitochondria at the periphery and higher in centrally located
mitochondria respectively (Takahashi and Hood, 1996, Mollica et al., 2006). The
mitochondria at each of these locations are also affected differently by stressors,
such as exercise, fasting and aging (Bizeau et al., 1998, Mollica et al., 2006,
Holloszy, 2008, Little et al., 2010, Crescenzo et al., 2014). Light microscopy and TEM

studies have suggested that the mitochondrial morphology may differ between
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mitochondria located at the SS and those in the IMF regions (Bakeeva et al., 1978,
Kayar et al., 1988, Ogata and Yamasaki, 1997, Picard et al., 2013). SS mitochondria
are proposed to have a higher proportion of circular mitochondria (Picard et al., 2013)
and IMF mitochondria are narrower and extend through the sarcomeres, with more
branching (Fujioka et al., 2013). However, it is now known the proportion or number
of mitochondria that are situated at each location and how may this be influence by

developmental muscle changes in different fibre types.

The morphology of individual mitochondria has been studied with the use of SBF-
SEM, primarily in the context of mitochondrial disease in humans skeletal muscle
(Vincent et al., 2016, Vincent et al., 2017, Vincent et al., 2019) and in normal
mammalian muscle (Bleck et al., 2018). These studies have emphasised a variation
in morphology of mitochondria present in skeletal muscle, for example the presence
of nanotunnels (Vincent et al., 2017), which are involved in sharing of information
between individual mitochondria but increase in number in disease cases, and an
decrease in the complexity of the mitochondria (Vincent et al., 2019). The
morphology of the mitochondria will have an impact on their function. It has been
proposed that longer mitochondria have an increased interaction with other
organelles and increased signalling across the cell and the larger the volume of the
mitochondrion the greater internal functional capacity (Glancy et al., 2020). However,
studies of the relationship between function and specific 3D morphology of individual
mitochondria have not been performed yet and currently only assumptions can be

made based on functional studies and a limited number of morphological studies.

Although all of these studies are important, they have been performed in a limited
number of experimental settings, with regards to tissue type, species and technique.,
they do point to a need to explore arrangements of mitochondria in a broader range
of circumstances. There are very few studies on morphology of individual
mitochondria and the network. The majority of imaging methods either do not have
the resolution capabilities required to differentiate individual mitochondria (light
microscopy) or are not able to image in 3D (TEM) both needed to image the complex
nature of the organelles and their network. However, with SBF-SEM individual
mitochondria and the network can be imaged and reconstructed. There is limited
research using SBF-SEM to examine the 3D structure, size and shape, of individual
mitochondria, or the main features of the mitochondrial network, during the important

biological process of skeletal muscle development and maturation.
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1.3.5. Choice of Experimental Animal Rationale (Guinea pig)

Guinea pigs were used as the primary animal for studying muscles in the early days
of muscle research (Peter et al., 1972, Gulati, 1976, Powell et al., 1984, Gorza,
1990). This was due to their muscular development being closer to that of human
muscle development, when compared to development in other rodents, which are
now primarily used due to their genetic amenability (rats and mice). New-born guinea
pigs (usually only 1-3 per litter) are fully mobile and have a fully developed central
nervous system, whereas mice and rats give birth to numerous pups (10-12
commonly) that require marked post-natal muscle maturation. Also, many
physiological features of guinea pig pregnancy, and thereby the in-utero environment
for fetal development, are closer to that of humans than mice or rats (van Kan et al.,
2009, Dyson et al., 2012). These factors make guinea pigs a good animal to study
skeletal muscle development with possible implications for human skeletal muscle

development.
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1.3.6. Hypothesis/Aims

As detailed, mitochondrial morphology is vital for the function of a cell and even more
so in the energy intensive musculoskeletal system. However high-resolution spatial
mapping of the mitochondrial morphology, individually and as a network, in different
guinea pig skeletal muscles, and how this may change with skeletal muscle

maturation, has not been performed.

The overall hypothesis is that guinea pig skeletal muscle development will be
accompanied by changes in mitochondrial morphology. It is proposed that the shape,
size and branching of individual mitochondria and the proportions of sub-cellular
localised mitochondria will change during fetal-to-adult development and maturation.
Differences in these features of mitochondria will also be found between psoas and
soleus skeletal muscle types. Stemming from studies showing the progression of
fibre type differentiation occurring during fetal skeletal muscle development. The
progression from primary to secondary muscle fibres during early to middle gestation,
followed by fibre type differentiation, will result in different mitochondria shape, size
and branching during development. Mitochondria will go from simple to more
complex organelles based on this. The progression of the psoas and soleus muscle

will also differ due to the different fibre type composition present in the two muscles.

With the use of SBF-SEM and subsequent segmentation, 3D reconstruction and
quantitative analysis, a comprehensive assessment of mitochondria shape and size
(relative to cell size) will be performed. This will be done in conjunction with a similar
analysis of size and shape changes with muscle maturation of another intracellular
organelle, the nucleus. From studies into muscle growth and regeneration in adult
muscle cells the ratio between nuclei and cell volume stays the same during these
processes. It can be hypothesised that cell to nuclei volume ratio is set early in

gestational age and maintained throughout fetal and into post-natal development.

A rigorous, quantitative analysis of this type has yet to be performed along with the
deposition of all raw data for public access and future use. Doing so will enable
testing of the above hypothesis to provide valuable biological information concerning
the processes accompanying skeletal muscle development. Not only this, but it will
also establish a protocol for the imaging and analysis of skeletal muscle mitochondria
(applicable to other organelles and even other tissue types) in differing experimental

scenarios.
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Chapter 2. Methods

2.1. Staining Protocol and Pin Preparation

2.1.1. Locust Optic Lobe

An adult locust (Locusta migratoria) was anesthetised on ice, the brain dissected out
in cold insect ringer solution and placed in 2% formaldehyde, 2.5% glutaraldehyde in
0.1M sodium cacodylate buffer. The brain was then halved, as shown in Figure 2.1,
and processed using an adapted version of the (Wilke et al., 2013) protocol
described in (Wernitznig et al., 2016) . The brains were washed in 0.1M sodium
cacodylate pH7.4 followed by a solution of 3% potassium ferrocyanide with 1%
aqueous osmium tetroxide in ddH2O for 30 minutes. This was followed by filtered
10% thiocarbohydrazide (TCH) for 1h and then secondary 1% osmium tetroxide for
30 minutes. The samples were then placed in 1% uranyl acetate at 60° for 2 hours
followed by lead aspartate solution, 0.12g of lead nitrate in 20ml aspartic acid
overnight. The samples were washed in several changes of ddH>O between each

step.

The samples were dehydrated with acetone, 25%, 50%, 75% and 100%, and
infiltrated with increasing concentrations of TAAB 812 hard resin, 25%, 50%, 75%
and 100%, in acetone with several changes of 100% resin. The samples were
embedded into 100% resin in coffin moulds and left to polymerise at 60°C for a
minimum of 36 hours. The brains were orientated with the protocerebrum closest to
the top of the resin block, example shown in Figure 2.1. Using an ultramicrotome
(Reichert) and a diamond knife the block was serially sectioned, at 1um, stained with
toluidine blue and viewed under a light microscope. The protocerebrum and optic
stalk were sectioned all the way through until the lobula was reached. At this point
several 70nm sections were taken, placed on a copper grid and viewed on a CM100
TEM (FEI). This was done to check tissue morphology, orientation of the sample and
penetration of the staining (detailed further in 2.4.1.-2.). The blocks were further
trimmed to approximately 0.75mm by 0.75mm and glued onto a pin. To reduce
charging within the SEM, the block was painted in silver paint and sputter-coated with

a 10nm layer of gold, shown in Figure 2.1(E).
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Figure 2.1 — Sample preparation of locust brain for SBF-SEM. (A) Diagram of
locust brain. The brain is halved during dissection, indicated by the line. The
lamina (La) is closest to the retina (Re), followed by the Medulla (Me) and the
area of interest the Lobula (Lb), circled, closest to the protocerebrum (Pc). (B)
Example of half a brain embedded in resin, circled. (C) Shows example of resin
block trimmed to trapezium for ultrathin sectioning, indicated with white arrow,
and (D) further trimming after being glued onto a pin, circled. (E) Is an example of

a pin with sample that has been gold coated and is ready for viewing on 3View
system. Arrow indicates where the sample is placed on the pin.
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2.1.2. Guinea Pig Skeletal Muscle

Skeletal tissue (psoas and soleus muscles) was collected from adult pregnant and
non-pregnant females and piglets at gestational ages 50 to 65 days Duncan Hartley
guinea pigs terminated under licensed procedures according to the Animals Scientific
Procedures Act 1986 (ASPA). An incision was made in the skin at the point of the
inner leg. With microdissection scissors, the skin was cut along the length of the inner
leg to the thigh. The gastrocnemius muscle was teased apart to expose the underlying
soleus muscle which removed and micro-dissected, ~2mm by 3mm rectangles, into
2% glutaraldehyde with 0.1M sodium cacodylate buffer pH7.4 and left for a minimum
of 12hrs in the fixative at 4°C. The animal was placed on its front and an incision in
the skin made from the abdomen down to the upper thigh. A portion of psoas muscle
was carefully removed from the lower abdominal area and placed in the same buffer
for microdissection. The samples then underwent a heavy metal staining protocol
(Wilke et al., 2013). The tissues were washed in 0.1M sodium cacodylate pH7.4 and
then a solution of 3% potassium ferrocyanide with 2% aqueous osmium tetroxide in
ddH20 was added for 1 hour. This was followed by filtered 10% thiocarbohydrazide
(TCH) for 20 minutes and then secondary 2% osmium tetroxide for 30 minutes. The
samples were then placed in 1% uranyl acetate at 4°C overnight followed by lead
aspartate solution (0.12gs of lead nitrate in 20ml aspartic acid) for 30 minutes.
Between each step the samples were washed in several changes of ddH20. The
samples were dehydrated with acetone, 25%, 50%, 75% and 100% and then
infiltrated with increasing concentrations of TAAB 812 hard resin in acetone, 25%,
50%, 75% and 100%, with several changes of 100% resin. The samples were
embedded in transverse orientation into 100% resin and left to polymerise at 60°C for

a minimum of 36 hours.

The resin blocks were trimmed using a razor blade to form a trapezoid block face,
Figure 2.2. Using a diamond knife, 1um sections were taken on a Reichert
ultramicrotome and stained with 1% toluidine blue (until a gold ring forms around the
toluidine blue) and viewed under a light microscope. Several 70nm sections were
taken, placed on a copper grid and viewed on a TEM (Philips (FEI) CM100 100kV).
This was done to check tissue orientation, which needed to be in transverse
orientation, and morphology to ensure membranes and organelles had not been
damaged during collection and processing, e.g., swollen or ‘blown’ mitochondria. The
penetration of the heavy metal staining was also checked, making sure the contrast

was consistent across cells and within the cells, particularly in deeper portions. The
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blocks were then further timmed to ~0.75mm by 0.75mm and glued on to a pin. In
order to reduce sample charging within the SEM, the block was painted with silver

paint and sputter-coated with a 10nm layer of gold, Figure 2.2(E).

Details of all protocols and chemicals used can be found in Appendix B — D.
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Figure 2.2 — Sample preparation of skeletal muscle for SBF-SEM. (A) The
sample, circled, was embedded into hard resin and polymerised, placed as close
to the edge of the resin block. (B) Using an ultramicrotome the block was trimmed
and shaped into a trapezium for sectioning and viewing the sample, indicated with
white arrow. (C) The tip of the block was sawn off, the sample was glued onto a
pin, trimmed further, ~0.75mm by 0.75mm, painted with silver DAG and coated in
gold, circled. (D) Shows an example of a gold coated pin ready for viewing on
3View system. Arrow indicates where the sample is placed on the pin.
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2.2. Imaging Parameters Refinement

All datasets were collected on a Zeiss Sigma SEM VP (Zeiss, Cambridge, UK)
combined with Gatan 3View system (Gatan inc. Abingdon, UK). There are a number
of different parameters that can be changed that relate to the sample to be collected.
These are the accelerating voltage of the electron beam (kV), the variable pressure
(pA) (specific to this setup), the pixel dwell time, resolution, image size and section
thickness. A number of these parameters are related to each other, changing one will
affect another, and can alter the image quality. The parameter settings were tested
for both guinea pig muscle and locust brain samples and in regard to the aims of the

respective experiments.

The first parameters to be tested were the kV and pA. Although SEMs can be
operated under high vacuum, this can lead to a build-up of excess electrons in the
resin block resulting in charging, even with the use of silver and gold to dissipate the
charge. Charging manifests as an overly bright (dark in the resulting image) area that
distorts the image and decreases the stability of the resin when cutting (Figure 2.3(A
and B)). This can occur in samples with a high amount of resin (guinea pig skeletal
muscle) or potentially poor resin infiltration, due to size and density of the sample
(locust brain). The kV is an indicator of the depth at which the electrons will penetrate
the sample, the higher the kV the higher the penetration depth. Resin will soften
under the electron beam and the amount of resin that is affected will therefore
depend on the penetration depth of the electron beam. Providing the section
thickness is greater than the depth of beam penetration the softened resin will be
removed, and the cutting of the sample will remain stable. If, when the section is cut,
the full depth of the softened resin is not removed it can cause degradation of the
resin and result in a build-up of charge. This can be counteracted by increasing the
section thickness to remove the affected resin (Figure 2.3(D)). Another way to
counteract the effect of the electron beam on the sample is by introducing a small
amount of nitrogen into the SEM chamber. The excess electrons can be ‘absorbed’,
and the charging removed (Figure 2.3(C)). However, increasing the amount of
nitrogen molecules in the chamber will reduce the number of electrons that reach the
detector. This will have an effect on image quality, most notably seen in the

contrasting of the images, shown in Figure 2.4.

52



N
° /

Beam
PY Nitrogen
Molecule
-<—— Knife Cut

Figure 2.3 — Examples of resin degradation and methods used to overcome.
(A) Shows example of charging that occurs in areas of empty resin surrounding a
muscle cell (asterisk ‘*’). (B) Example of continued impact of the electron beam
on the tissue, causing wrinkling and damage to the resin. (C) One way in which to
combat this is to increase the thickness of the section in order to remove all of the
resin affected by the electron beam penetration, indicated by the shaded area.
(D) Second method is to increase the nitrogen present in the chamber in order to
limit the amount of electron beam interacting with the block surface. Scale bars

are Sum.
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Figure 2.4 — Impact of pressure on image contrast. (A) — (D) Show examples
of images taken at different pressures, pa, from high vacuum (A), 10pa (B), 20pa
(C) and 30pa (D). As the pa increases there is a gradual loss of resolution and

contrast from the images.
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The next parameters tested were, magnification, resolution, image size and pixel
dwell time. These factors have a direct impact on the quality of images acquired.
Changing the dwell time will affect the noise of the final image, as the electron beam
spends more time on the sample surface, the larger the number of resulting back
scattered electrons and thus more information gained in regard to the structures in
the sample. The result is an image where the contrast is starker between different
structures but will increase acquisition time, shown in Figure 2.5. The magnification,
resolution and image size are linked in such a way that changing one will affect
another. When a resolution and magnification is chosen the size of the image
required will be according to these two factors. If the magnification is altered, but the
image size remains the same the resolution will change. Examples of this
relationship are shown in Figure 2.6. Again, when taking images at high
magnification, resolution and long dwell time this will affect the resin, which was

taken into consideration when deciding these parameters.

A B

Image Size: 2000x2000 Image Size: 2000x2000
Resolution: 6nm Resolution: 6nm
Magnification: 6.27kx Magnification: 6.27kx
Dwell Time: 5us/pixel Dwell Time: 20ps/pixel
Time: 20.06secs Time: 80.06secs

Figure 2.5 — Pixel dwell time alterations and noise. (A) An image of a muscle cell
taken at 5us per pixel and (B) the same area imaged at 20us per pixel. The
increase in dwell time decreases the noise but increases the time taken to scan a
whole section. Scale bar is 5um.
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Image Size: 2500x2500
Resolution: 8nm
Magnification 3.82Kx

Image Size: 3500x3500
Resolution: 8nm
Magnification 2.64Kx

Image Size: 6000x6000
Resolution: 8nm
Magnification 1.53Kx

Figure 2.6 — Relationship between magnification, resolution and image size.
(A) — (C) show examples of datasets collected at the same resolution but different
image sizes and magnifications to highlight the relationship between the three
parameters. If the magnification is reduced but the resolution is to be maintained,
the image size has to change in accordance and vice versa for all the
parameters. All Scale bars Sum.
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Another factor to consider when deciding upon the imaging parameters is the
computing power available for the subsequent analysis. An image at high resolution
and low magnification requires a large image size, therefore will be a large file, and a
long series of images (regardless of size) can be difficult for the analysis software to
handle. To decide upon all the different parameters, the type of information to be
collected needs to be known. For the two biological questions the process of deciding

upon the parameters used is discussed in the following sub-sections.
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2.2.1. Locust Optic Lobe Parameters

The aim for the locust project was to follow identify and map the connections of the
TmA neurons synapsing onto a portion of the LGMD 2 neuron. To undergo this, the
LGMD 2 neuron had to be located and imaged, as well as the TmA neurons
synapsing upon the LGMD 2 which had to be followed through the neuropil as far as
possible to identify individual TmA neurons. For this a large area had to be imaged at
a resolution at which synapses and small TmA neurons could be visualised. A range
of resolutions was tested and the one at which both synapses and TmA neurons
could be seen, and did not restrict the image size and magnification, was determined
to be 8nm. Although arrived at independently, this was consistent with what had been
used by other research groups working with Drosophila brains (Takemura et al.,
2017). Once the resolution was decided upon, the size of the imaging area was
tested and established. Firstly, the use of multiple regions of interest were tested.
However, during the test imaging the resin became distorted at the areas of overlap,
required for stitching the areas together. This occurred regardless of when the kV
was decreased, the pA increased, or slice thickness increased. This was most likely
due to lack of full resin infiltration, common in dense brain tissue. Therefore, it was
decided that imaging a single large area was the best option. Short serial image runs
were used to test different image sizes and stability of the imaging. From this, it was
found that an image of 6000 by 6000 pixels at 8nm resolution gave a large enough

area to follow a branch of the LGMD 2 neuron and the afferents synapsing with it.

After the imaging parameters had been decided upon, the next parameter to be
tested was the slice thickness. As the synapses and processes of the afferent
neurons are small, a thin section would ensure that the small processes could be
followed (some studies of neurons have been sectioned at 25nm (Helmstaedter et
al., 2013)). However, during the test runs cutting was not consistent and the resin
became damaged when the thickness was dropped to 50nm or below. Thus, a
section thickness of 60nm was chosen. At this thickness the cutting was stable and

the synapses and TmA neurons could be seen and followed through the dataset.

Overall, the images were obtained at 2.5kV accelerating voltage, with an aperture of
30um, at 20Pa. The block was sectioned at 60nm thickness, and the images
recorded at a magnification of 1.5Kx, with an image size of 6000 by 6000 pixels,
20us/pixel dwell time and a resolution of 8nm. The block was then imaged for 500

sections (Table 2.1).
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2.2.2. Muscle Parameters

The muscle samples also underwent parameter testing. Once a sample was placed
in the SBF-SEM the sample surface was visually scanned for muscle fibres in
transverse orientation. Although the fibres had been orientated during resin
embedding resin, the orientation of the tissue can change during polymerisation and
pin preparation. For each run three muscle fibres were imaged simultaneously, using
the multiple regions of interest function. The imaging parameters used were chosen
based upon the size of the cell, the imaged area had to encompass the entire cross-
section and portion of surrounding area of the cell. As the fibres were often oblique
and truly vertical in the Z direction, the cell would not remain in the centre during
imaging but ‘drift’. The resolution required depended on the appearance of the
mitochondria and nuclei, ensuring they were identifiable. The magnification and
required resolution were decided upon and the final image size, which is dependent

on these two factors, was adjusted accordingly (Table 2.1).

Thinner sections give more detail in the Z direction and show smaller changes in
structures, for example the cristae of the mitochondria or the endoplasmic reticulum.
From the aim of the muscle project only the overall 3D structure (shape, surface area
and volume) of the mitochondria, nuclei and cell were needed. All of these structures
can extend for a large number of sections, so a think section was not required. The
muscle samples also had a high amount of empty resin surrounding the cells.
Therefore, the samples were at a higher risk of having a large amount of charging,
resin distortion and inconsistent cutting. For this and the above reason 70nm section

thickness was chosen.

Overall, the cells were imaged for a minimum of 250 sections at 70 nm section
thickness, 2.5 to 5Kv accelerating voltage, a variable pressure between 20 and 53pa
and a dwell time of 20um/s. The size of the image ranged from 2500x2500 pixels up
to 5000x5000 pixels and the resolution ranged from 7nm to 10nm with 8nm the

average resolution used.
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2.3. Optimisation of Image Analysis

Prior to analysis of the datasets collected, the best method(s) for analysing the date
was found. Three software programs were chosen, based on accessibility, usage and
segmentation and analyses tools available. The three chosen were TrakEM2, a Fiji
plugin, (Cardona et al, 2012) combined with Blender, (Neuromorph tools, Jorstad et
al. (2015)) an open software platform for reconstruction (collectively referred to in the
Results as ‘Fiji’); Microscopy Image Browser, MIB, a recently developed free
software (Belevich et al., 2016); and Amira, a licensed software commonly used for

analysis (https://www.fei.com/software/amira-for-life-sciences/). Then, using an

example skeletal muscle dataset, each of the software packages and the
segmentation tools were tested. Protocols were developed on how to use the
programs (see Appendix E and in Cocks et al., 2018) and a workflow for choosing
the best segmentation tools with respect to particular experimental objectives was
created. The raw datasets used in this testing can be accessed via the EMPIAR

website:

http://www.ebi.ac.uk/pdbe/emdb/empiar/ (Accession code: EMPIAR-10092).

The analysis was performed on a Toshiba laptop with Intel® Core i7-5500U CPU,
2.40 GHz, 16 GB RAM and 64-bit processor. Videos pertaining to the steps can be
found under Supporting Information at https://doi.org/10.1111/imi.12676.
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2.3.1. Software Comparison

Figure 2.7 shows a series of SBF-SEM images from the psoas skeletal muscle (fetal
day 60-64). This example dataset was used to show different image analysis
programs and protocols. From the data, the nucleus, nucleolus, chromatin and
mitochondria were segmented using the segmentation tools detailed in Appendix E.
The types of tools and functions can vary between the software available and a

comparison between Fiji, Amira and MIB is shown in Table 2.2.

Figure 2.7 — Example of SBF-SEM image series. Nine consecutive images
(viewed from left to right) at 70nm section thickness from a stack of 93 serial
images of a portion of a skeletal muscle psoas cell from day 60-64 Fetal guinea
pig. In the first image the nucleus can be seen, labelled with an ‘N’, as well as the
nucleolus, white ‘n’, and the mitochondria, labelled with white arrows. All scale
bars 1 um.
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Table 2.2 — Comparison of imaging programs. Examples of the different types
of image formats and segmentation tools offered by three analysis programs

Fiji Amira MIB
Image import tif, .dm3, .png, .omp tif, .png, .bmp tif, .dm3, .dm4, .png,
format .bmp
Object export .0bj .am, .surf .am, .tif, .mat, .model,
format .stl, .mrec, .mod, .nrrd,
.h5
Manual Brush v v v
Interpolation v v
B/W thresholding v v
Magic wand v v
thresholding
Watershed/SLIC v

segmentation
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A timing analysis was performed over 20 slices for each of the different methods
used to segment an individual mitochondrion and a nucleus from adult or fetal
skeletal (psoas) muscle (see Table 2.3). For Fiji (TrakEM2) the only method available
for segmentation is the manual brush tool, which was used. For Amira and MIB
manual segmentation (every 5" section) was combined with interpolation for the
nucleus, which was faster than manual segmentation performed in Fiji. For the
mitochondrion the fastest method found was the thresholding method used in Amira,
Overall, the semi-automated tools segmented the structures fastest. However, it has
to be noted that the speed of the semi-automated procedures is dependent on the

computing power available.

Table 2.3 — Timing analysis results. The table shows the results from the timing
analysis (in seconds) performed on a small portion of the skeletal muscle dataset (20
slices) in each of the programs shown. It was performed on a Toshiba laptop with
Intel® Core i7-5500U CPU, 2.40 GHz, 16 GB RAM and 64 bit.

Fiji Amira MIB

fetal Nucleus 6.29 3.21 212
Mitochondrion 9.14 9.22 26.44

Adult Nucleus 10.52 5.35 3.07
Mitochondrion 37.14 4.28 62.39
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2.3.2. Segmentation Workflow

The first structure to be segmented from the test dataset was the nucleus. It was
segmented manually in Fiji and with the use of interpolation (semi-automated
method) in Amira and MIB. Both the 3Dr reconstructions and volumes similar were
are similar between each of the programs (Figure 2.8). Although interpolation sped
up the segmentation process, errors occurred on the interpolated slices. These errors
required manual correction and added to the overall time taken of the segmentation.
Further analysis was performed to test the accuracy of the interpolation in MIB,
comparing the uncorrected interpolated nuclei to a manually segmented one

(Figure 2.9). The level of detail differed between each of the models; the folds of the
nuclear membrane were not as detailed in the interpolated models as in the manually
segmented one. However, the volumes of the nuclei from the quantification analysis
were similar, with only 1.98% difference between the corrected and then every 10th
slice (1.37% difference between the corrected and then every 5th slice). Overall, for
bulk quantification analysis, interpolation without corrections can be used and if finer
details are required a combination of interpolation and manual correction can be

used.
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Figure 2.8 — Examples of digital reconstruction of nuclear volume. (A)
Reconstructions of the nucleus from foetal psoas at different orientations from the
segmentations performed in Fiji, Amira and MIB. (B) Shows the volume
measurements of the nucleus from each of the programs. Scale bars 1um.
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Figure 2.9 — Analysis of accuracy of interpolation method for segmentation.
(A), (B) and (C) each show 5 images with the nucleus segmented and the final
reconstruction of the nucleus, from late foetal psoas, all performed in MIB. (A)
Shows the nucleus segmented using interpolation when every 10th slice has
been manually segmented, (B) from every 5th slice and (C) is a nucleus which
has been segmented manually. Volumes from each of the segmentations. All
Scale bars 1 um.
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After the nucleus, the darker and dense chromatin and nucleolus within the nucleus
was segmented. The segmentation and the final reconstruction can be seen in
Figure 2.10. In Fiji, as with all of the structures, manual segmentation was used. In
Fiji the object is segmented in layers whereas in MIB and Amira the pixels can only
be assigned to a single object. When using MIB and Amira for inner structures, like
chromatin and nucleolus, the order of the segmentation is important. In both MIB and
Amira the chromatin and nucleolus were segmented using the thresholding too, to
select the darker pixels within the nucleus. The chromatin was thresholded first
(Figure 2.10(A)). During this step the nucleolus was also selected, as the pixels are
of a similar contrast. By then segmenting the nucleolus, the pixels were reassigned to
the nucleolus object (Figure 2.10(B)). During the thresholding of the chromatin in
both Amira and MIB, there were errors in the selection, often the dark nuclear
boundary was also selected. These errors had to be corrected manually. As seen in
the raw images, the nucleolus consists of both and light and dark pixels and appears
as a web-like structure. When thresholded, only the darker pixels were selected,
causing gaps in the model, whereas during manually segmentation, the entire
nucleolus area was segmented. The thresholded models in MIB and Amira showed
the web-like appearance which was not seen in the manual segmentation. This is as
example of when thresholding can be used to show intricate internal structures of an
object. Overall, for the thresholding procedure to be effective, there needs to be
sufficient contrast within the images and between structures. Although, manual
alterations can be made after thresholding to ensure that the correct selection is

made.
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Figure 2.10 — Examples of reconstruction of chromatin and nucleoli. (A) 3
single images from the data series with the chromatin segmented and the
reconstructions at different orientations performed in each of the image programs,
Fiji, Amira and MIB, scale Bars are 1 um. (B) 3 single images from the data series
with the nucleolus segmented and reconstructions of the nucleolus from the 3
programs. Scale Bars are 0.5 um.
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Once the nuclei and associated structures were completed, the mitochondria were
segmented. Mitochondrion can extend through many sections but due to their small
size and complexity (Figures 2.11(A) and (B)) the decision was made not to
interpolate. Instead, the mitochondria were thresholded in Amira and MIB and
manually reconstructed in Fiji (Figure 2.12). In the raw images it can be seen that
mitochondria consist of a range of contrasts due to the detail of the cristae
(appearing as dark inner membranes)). During thresholding, only the darker pixels,
the outer mitochondrial membrane and inner membrane (cristae), were selected.
This gave the models from Amira and MIB a broken appearance compared to that
from the manual segmentation in Fiji. However, the overall arrangement of the
mitochondria could be seen and with further user input (e.g., using the fill feature),
the appearance could be further improved. The quantitative volume analysis showed
that the thresholded mitochondria resulted in a smaller volume than the manually
segmented mitochondria, due to only the darker pixels being segmented (Figure
2.12(B)). This further proves that the thresholding tool should only be used in
conjunction with other segmentation methods, to ensure that correct reconstructions

and resulting measurements are made.
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Figure 2.11 — Examples showing the complex morphology of mitochondria.
(A) Nine consecutive images from the late foetal psoas (viewed from left to right).
The mitochondria have been segmented individually in different colours, in MIB,
and their corresponding 3D reconstructions, from Amira, can be seen in (B). All

Scale Bars 1um.
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Figure 2.12 — Examples of reconstructions of the mitochondrial network. (C)
3 single images from the data series with the mitochondria segmented and the
reconstructions of the mitochondria at different orientations. (D) Volume
measurements of the mitochondria. All Scale Bars 1um.
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The final reconstructions incorporating all segmented features of the skeletal muscle
are shown in Figure 2.13. Although the general appearances of the models were
similar in each of the programs, there were some differences caused by the methods
used to segment the structures of interest. For example, the mitochondria were more
fragmented in the MIB and Amira models as they had been thresholded compared to
the denser structures seen with Fiji's manual segmentation. The devised workflow

from these analyses is shown in Figure 2.14.
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Figure 2.13 — Examples of 3D reconstructions of segmented structures. This
diagram depicts examples of the assembled reconstructions of all segmented
features from two separate skeletal muscle SBF-SEM datasets. Rows A and B
show results from adult soleus muscle (from X serial sections; panel A1 indicates
an SBF-SEM image). Rows C and D show results from foetal psoas muscle (from
X serial sections; panel B1 indicates an SBF-SEM image). Rows (C) and (D) The
following features are colour-coded in the reconstructions: mitochondria, light
blue; nuclei, dark pink/purple; chromatin, light pink; nucleoli, dark blue;
plasmalemma, green. All scale bars 1um.
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Figure 2.14 — Proposed workflow to aid in decision making when choosing
appropriate segmentation methods for analysis of SBF-SEM data. The
majority of these segmentation methods can be used in MIB and Amira, with
some exceptions, the watershed segmentation which is not shown in this paper.
The decision to use either MIB or Amira to perform the segmentations will depend
on user preference and access to the software, as previously shown the two
programs yield similar results.
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2.3.3. Validation of Workflow

The workflow was then implemented onto two other tissue types: guinea pig cardiac
muscle (detailed below in this section) and a region of the optic lobe from locust brain
(detailed in section 2.4). This was done to test the workflow and validate that it was

applicable to other tissues and structures.

Cardiac muscle (dataset taken by Dr. Hanan Kashbour) was chosen as a good
model system for this test because the mitochondria appeared darker and denser,
compared to skeletal muscle, with high contrast to surrounding features

(Figure 2.15(A)). It had a different appearance when compared to the mitochondria in
the skeletal muscle, which, as shown already, exhibited varied contrasts. By following

the workflow:
3D-Reconstruction>Yes>Quantification>Yes>Contrast>Simple>Threshold

it was determined that a form of thresholding, either b/w or the magic wand in MIB or
Amira, could be used to segment the cardiac mitochondria. This was done and the
successful segmentations and subsequent reconstructions are shown in Figures 2.15
(B) and (C).
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Figure 2.15 — Segmentation and reconstruction of mitochondria from
cardiac muscle. (A) Shows 3 raw images that are 5 slices apart from each-other,
mitochondria labelled with white arrows. (B) Are the same raw images with the
segmentation of the mitochondria (blue) shown and (C) is the subsequent
reconstructions at different orientations. Scale bars are 1um.
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For the cardiac muscle nucleus, the same segmentation procedure was used as for

the skeletal muscle. The workflow was:

3D Reconstruction>Yes>Quantification>Yes>Contrast>Varied>Size> Large>Distinct

Border>Yes>Automated Method (Watershed Segmentation in MIB)

The dataset was composed of only 100 slices, image size 1024x1024 pixels, and the
nucleus was only present for a portion of the stack. As automated segmentation can
be a time-consuming method due to computational demands, it is not efficient for
small objects or datasets. Thus, the decision was made to use manual segmentation
combined with interpolation. So, the nucleus was manually segmented over every

fifth slice, interpolated in-between and any errors manually corrected (Figure 2.16).

These outcomes indicated the applicability of the workflow approach for

mitochondrial analyses of muscle preparations.
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Figure 2.16 — Segmentation and reconstruction of nucleus from cardiac
muscle. (A) Shows 3 raw images that are 5 slices apart from each-other, nucleus
is labelled with white ‘N’. (B) Are the same raw images with the segmentation of
the nucleus (purple) shown and (C) is the subsequent reconstructions at different
orientations. Scale bars are 1um. (Data collected by Dr. Hanan Kasbour).
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The dataset from the locust optic lobe of the LGMD 2 neuron also presented
challenges for choosing the most appropriate analyses procedure. This tissue was
vastly different from the skeletal and cardiac muscle already shown, as it was
densely packed with a variety of cells. The dataset analysed (100 slices at
6000x6000 pixels) was also much larger than the muscle dataset. The aim, on this
occasion, was rather different - to segment out an entire dendrite. The following

workflow was followed:

3D Reconstruction>Yes>Quantification>Yes>Contrast>Varied>Size> Large>Distinct

Border>Yes>Automated Method (Watershed Segmentation in MIB)

As mentioned earlier, this method takes time but there is a semi-automated version
of the watershed segmentation combined with the brush tool in MIB, whereby voxels
are grouped depending on the presence of boundaries. These larger voxels can be
selected using the brush, all performed directly in the user interface. Using this
method, the dendrite was selected, manually segmented repeated every fifth slice
and interpolation used (Figure 2.17). This tool could be used when analysing nuclei,
however, it is best used on larger and more complex structures that would take time
to manually segment, such as large dendrites like the LGMD 2 neuron. This
approach therefore also confirmed the adaptability of the workflow to the examination

of neuronal tissue.
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Figure 2.17 — Segmentation and reconstruction of the LGMD 2 neuron from
the optic lobe of the locust. (A) Shows 3 raw images that are 5 slices apart from
each other, with the neuron of interest circled in white. (B) Are the same raw
images with the segmentation of the LGMD 2 shown and (C) is the subsequent
reconstructions at different orientations. Scale bars on sections are 10um and
5um on 3D reconstructions
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2.4. Segmentation, Reconstruction and Analysis of Locust Optic Lobe

2.4.1. Identification of LGMD 2 neuron

As described previously the block was serially sectioned at 1um thickness, stained
with toluidine blue and checked under the light microscope until the protocerebrum
and optic stalk had been cut through. As soon as the optic stalk was cut through the
subsequent sections were checked for the start of the lobula region of the optic lobe.
The lobula region was identified by the presence of tracheae, groupings of cell or
nuclear bodies, such as anterior body and ventral body. The LGMD 2 neuron
dendrites are the outer crescent of two located within the lobula (Rind et al., 2016,
Rind and Leitinger, 2000), examples of the sections taken and viewed are in Figure
2.18(A-B).
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Figure 2.18 — Process of finding the region of interest and the LGMD 2
neuron. (A) Light microscope section, stained with toluidine blue, of the lobula
with tracheae, Tr, somata, So, anterior body, Ab, and ventral body, Vb, labelled.
Scale bar 100um. (B) Higher resolution image of same section with area of
interest circled. Scale bar 100pm. (C) Image from SBF-SEM of the lobula, with
tracheae, Tr, somata, So, and the anterior body, Ab, labelled and branches of
LGMD 2 neuron are circled in white. (D) Single section from the collected dataset
(500 slices), with the LGMD 2 branch of interest circled. Scale bar 5um.
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2.4.2. Identification of Synapses

As described earlier once the crescent of the dendrites of the LGMD 2 neuron were
identified in the lobula region, several 70nm sections were taken and viewed on the
TEM. As the tissue processing protocol differs for the SBF-SEM compared to
standard TEM the preservation and appearance of the synapses was checked (and
later compared to the appearance of the synapses seen when viewing with the SBF-
SEM), shown in Figure 2.19. Synapses were first recognised in the TEM, by the
presence of presynaptic density and vesicles. At a synapse onto the LGMD 2 neuron,
there is a dark pre-synaptic density present in both TmA neurons in a 'V’ shape. The
synapses found on the TEM also confirmed the location and identity of the LGMD 2
neuron, as characteristically all synapses found were reciprocal, with the synapses of
two neighbouring TmA neurons occurring back-to-back synapses at the same
location onto the LGMD 2 neuron branch and both sharing the same synaptic cleft
(Rind et al., 2016, Rind and Leitinger, 2000).
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Figure 2.19 - Identifying synapses using TEM and SBF-SEM. (A) and (B) show
TEM images of a 3view sample. The TmA neurons are labelled (*) and the
synapses are circled. The synapses are identified by their characteristic dark pre-
synaptic densities present in both TmA neurons forming a ‘v’ shape relative to one
another. Scale bar 500nm. (C) Shows a branch of the LGMD 2 neuron and (D) is
an enlarged image of the area in the square imaged in the SBF-SEM. On (D) the
TmA neurons are labelled (*) and synapses circled. Scale bar is 1um.
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2.4.3. Segmentation and Reconstruction

The dataset collected was then converted from .DM3 to .TIF format using Fiji
(https:/fiji.sc/). During this step in Fiji the contrast was normalised across the stack.
The dataset was then given to Dr Kristian Bredies (University of Graz, Austria), and
further processed using a denoising filter to aid in semi-automated segmentation.
The processed dataset was divided into two 200 and one 100 portions due to the
overall size of the dataset (>16GB). The portions of the processed dataset were

opened into Microscopy Image Browser (MIB) (http://mib.helsinki.fi/) (Belevich et al.,

2016) and the contrast of the images were altered further, to visualise the dark cell
boundaries and synapses easier. In MIB the larger LGMD 2 neuron branches were
segmented using the watershed option of the manual brush tool and interpolation.
The smaller LGMD 2 neuron processes and the TmA neurons had to be
reconstructed manually, as they were too small for the semi-automated methods and
too many errors were created. Examples of the appearance of the data at each of
these steps is shown in Figure 2.20. Information about each of the TmA neurons and
their respective synapses was also compiled, including location on the LGMD 2
neuron and which branch of the LGMD 2, as well as the identity of the neighbouring

neuron, which the TmA neuron synapses with onto the LGMD 2 neuron.
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Figure 2.20 — Step
Shows slice 1, 10 and 20 from dataset of raw images collected from digital

micrograph. (B) The denoised dataset (performed by Dr Kristian Bredies of Graz
university) and after further contrast enhancement in MIB, to improve boundaries
and synapses. (C) Examples of segmented dataset of LGMD 2 neuron branches,
blue, and TmA neurons, multi-coloured. Scale bar 5um.

Video: https://doi.org/10.6084/m9.figshare.7172384.v5
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Once the segmentation of all the TmA neurons synapsing onto the nominated LGMD
2 neuron branches within the dataset was finished both the TmA neurons and LGMD
2 neuron branches were exported out of MIB and opened in Amira

(https://www.fei.com/software/amira-for-life-sciences/). The models of the neurons

over the three portions of the dataset were merged within Amira and visualised,
Figure 2.21. Within Amira the lengths of the dendrite main and sub-branches were

measured, Figure 2.22, as well as the surface areas of all the branches.
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Figure 2.21 — Segmentation and reconstruction of LGMD 2 neuron branches
and TmA neurons. (A) Single section from the dataset and enlarged area around
the main branch of the LGMD 2 neuron analysed (circled). (B) Single section with
the segmentation, LGMD 2 neuron branches are blue and TmA neurons multi-
coloured. (C) Reconstruction of all of the segmented LGMD 2 neuron branches,
blue, and TmA neurons, multi-coloured, with an orthoslice taken at the level shown
in C with a shift in orientation. Scale bar 5um. Video:
https://doi.org/10.6084/m9.figshare.7167998
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Figure 2.22 — Analysis of the main and sub-branches of a portion of LGMD 2
neuron. (A) Measuring the length of the main branch and the smaller sub-
branches of the LGMD 2 neuron, blue, in Amira using a 3D tool measurement. (B)
Showing the measurement results without the reconstruction. (C) Labelling the
sub-branches on the reconstruction to identify location of synapses for synapse
density measurements. (D) Reconstructions of two TmA neurons, purple and
orange, that synapse onto one of the sub-branches of the LGMD 2 neuron, to
determine which branch the synapses occur on.
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During the segmentation and reconstruction process incomplete arbours of TmA
neurons were noted. These were defined to be at either end of the dataset or to have
been partially reconstructed, because their branches were only partially identifiable
during segmentation. This could be due to the slice thickness and resolution of the
images being too large to be able to identify the finer processes. Examples of the
incomplete neurons can be found in Figure 2.23. Much of the analysis was performed
on all neurons, including incomplete and completely reconstructed arbours of the
TmA neurons to reduce bias, such as the analysis on synapse density. However, the
network analysis was primarily performed only on the completely reconstructed

arbours and analysis including the incomplete arbours is highlighted.

Figure 2.23 — Reconstructions of incomplete arbors of TmA neurons. (A) and
(B) show an example of a TmA neurons, light pink and light purple, which are only
partially reconstructed. (C) and (D) are examples of incomplete TmA neurons,
multi-coloured, that occur at the end of the dataset, both are the same dataset in
different views.
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2.4.4. Statistical Analysis

During the segmentation and reconstruction TmA neurons were labelled along with
synapses and neighbouring TmA neurons. This information was compiled into a
spreadsheet, with information on location, such as slice numbers and branch
identification, such as main or sub-branch as well as specific LGMD 2 neuron branch
identity. From this, a nodes list was developed, where 1 node is a TmA neuron and
the 2" node the neighbour. This was used to create connectomes in MATLAB. Other
analysis was performed on the information in the spreadsheet. All graph production
was performed in Microsoft Excel. The statistical analysis performed, included Mann-
Whitney U test (for hub v non-hub) and Kruskal-Wallis with post-hoc Bonferroni test

(branch innervation). All statistical analysis was performed in SPSS.

The dataset can be accessed at https://doi.org/10.5281/zenodo.1434744.
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2.5. Optimised Procedure for Segmentation, Reconstruction and Analysis of
Guinea Pig Skeletal Muscle

2.5.1. Identification of Skeletal Muscle Cell Components

The health of the cell and mitochondria was checked using TEM to obtain high
magnification and high-resolution images of mitochondria, examples of these are
seen in Figure 2.24. Once collected, all the datasets went through the same
processing steps. This consisted of opening the datasets in Fiji and the contrast was
normalised and enhanced when needed, Figure 2.25(A) and (B). The images were
then converted into a .tif format from the .dm3 collected and opened in MIB for
segmentation. From the datasets the nuclei and mitochondria could be identified, as

well as other structures found surrounding the muscle cells.
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Figure 2.24 — Examples of high resolution TEM images of mitochondria from
analysed samples. (A) Adult Soleus, 19000x (B) Adult Psoas, 25000x (C) Foetal
day 60-64 Soleus, 25000x (D) Foetal Day 60-64 Psoas, 19000x. Mitochondria are
labelled with white arrows and a Nucleus with N. Scale bar 500nm.
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Figure 2.25 — Steps of image processing from raw images to segmentations.
(A) Raw images of slice number 1, 10 and 20 from a larger dataset (~250
sections) of the adult guinea pig soleus muscle in transverse. (B) The same slices
that have been processed using Imaged (Fiji). For all datasets collected the
contrast was normalised across the dataset and then increased. (C) The
processed images were used for segmentation, example of mitochondria (light
blue) is shown. Scale bars 5um, images 5000 x 5000 pixels and 10nm resolution.
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2.5.2. Segmentation and Reconstruction of Nuclei

The nuclei were segmented using semi-automatic methods, specifically the
watershed brush and interpolation; and the cell using the watershed brush and
interpolation. For the segmentation of the nuclei, 50 sections from one of the polar
ends of the nucleus was reconstructed. The cell was reconstructed in both cases
for the same 50 sections that corresponded to nuclei that had been segmented.

Example of reconstructed nuclei is seen in Figure 2.26.
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Figure 2.26 — Example of segmentation of mitochondria and nuclei from 50
sections. (A) Singlesection of adult guinea pig soleus muscle, showing muscle
cell in transverse in the centre with two nuclei labelled, N, mitochondria, circled,
capillary, C, and a red blood cell, X. (B) and (C) show 3D reconstructions of the
two nuclei, magenta, and mitochondria, light blue, respectively both with
orthoslice. Reconstructions without orthoslice shown (D) and flipped (E). Scale
bars 5um, image size 5000 x 5000 pixels and 10nm resolution. Video:
https://doi.org/10.6084/m9.figshare.7140380.v3
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2.5.3. Segmentation and Reconstruction of Mitochondrial Network

The mitochondrial network was segmented using a combination of manual and
thresholding tools. First the cell was selected using the manual brush tool and
interpolation, the selection was then added to the mask layer. When the ‘mask only’
was ticked in MIB, the segmentation was only performed in the masked area. The
thresholding tool was then used to select the mitochondria within the cell or masked
area. This was also used for segmenting the area of IMF mitochondria over 200

sections.

From the reconstructions various measurements were made in Amira. Mitochondria,
from the whole cell, were segmented over 50, 75 and 100 sections and their volume
measured. The results were compared to determine the pragmatic number of
sections needed to take to get a representative value relative to estimates of cell
volume, Table 2.4. Nuclei were removed from the analysis to ensure that calculations
were based only on the volume of the cell that could be occupied by mitochondria.
This indicated that estimates of the percentage of cell volume occupied by
mitochondria were similar when using 50, 75 or 100 sections of data. Therefore, in all
subsequent work, to analyse the mitochondrial network data from 50 sections of the
dataset were segmented, as well as any nuclei that were present in those first
sections. The cell boundaries/volume was reconstructed in both cases for the same
50 sections that corresponded to mitochondria that had been segmented.

Table 2.4 — Mitochondrial Volume Test Results. Mitochondria were segmented
over 50, 75 and 100 sections. Volume measurements were made on each dataset
and compared to determine the minimum number of sections required for a

representative value based on the homogenous nature of the muscle and
mitochondrial network.

Dataset No. of Mitochondrial Cell Volume, Percentage, %
slices Volume, pm? pm3

100 310.21 1969.00 15.75
Adult 75 234.64 1490.58 15.74
Psoas 50 156.13 990.92 15.76
fetal day 100 70.00 800.62 8.74
60-64 75 54.91 601.11 9.13
Psoas 50 37.41 398.70 9.38
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From these testing results a difference can already be seen between the fetal and
adult mitochondrial volume, the biological contextualisation of the data is given in

Results section 3.2.2 (pg142) and Discussion section 4.2.2 (pg193).

This segmented portion was divided up into IMF, SS and Peri-nuclear (PN) based on
location, Figure 2.27. The SS mitochondria were defined as being between the cell
boundary and the first layer of sarcomere. Sometimes these SS mitochondria
extended towards the centre of the cell but, if the majority of the mitochondrion was
between the sarcolemma and sarcomere, it was defined as being SS. The PN
mitochondria were segmented in a similar way, but instead of the sarcolemma it was
the nuclei that defined the boundary. So that any mitochondrion located in the area
around the nuclei and between the nuclei and sarcomeres or sarcolemma was
designated as PN. The remaining mitochondria were labelled as IMF. This was
performed on the network segmentation and the individual mitochondrion

segmentation.

Intermyo-

fibrillar \

Perinuclear

Sub- ‘

sarcolemmal

Figure 2.27 — Labelled single section of intermyofibrillar, subsarcolemmal
and perinuclear mitochondria. Single section from adult soleus muscle in
transverse with the mitochondria divided into subsarcolemmal (SS), light blue,
intermyofibrillar (IMF), purple, and perinuclear (PN), dark blue, with nuclei labelled,
N. Scale bar 5um.
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For mitochondrial network analysis a portion of IMF mitochondria was reconstructed
over 200 sections, as described above. The model files were opened in Amira and
the surfaces generated. The ‘Auto-skeleton’ function was applied to the .am file to
create a skeletonised version of the reconstruction. From the skeleton, angle
measurements could be made to determine which segments or portions of the
skeleton or branches extend along the transverse plane. Via a process of elimination,
the angle 50° was chosen as the representative angle for segments branching along
the XY axis with smallest rate of error, shown in Figure 2.28. All segments with an
angle greater than 50 degrees was counted as a branch and proportion of segments
>50 and <50 was obtained. The larger reconstructions would sometimes have more
segments than true to the reconstruction. When this occurred, the model was eroded
by a small factor in MIB in order to maintain the morphology of the network but

reduce the rate of error during skeletonisation.
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Figure 2.28 — Angle measurement of skeletonised mitochondrial network.
Reconstructed portion of IMF mitochondrial network from a foetal day 50-54
soleus cell skeletonised in Amira. Each image shows highlighted portion of the
skeleton at certain angle measurements, (A) 0-9° (B) 20-29° (C) 50-59° (D)
70-89°.
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2.5.4. Segmentation and Reconstruction of Individual Mitochondria

To analyse whole individual mitochondria, a method for randomly selecting
mitochondria was implemented. A grid, with 1 to 5um squares, was placed on all
250 slices and a number randomly generated between 50 and 200, corresponding
to a chosen slice number. The size of the datasets used in this analysis were 250
sections but to ensure the maximum number of whole mitochondria could be
segmented, the slice number was chosen between 50 and 200. On the randomly
generated slice number every mitochondrion that crossed the grid lines was
followed through the dataset, Figure 2.29. The individual mitochondrion had to be
followed and segmented manually and only the mitochondria that started and ended

within the dataset (250 sections) were segmented.
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Figure 2.29 — Random selection of mitochondria for analysis of
individual whole mitochondria. (A) Example of single section from adult
guinea pig soleus muscle with bold grid in white superimposed on the image.
(B) The chosen section, from random number generation, and grid showing
segmentation of individual whole mitochondria that intersect with the grid
lines. (C) 3D reconstruction of the individual mitochondria, multi-coloured,
from the example dataset. Scale bar 5um, image size 5000 x 5000 pixels and
10nm resolution. Video: https://doi.org/10.6084/m9.figshare.7140713.v3
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2.5.5. Statistical Analysis

All statistical analysis and graphs were produced in Microsoft Excel and MATLAB.
Throughout the results the mean and standard deviation is presented in brackets, as
(mean t standard deviation). A one-way Anova was performed across the groups
with post-hoc Bonferroni test to test between the groups, and paired T-test was used
when needed, for example for comparison between the two muscles. All statistical
analysis was performed in SPSS. The results from one-way Anova test, performed
for age group comparison, is presented in text and the post-hoc Bonferroni or T-Test

is shown on the graphs.

All of the raw datasets have been made available online, links to access the
datasets and parameters are shown in Table 2.5. Links to videos of the

reconstructions are stated in associated figure legends.
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Table 2.5 — Access links to skeletal muscle datasets. Links to all of the datasets
analysed in this project with the parameters for each dataset.

Age Tissue Code nm/ No.of X&Y, Z, Access Link
Type pixel Slices pixels nm
163 https://doi.org/10.52
Adult Psoas 10 250 4000 70
Cell 1 81/zen0do.1434998
165 https://doi.org/10.52
18 250 3000 70
Cell 1 81/zen0do.1434998
165 https://doi.org/10.52
19 250 3000 70
Cell 2 81/zen0do.1434998
165 https://doi.org/10.52
19 250 3000 70
Cell 3 81/zen0do.1434998
166
https://doi.org/10.52
Cell 1 11 250 5000 70
81/zen0do.1434998
and 2
166 https://doi.org/10.52
11 250 5000 70
Cell 3 81/zen0do.1434998
162 https://doi.org/10.52
Adult Soleus 22 250 3000 70
Cell 1 81/zen0do.1435432
162 https://doi.org/10.52
28 250 3000 70
Cell 2 81/zen0do.1435432
164 https://doi.org/10.52
10 250 5000 70
Cell 1 81/zen0do.1435432
164 https://doi.org/10.52
10 250 5000 70
Cell 2 81/zen0do.1435432
166 https://doi.org/10.52
8 300 5000 70
Cell 1 81/zen0do.1435432
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166

https://doi.org/10.52

8 300 5000 70
Cell 2 81/zen0do.1435432
275
Foetal
Pup 1 https://doi.org/10.52
Day Psoas 13 385 3000 70
Cell 1,2 81/zenodo.1435532
60-64
and 3
275
Pup 2 https://doi.org/10.52
15 288 3500 70
Cell 1 81/zenodo.1435532
and 2
275
https://doi.org/10.52
Pup 3 9 311 2000 70
81/zenodo.1435532
Cell 1
275
https://doi.org/10.52
Pup 3 8 291 5000 70
81/zenodo.1435532
Cell 2
Foetal 275
https://doi.org/10.52
Day Soleus  Pup 1 9 270 3000 70
81/zenodo.1435536
60-64 Cell 1
275
https://doi.org/10.52
Pup 1 9 272 3000 70
81/zenodo.1435536
Cell 2
275
https://doi.org/10.52
Pup 2 8 300 3000 70
81/zenodo.1435536
Cell 1
275
https://doi.org/10.52
Pup 2 8 402 4000 70
81/zenodo.1435536
Cell 2
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275

https://doi.org/10.52

Pup 3 8 296 3500 70
81/zenodo.1435536
Cell 1
275
https://doi.org/10.52
Pup 3 8 268 4000 70
81/zenodo.1435536
Cell 2
Foetal 521
https://doi.org/10.52
Day Psoas Pup 1 7 290 3000 70
81/zenodo.1435581
55-59 Cell 1
521
https://doi.org/10.52
Pup 1 07 290 3000 70
81/zenodo.1435581
Cell 2
521
https://doi.org/10.52
Pup 4 9 250 2000 70
81/zenodo.1435581
Cell 1
521
https://doi.org/10.52
Pup 4 9 250 2000 70
81/zenodo.1435581
Cell 2
521
https://doi.org/10.52
Pup 4 9 250 2000 70
81/zenodo.1435581
Cell 3
523
https://doi.org/10.52
Pup 4 8 297 3000 70
81/zenodo.1435581
Cell 1
Foetal 523
https://doi.org/10.52
Day Soleus Pup?2 8 422 3000 70
81/zenodo.1435584
55-59 Cell 1
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523

https://doi.org/10.52

Pup 2 259 3000 70
81/zenodo.1435584
Cell 2
523
https://doi.org/10.52
Pup 3 321 3000 70
81/zenodo.1435584
Cell 1
523
https://doi.org/10.52
Pup 3 319 3000 70
81/zenodo.1435584
Cell 2
523
https://doi.org/10.52
Pup 5 269 3000 70
81/zenodo.1435584
Cell 1
523
https://doi.org/10.52
Pup 4 269 3000 70
81/zenodo.1435584
Cell 2
Foetal 522
https://doi.org/10.52
Day Psoas Pup 1 300 2500 70
81/zen0do.1435725
50-54 Cell 1
522
https://doi.org/10.52
Pup 1 300 2500 70
81/zen0do.1435725
Cell 2
522
https://doi.org/10.52
Pup 2 299 3500 70
81/zen0do.1435725
Cell 1
522
https://doi.org/10.52
Pup 2 300 3500 70
81/zen0do.1435725
Cell 2
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522

https://doi.org/10.52

Pup 3 300 3000 70
81/zen0do.1435725
Cell 1
522
https://doi.org/10.52
Pup 3 300 3000 70
81/zen0do.1435725
cell 2
Foetal 522
https://doi.org/10.52
Day Soleus  Pup 1 300 3000 70
81/zenodo.1435729
50-54 Cell 1
522
https://doi.org/10.52
Pup 1 298 2000 70
81/zen0do.1435729
Cell 2
522
https://doi.org/10.52
Pup 2 307 3000 70
81/zenodo.1435729
Cell 1
522
https://doi.org/10.52
Pup 2 247 2500 70
81/zenodo.1435729
Cell 2
522
https://doi.org/10.52
Pup 3 300 2000 70
81/zenodo.1435729
Cell 1
522
https://doi.org/10.52
Pup 3 287 2500 70
81/zeno0do.1435729
Cell 2
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Chapter 3. Results

3.1. Locust Results

3.1.1. Reconstructions

From the SBF-SEM dataset collected a length of ~47.11um of a branch of the LGMD
2 neuron was reconstructed as well as any TmA neurons found to synapse onto the
branch. In total 360 synapses were found to occur onto the LGMD 2 neuron
branches and the TmA neurons associated with all were reconstructed, shown in
Figure 3.1. The segmentation of the LGMD 2 neuron, TmA neurons and synapses
took roughly 9 months, average 6hrs a day and 5 days a week. The average
diameter of this branch of the LGMD 2 neuron was found to be 12um, calculated by
taking a diameter measure every 10 sections, making it one of medium diameter.
The TmA neurons were followed through the dataset allowing for a full reconstruction
of them. This branch of the LGMD 2 neuron was termed the primary branch (* in
Figure 3.1). The TmA neurons also synapsed on subsequent neighbouring branches
of the LGMD 2 neuron that were not traced to the large primary branch analysed and
were therefore called secondary branches. These secondary branches were also
reconstructed, a total of 9 more branches. The synaptic partners of the TmA neurons
were also mapped for 7 of the 9 secondary LGMD 2 neuron branches. In total 216
TmA neurons were followed. For 92 of the TmA neurons, the complete terminal
arbour was reconstructed (as described in the methods), referred to as complete
neurons from now on. Including all the 10 branches, 1171 synapses onto the LGMD
2 neuron were found, with synaptic partners labelled for all. The TmA neurons first
pass through the medulla, then cross in the second optic chiasm into the outer lobula
region (OLO) of the optic lobe Rosner et al. (2017), to synapse upon the LGMD 2
neuron, Figure 3.1. From the reconstructions it can be seen that the TmA neurons
synapse upon the LGMD 2 neuron in an organised manner. All TmA neurons, except
two, follow a similar angular path, as shown in the reconstructions. The TmA neurons
appear to have distinct regions of the LGMD 2 neuron where they terminate. This is
indicative of a conserved retinotopic mapping present from the facets of the eye, with
one facet associated with one TmA neuron, which in turn synapses with a single
portion or area of the LGMD 2 neuron. Due to limited field of view, it cannot be
determined from this dataset whether the TmA neurons found here also synapse

upon the LGMD 1 neuron.
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Figure 3.1 — Overview of reconstructed LGMD 2 neuron branches and TmA
neuron segmentations. (A) Shows the reconstructions of the LGMD 2 neuron
branches reconstructed, light blue. As well as all 92 TmA neurons, multi-coloured,
that were found to synapse onto the primarily analysed branch, (*). (B) and (C)
show the reconstructions with reference to the orientation of the neurons within the
optic lobe, including the protocerebrum and medulla and anterior and posterior
direction of the lobula. Scale bars are 5um. Video:
https://doi.org/10.6084/m9.figshare.7172432
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3.1.2. Synapse Distribution Across the LGMD 2 Neuron Branch

The location of the synapses made by TmA neurons on one of the LGMD 2 branches
(primary branch), encompassing a main larger branch and smaller processes or sub-
branches, extending from the main branch, were reconstructed (examples and
reconstructions shown in Figure 3.2). The maijority of the synapses were found on the
larger branch, 245 (68%), with 115 (32%) on the smaller branches. However, the
synapses were denser on the smaller processes, with a higher concentration of
synapses over a smaller area and very few gaps between synapses. Along the larger
main branch there were regions where there were no or few synapses present. When
the synapse number by surface area was measured there was a higher density of
synapses seen on the majority of the smaller branches (Figure 3.3). The large branch
has an average of 0.18 synapses per 1um?, whereas the smaller branches have an
average 0.52 synapses per 1um?, numbers ranging in the smaller branches from

0.17 to 0.81 synapses per 1um?>.
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Figure 3.2 — Distribution of synapses along larger and smaller branches of a
portion of the LGMD 2 neuron. (A) Shows cropped area of a slice from the
dataset, with the second image showing the segmented synapses, red,
surrounding the larger (main) branch of the LGMD 2, marked with a star. (B)
Shows the reconstructions of the synapse segmentations, red, on the main
branch, blue. The area the section was taken from is indicated by a box and two
views are shown. (C) Cropped area from a single slice focusing on a sub-branch
of the LGMD 2 (star). The second image shows the segmentation of the synapse
around the smaller branch, red. (D) Example of reconstructions of the synapses,
red, on one of the sub-branches. The area the section was taken from is indicated
by a box and two views are shown. Scale bar for (A), (B) and (D) is 5um for (C)
scale bar is 1 um. Video: https://doi.org/10.6084/m9.figshare.7172435
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Figure 3.3 — Results from distribution of synapses along larger and smaller
branches. Results of synaptic density (number of synapses per um? of surface
area) of the main branch of the LGMD 2 neuron and the sub-branches originating
from the main branch.
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3.1.3. Connectivity in Z Direction

As detailed in the methods the final TmA neuron labels at each synapse were a
combination of partially reconstructed neurons and TmA neurons whose terminal
arbour was completely reconstructed. The analysis into the connectivity of the TmA
neuron and LGMD 2 neuron branches was performed solely on the completely TmA
arbours (with some exceptions for the connectome diagrams). As the TmA neurons
were followed through the dataset information on the synapsing partners of the TmA
neurons and the network of the TmA neurons was compiled. A single TmA can form
a reciprocal synapse with another TmA neuron once or multiple times and potentially
with different partners. An example of this is seen in Figure 3.4, showing how a single
TmA neuron can synapse twice onto the LGMD 2 but in the second case with a

different TmA neuron partner.

Figure 3.4 — Formation of TmA neuron network via different synaptic
partners. (A) Example of synapse between two TmA neurons, orange (+) and
light pink (white *), onto the LGMD 2 neuron, blue. (B) The reconstruction of the
TmA neurons at the synapse, green presynaptic density indicated by arrow. (C)
The same TmA neuron, orange (+), with a different synaptic partner, dark pink
(black *), both synapsing onto the LGMD 2. (D) The reconstruction of the synapse,
green presynaptic density indicated by black arrow. Scale bar on orthoslice is 1um
and on 3D model is 5Suym. Video: https://doi.org/10.6084/m9.figshare.7172441.v2
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The connectomes shown in Figure 3.5 map the synaptic partners of the TmA
neurons and how many times that particular connection is made, indicated by the
colour. The label of the neuron is spatial, with the lower numbers indicating a TmA
neuron at the beginning of the dataset, thus further away from the medulla,
compared to the neurons with a higher number label at the end of the dataset, closer
to the medulla. The connectome diagram of the complete TmA neurons, show that
they primarily synapse within a certain area of the dataset with nearby TmA neurons.
This results in a network of connected TmA neurons over the LGMD 2 neuron
branches. The individual TmA neurons have overlapping regions of connectivity but
are still limited to a portion of the dataset, such that no TmA neuron from the
beginning of the dataset synapses with a TmA neuron from the end of the dataset.
Some TmA neuron to TmA neuron connections occur only once, but the majority of
the TmA neuron to TmA neuron connections occur twice or three times, with a small
proportion occurring upwards and including 7 times, as indicated by the colour code
in the connectomes, Figure 3.5. A number of TmA neurons were also noted at having
a high number of synapses, compared to others (indicated with white lines in Figure
3.5 (B). To assess this and the connectivity further the total number of synapses,
number of synaptic partners and the frequency of connections with the same partner

was analysed.
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Figure 3.5 — Connectomes of TmA neuron v TmA neuron. (A) Connectome of
all TmA neurons onto TmA neurons N=216, synapse n = 1171. (B) Connectome
of only the 92 completely reconstructed neurons N=92, synapse n = 837. In this
plot TmA neuron 93 is the sum of all the partial neurons identified. For both
connectomes the colour of each square, denoted in the heat-scale on the figure,
indicates the number of times that a specific pre and post TmA neuron connection
occurs. TmA neurons making a large number of synapses are delineated in white.
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The frequency of TmA neuron partners and the total number of synapses is shown in
Figure 3.6. The majority of the 92 TmA neurons with completely reconstructed
arbours synapse between three and 10 times onto the LGMD 2 neuron, with a range
from 1 to 26 times and a median of 8. As not all the synapses from a TmA neuron are
with different partners, the number of synaptic partners was quantified, only taking
into account the completely reconstructed terminal arbours of the TmA neurons. As
shown in Figure 3.7, the highest number of the TmA neurons have at least 2 different
synaptic partners, with the median of different partners being 4. The range extended
from 1 to 13 partners. The number of synapses made with the same partner also
varies, from the TmA neurons that only have one neighbour (9), three only synapse
once, while the others synapse multiple times with the same partner. This led onto
the next analysis, where the number of times a TmA neuron synapsed with the same
partner was plotted. The graph in Figure 3.8 shows the frequency of times a neuron
synapses with the same partner. The majority of the neurons synapse 2 to 3 times
with the same neighbour. The range was from 1 to 7, with two pairs of neurons found

to synapse with each other 7 times.

118



12

10 -

Frequency
(o)} [e:]

FN
1

; 11,

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26
Total No. of Synapses

Figure 3.6 —Total number of synapses from individual TmA neurons. (A)
Graph showing the frequency of TmA neurons that synapse between 1 and 26
times. Median = 8, IQR (25™") = 5, IQR (75") = 12, Range = 1-26. (B)
Reconstruction of the TmA neuron which synapses the highest number of times
onto the LGMD 2 neuron (26). (C) Example of a TmA neuron, which only
synapses once onto the LGMD 2 neuron branch. Scale bars 5um. Video:
https://doi.org/10.6084/m9.figshare.7172450.v2
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Figure 3.7 —Number of synaptic partners found for individual TmA neurons.
(A) Graph of the frequency of unique connections made by individual TmA
neurons that is the number of different synaptic partners (TmA neurons can
synapse with same partner multiple times). (B) Example of TmA neuron known to
have a high number of multiple synaptic partners. (C) Reconstructions of the
same neuron, labelled with arrow, with some of the synaptic partners (5 out of 12
partners shown). (D) Example of a neuron with only one other synaptic partner
and same neuron is shown, labelled with arrow, with the single partner in (E).
Median = 4, IQR (25") = 2, IQR (75™") = 5, Range = 1-13. Video:
https://doi.org/10.6084/m9.figshare.7172453.v2
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Figure 3.8 — Frequency of TmA neurons synapsing with the same partner.
(A) Shows the results of analysing the number of times a TmA neuron synapses
with the same partner and frequency of TmA neurons that share the same
number. (B) Shows reconstruction of two pairs of TmA neurons that synapse with
each other on only 2 occasions. Median = 2, IQR (25)=2, IQR(75)=3, Range = 1-
7. Scale bar 5um. Video: https://doi.org/10.6084/m9.figshare.7172462.v2
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A schematic of the network to highlight these concepts was drawn, shown in Figure
3.9. Starting from a TmA neuron (149) that synapsed only once with another TmA
neuron (88), the synaptic partners of this TmA neuron (88) was then added (TmA
neuron 123) and so forth, including those connections found between slice 270 and
slice 350 of the reconstruction. The diagram shows how the TmA neurons have a
specific region in which they contact the LGMD 2 neuron and interact with other TmA
neurons. These areas overlap, with TmA neurons having varied total numbers of
synapses and synaptic partners. As found from the earlier results a small population
of TmA neurons stood out by having a high number of synapses and also high
number of synaptic partners, TmA neuron 115 and 123 for example, labelled with

asterisks in Figure 3.9.
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Figure 3.9 — Schematic of a portion of the network of TmA neurons synapsing
onto the LGMD 2 neuron. The diagram shows a small portion of the pattern of
synapsing TmA neurons synapsing on the LGMD 2 neuron (~80 slices). Each
coloured line represents a different segmented neuron, colour matching the
segmentation and reconstruction colour, only a portion of the synaptic partners for the
neurons are also shown and only a small number of the synapses that occur within
the region shown are presented. This map includes TmA neurons with both fully and
partially reconstrued arbors. TmA neurons with high number of synapses are marked

(*)-
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Figure 3.9 — Schematic of a portion of the network of TmA neurons
synapsing onto the LGMD 2 neuron. The diagram shows a small portion of the
pattern of synapsing TmA neurons synapsing on the LGMD 2 neuron (~80
slices). Each coloured line represents a different segmented neuron, colour
matching the segmentation and reconstruction colour, only a portion of the
synaptic partners for the neurons are also shown and only a small number of the
synapses that occur within the region shown are presented. This map includes
TmA neurons with both fully and partially reconstrued arbors. TmA neurons with
high number of synapses are marked (*).
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To determine whether there were two groups of neurons, the total number of
synapses was plotted against the number of postsynaptic partners, seen in Figure
3.10(A). There was a positive correlation between total number of synapses and
number of unique connections (p=2.67E-36) found. From this relationship, a

connectivity index was calculated:

Connectivity Index=Total Number of Synapses (n) x Number of Unique partners (N)

100

When this index was plotted against the total number of synapses (Figure 3.10(B)) a
positive correlation was shown and formation of two groupings is seen. When the
connectivity index is plotted alone the distinction between two groups is larger
(Figure 3.10(C)). From these graphs, a cut-off was decided based on a connectivity
index of 1 (shown as a black line on the graph 3.10(C)). In total 12 neurons were
found to have a higher connectivity index then 1 and named ‘hub neurons. These
neurons synapse a minimum of 12 times and up to 26 times (mean= 18) onto the
LGMD 2 branches and have from 7 to 13 unique partners (mean= 10). The
connectivity index distribution of the hub and non-hub neurons is plotted in Figure

3.11(A), indicating a highly connective sub-group of TmA neurons.

The synaptic distance and range were also measured for all neurons so as to
compare between the two groups. The synaptic distance was calculated by
cumulating the number of sections the TmA neuron made synaptic contact with the
LGMD 2 neuron. The synaptic range is the distance, determined by number of slices,
between the slice at which the TmA neuron first synapses to the last slice at which it
synapses, irrespective of whether it was synapsing or not synapsing. For both
measures there was significant difference found between the hub and non-hub
neurons (Figure 3.11(B) and (C)). For the distance and range, the hub neurons were
found to have a mean of 6.14um and 10.41um and the non-hub mean of 2.75um and
4.72um, respectively. The hub neurons had a larger synaptic range and synapsed for

longer along the LGMD 2 neuron branches.
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Figure 3.11 — Comparison of ‘hub’ and non-hub neurons. (A) The
connectivity index for the hub and non-hub neurons. Hub median = 1.49,
IQR(25") = 1.35, IQR(75") = 1.91 and range = 1.08-2.99. For non-hub, median =
0.16, IQR(25™) = 0.06, IQR(75") = 0.42, and range 0.01-0.91. (B) Comparison of
synaptic distance, measure of synaptic contact with the LGMD 2. For the hubs,
median=5.88, IQD(25)=5.45, IQD(75)=6.65, range 4.1-8.52 and non-hub,
median=2.58, IQR(25)=1.5, IWR(75)=3.66, range=0.24-7.32, (*) p<0.05. (C)
Comparison of the synaptic range, distance from first synapse to last synapse.
The hub median=10.8, IQR(25)=7.94, IQR(75)=12.36, range=4.44-16.86 and
non-hub median=4.2, IQR(25)=2.37, IQR(75)=6.2, range=0.24-14.16. (*) p<0.05.
The mean of each group is also plotted on the graphs (X) and the data points (O)
and for all the Hub neurons are shown in green (n=12) and the non-hub neurons
in red (n=80).
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The reconstructions of the hub neurons are shown in Figure 3.12. They appear more
complex than non-hubs, as shown in Figure 3.12(A) and (B). The hub neurons were
also found to be situated around branches of the LGMD 2 neuron, with all neurons
synapsing onto the primary branch as well as the secondary branches of this
reconstructed portion of the LGMD 2 neuron (Figure 3.12(C)).
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Figure 3.12 — Reconstructions of the ‘hub’ neurons. (A) and (B) Show
examples of a hub (red) and 2 non-hub neurons (purple and orange), with
different complexities. (C) Shows the reconstructions of all of the ‘hub’ neurons
(multi-coloured), n=12, and the LGMD 2 neuron branches (light blue). All scale
bars 5um. Video: https://doi.org/10.6084/m9.figshare.7172465.v2
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3.1.4. Connectivity in X and Y Direction

A small portion of TmA neurons followed from the main LMGD 2 neuron branch were
found to synapse upon neighbouring branches of the LGMD 2 neuron as well.
Representative example reconstruction of those TmA neurons and their post-
synaptic LGMD 2 neuron branches can be seen in the reconstructions in Figure
3.13(A-G). By following and mapping the TmA neurons and the branches they
synapse upon, three types of synaptic distribution across the LGMD 2 neuron were
proposed. Firstly, TmA neurons could synapse upon one branch solely, secondly,
they could synapse primarily on a single branch with a small proportion of synapses
on another branch and lastly, they could synapse evenly across multiple branches.
This is shown in a schematic in Figure 3.13(H). This would also give an indication of
the connectivity that occurs in the X and Y direction, across the branches of the
LGMD 2 neuron.
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Branch 5

Figure 3.13 — Synapse distribution on multiple branches of the LGMD 2
neuron. (A) — (G) All show reconstructions of the main LGMD 2 neuron branch
analysed with other branches, that are connected via TmA neurons, multi-
coloured. (H) Schematic of the pattern of synapse distribution found between
neighbouring branches. Some TmA neurons will synapse onto a single branch of
the LGMD 2 neuron only (middle), others synapse primarily onto one branch with
a small number onto another branch (right) and the last group were found to
synapse onto two separate branches equally (left). All scale bars 5um. Video:
https://doi.org/10.6084/m9.figshare.7172438
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The TmA neurons and the post-synaptic LGMD 2 neuron branch were mapped in a
connectome diagram, shown in Figure 3.14. The diagram shows each of the LGMD 2
neuron branches the TmA neuron synapse and how many times that specific
connection is made, indicating the distribution of the synapses of the TmA neurons
across the dendritic branches of the LGMD 2 neuron. From the analysis of the
complete TmA neurons against LGMD 2 neuron branch (Figure 3.14(B)), it was
determined that only a small proportion of TmA neurons synapse across multiple
branches. From the connectome it was determined that within the TmA neurons that
synapse on more than 1 branch a small number synapse on more than 2 branches.
The frequency of TmA neurons that synapse on multiple branches was determined
and is shown in Figure 3.15A. The majority of neurons showed specificity and
synapsed primarily on one branch of the LGMD 2 (60%), with a proportion synapsing
onto 2 branches (32%) and very few synapsing onto 3 or 4 branches (total of 8%). A
total of 37 TmA neurons were found to synapse onto multiple branches. The
distribution of these synapses was analysed and is shown in Figure 3.15(B). Branch
1, 2, 3, and 4 in the figure are not always the same branch but are dependent on the
individual TmA neuron, the branch with the highest proportion of synapses is labelled
as branch 1 and so on. From this analysis it was determined that of those that
synapse onto multiple branches there is a preference to a single branch, all primarily
synapse onto one branch and have fewer synapses on another. This indicates that
from the proposed distribution patterns, the first and second are true. The TmA
neurons will synapse solely onto a single branch but of those that do synapse across

multiple branches there is still a single branch of preference.
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Figure 3.14 — Connectome of TmA neuron V LGMD 2 neuron branches. (A)
Connectome of all TmAs onto separate branches of the LGMD 2 neuron, labelled
1-10, TmA neuron N=216, synapse n = 1171. (B) Connectome of only the whole
reconstructed TmA neurons onto the LGMD 2 neuron branches, N=92, synapse n
= 837. The colour of each square indicates the number of times that specific
connection occurs, denoted in the figure legend on both connectomes. The hub
neurons are highlighted in white.

133



When the hub neurons were isolated for the frequency distribution histogram, the
majority were shown to synapse across multiple branches, with only 2 hub neurons
(from 12) synapsing onto a single branch only (Figure 3.15(C)), whereas the vast
majority of the non-hub neurons synapsed onto one branch only (Figure 3.15(C)),
further evidence for the highly connective nature of the hub neurons. This confirms
that the hub neurons innervate a larger portion of the LGMD 2 neuron than the non-
hub neurons, both along the branches and across the branches of the LGMD 2
neuron. The graph in Figure 3.15(B) also shows that a small number of neurons, not
identified as hub neurons also synapse onto multiple LGMD 2 neuron branches.
However, when the incomplete TmA neurons were removed for any synapse, they
had with a complete TmA neuron, they were referred to as unknown synaptic
partners for the analysis. As the incomplete neurons could be portions of the same
neuron and the identity is not known. The synapses with at least 1 unknown partner
were not included in the connectivity analysis, detailed above. Although it does

suggest that there could be more hub neurons present.
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Figure 3.15- Analyses of branch frequency and distribution. (A) Shows the
frequency or number of neurons that innervate 1, 2, 3 or 4 unassociated branches
of the LGMD 2 neuron. (B) Shows the synapse distribution on each branch for the
TmA neurons that synapse upon 2 or more branches of the LGMD 2 neuron. The
hub neurons are labelled (H). (C) The comparison of the distribution between the
hub (green, n=12) and non-hub (red, n=80).
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The neurons that innervate multiple branches were compared with those that only
synapse upon a single branch, shown in Figure 3.16. Significance was found for the
number of total synapses by a TmA neuron between those that synapse onto one
branch and those that synapse onto multiple branches (1 branch v 2 branches,
p=<0.05, 1 branch v 3 branches, p=<0.05), Figure 3.16(A). Significance was also
found between the group synapsing onto one branch compared to those that
synapse onto 2 branches for connectivity index (p=<0.05) but not for the other
groups, Figure 3.16(B). However, no significance was found between groups of TmA
neurons that perform multiple innervations on different branches. The TmA neurons
can also be further divided into a group based on whether they synapse onto one

branch or onto multiple.
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Figure 3.16 — Comparison of TmA neurons that innervate a single branch of
the LGMD 2 neuron with those that innervate multiple branches. (A) Is a
boxplot of the number of synapses for TmA neurons that synapse onto a single
branch (blue), two branches (purple), three branches (green) and four branches
(orange). (B) Is a box plot of the connectivity index of the four groups of TmA
neurons. In both graphs the mean is shown as a cross on the box plots.
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Overall, the analysis shows the existence of a connected TmA neuron network in
both directions, along and across the LGMD 2 neuron branches. This network is
shown in the diagram in Figure 3.17. Each line on the diagram represents a synapse
by the connected neurons onto the LGMD 2 neuron, with the type of line indicating
which branch this particular connection occurred upon. All of the connections
occurring on the main branch are shown plus a small proportion of synapses that
occurred on the secondary branches shown. The diagram primarily shows the
connections arising from the primary branch of analysis, with a small number of TmA
neurons that do not synapse upon the primary branch but are defined as hub
neurons from earlier analysis. The hub neurons are highlighted by having red
connections to their synaptic partner. The secondary connections from these
partners are in orange, the next layer in yellow and those furthest from the hub
neurons have green connections. Almost all TmA neurons are either directly
connected to a hub neuron or are within a single synapse distance from one, via a
shared synaptic partner. The TmA neurons furthest away are at the end of the
dataset and it is likely that they would be close to further hubs or could be hubs
themselves. The maijority of the hubs (n=10) were found to synapse upon the main
branch of focus in the dataset. The other hubs were found to primarily synapse with
another branch within the dataset. The hub neurons also stretch across multiple
branches but each of the hubs had a single branch of the LGMD 2 neuron they
mainly synapse upon. These hubs are vital to ensure that the TmA neuron network is
connected. This is shown when the hub neurons are removed from the network
diagram, seen in Figure 3.18. Without the hubs the network is not connected as a
whole, with smaller ‘islands’ of TmA neurons connected with one another instead. A
small number of TmA neurons (n=8) only synapse with the hub neurons and are no

longer connected within the network, circled in the diagram.
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Figure 3.17 — TmA neuron network diagram. The diagram represents the TmA
neuron network, each line denotes a synapse, which two TmA neuron neighbours
form. The type of line indicates the second post-synaptic target, the LGMD 2
neuron branch where that connection occurs. The colour of the line denotes the
distance from a hub neuron that connection is. The direct connections to a hub are
red, the next connections on are orange, the next yellow, and the furthest are in
green.
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Figure 3.18 — TmA neuron network diagram with ‘hub’ neurons removed.
The lines indicate a synaptic connection, and the type of line shows the branch of
the LGMD 2 neuron this connection is made upon. Without the hub neurons there
are 5 ‘islands’ of neurons that only connect with themselves. TmA neurons that
are no longer connected to any other TmA neuron, only partnered with the hubs,
are circled. n=8.
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3.1.5. Summary

In summary, each TmA neuron has two synaptic partners, a second TmA neuron and
the LGMD 2 neuron, which occur simultaneously within the lobula. This mapping of
synapses is organised and reflects the retinotopy preserved from the eye down to the
branches of the LGMD 2 neuron. This had been previously found in the LGMD 1 but
yet to proven to be the same onto the LGMD 2 neuron. The TmA neurons will
synapse multiple times with the LGMD 2 neuron and with the same or multiple TmA
neuron synaptic partners. The synaptic area of the TmA neurons overlap and via
shared synaptic partners a dense highly connected network has been found. This
network not only spreads down the LGMD 2 neuron but also across multiple
branches, connecting the neighbouring LGMD 2 neuron branches via the TmA
neuron network. Within this network the existence of a small group of highly
connective TmA neurons, hub neurons, has been found vital to ensure the network is
connected. The results from the reconstructions and subsequent analysis show that
the TmA neurons form an interconnected network, via formation of reciprocal
synapses at a specific location of the LGMD 2 neuron. This organization of this
network will impact on the integration of the signal across the LGMD 2 neuron. This
is further discussed in Chapter 4.1 (pg180).
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3.2. Muscle Results

3.2.1. Reconstructions

A total of 48 individual cells were imaged over 250-300 70nm thick sections. From
this the mitochondrial network was segmented for every cell for 50 sections, for
volume analysis and over 200 sections for the analysis on branching. A total of 2350
individual mitochondrion were segmented manually. From the datasets 56 nuclei
were also partially reconstructed. Along with mitochondria and nuclei the cell was
also segmented to be used in volume and density analysis of the mitochondria and
nuclei. In total, the analysis of the skeletal muscle data took roughly 10 months,

working for 6hrs a day, 5 days a week.
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3.2.2. Mitochondrial Network Analysis
Over development the mitochondrial network will grow in conjunction with the size of
the cell. So that as the muscle cells increase in size the mitochondrial network will as

well, maintaining a ratio between network and cell volume.

As detailed in the methods section, the mitochondrial network was segmented from a
partial volume of the whole dataset (50 sections), along with the corresponding cell
volume. Any nuclei present within the volume were segmented and their contribution
subtracted from the total cell volume. This was done to estimate the volume of

mitochondria per cell they could potentially occupy.

Figures 3.19 and 3.20 show examples of the reconstructions of the network at the 4
age groups studied. From the reconstructions for both muscle types, it can be
surmised that there is a change in the mitochondrial network from fetal to adult. The
volume of mitochondria occupancy of the psoas or soleus cells in the two earliest
fetal age groups (day 50-54 and day 55-59) appears less than in the older fetal group
(day 60-64) and the adult group. Overall, for both muscle types, the adult
mitochondrial network appears denser, and potentially more complex, than all of the

fetal age groups.
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Fetal Day
50-54

Fetal Day
60-64

Adult

Figure 3.19 — Examples of total mitochondria segmented from 50 sections of
psoas. (A) Single section from psoas muscle with mitochondria segmented, light
blue. (B) Shows the reconstructions of the example shown in the single sections,
with the segmented mitochondria, light blue, and the cell boundary, green. (C) The
model of only the mitochondria at an angle. Scale bars 5um for adult, fetal Day 60-
64, and fetal day 55-59 and 1um for fetal day 50-54 o on the orthoslice, all scale
bars on the 3D models are 5um. Video:
https://doi.org/10.6084/m9.figshare.7165591.v2
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Figure 3.20 — Examples of total mitochondria segmented from 50 sections of
soleus. (A) Single section from soleus muscle with mitochondria segmented, light
blue. (B) Shows the reconstructions of the example shown in the single sections,
with the segmented mitochondria, light blue, and the cell boundary, green. (C) The
model of only the mitochondria at an angle. Scale bars 5um for adult, fetal Day 60-
64, and fetal day 55-59 and 1um for fetal day 50-54 on the orthoslice, all scale
bars on the 3D models are 5um. Video:
https://doi.org/10.6084/m9.figshare.7166006.v2
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This is corroborated in the results shown in Figure 3.21. The percentage of the
reconstructed volume occupied by mitochondria was calculated to compensate for
the range of cell size present between the groups. For both muscle types there are
significant differences found between the age groups (p<0.05 for both psoas and
soleus). Upon further analysis significance was found between the day 50-54
(mitochondrial volume of 5.6+1.8% of cell volume for psoas and 5.8+1.8% for
soleus), 55-59 (4.7£1.6% and 7.1+1.3%) fetal age groups and the fetal day 60-64
(13.1£6% and 12.8+£3.3%) group for psoas and soleus and between day 50-54 and
adult (11+4.7%) group for the soleus only.

*
* [
* | 2 *
24 1 [ 1 .
22 . 18 '—*|

- o
.

Percentage, %
2 N

Percentage, %
» o

o N - o ]

Fetal Day 50-54
(n=6)
Fetal Day 55-59
(n=6)
Fetal Day 60-64
(n=6)

Adult (n=6)
Fetal Day 50-54
(n=6)
Fetal Day 55-59
(n=6)
Fetal Day 60-64
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Figure 3.21 — Results of percentage of portion of cell volume occupied by
mitochondria. (A) And (B) show the percentage of the reconstructed cell volume
from 50 sections, of a larger dataset (~250 sections), occupied by mitochondria for
the psoas and soleus, respectively. Each point is a result from a single cell, the
mean is denoted by the bar and significance is (*) p<0.05.

145



This is further highlighted when the volume of the cell is shown, in Figure 3.22. The
associated cell volume used for the mitochondrial density calculation shows
significance only between the fetal and adult groups for psoas and soleus (p<0.05).
Cell size does not show significance over fetal development for both muscles (day
50-54 is 276.3+107.6um?® and 310.6+113.1 ym3, fetal day 55-59 is 917.8+5113.8 ym?®
and 384.6+160.4 ym? and fetal day 60-64 is 836.5+365.4 um3and 773.8+498.1 ym?3
for soleus and psoas respectively) but there is a large increase between these

groups and the adults (4058.1£1517.2 um3and 2249.3+1631.1 um?3) for soleus and
psoas, respectively.
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Figure 3.22 — Results of portion of cell volume. (A) And (B) show the portion of
cell volume, same as used for mitochondrial density calculation, from 50 sections.

Each point is a result from a single cell, the mean is denoted by the bar and
significance is (*) p<0.05.
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Mitochondria can be divided into three distinct locations within the cell,
subsarcolemmal (SS), intermyofibrillary (IMF) and perinuclear (PN), shown in
Methods Figure 2.26. The proportions of mitochondria within each of these locations
changes over development. The reconstructions seen in Figures 3.23 and 3.24 show
how the percentage of the mitochondrial network in each of these areas differs
between the age groups. One of the noticeable differences is an increase in
mitochondria present sub-sarcolemmally between each fetal group up to the adult for
both muscle types. For this analysis only datasets containing nuclei in the

reconstructed volumes were analysed.
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Fetal Day
50-54
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Adult

Figure 3.23 — Examples of mitochondrial segmentation and reconstructions
divided by location for psoas. (A) Examples of a single section from each of the
age groups from the psoas muscle. The segmentation of mitochondria is divided
into locations SS, light blue, IMF, purple, and PN (when present), dark blue. (B)
The subsequent reconstructions of the 50 sections of segmented mitochondria
with cell boundary, green, and (C) show the same reconstructions without cell
boundary and different orientation. Scale bars 5um for adult, fetal Day 60-64, and
fetal day 55-59 and 1um for fetal day 50-54 on the orthoslice, all scale bars on the
3D models are Spym. Video: https://doi.org/10.6084/m9.figshare.7166093
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Figure 3.24 - Examples of mitochondrial segmentation and reconstructions
divided by location for soleus. (A) Examples of a single section from each of the
age groups from the soleus muscle. The segmentation of mitochondria is divided
into locations SS, light blue, IMF, purple, and PN (when present), dark blue. (B)
The subsequent reconstructions of the 50 sections of segmented mitochondria
with cell boundary, green, and (C) show the same reconstructions without cell
boundary and different orientation. Scale bars 5um for adult, fetal Day 60-64, and
fetal day 55-59 and 1um for fetal day 50-54 on the orthoslice, all scale bars on the
3D models are Spym. Video: https://doi.org/10.6084/m9.figshare.7166096.v2
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The volumes of IMF located mitochondria shows a large increase from the fetal
groups to the adult in both the psoas (15.6+11.5um3, 13.5+£9.0um3, 86.3+78.2um3
and 163.2+126.2um? for day 50-54, 55-59, 60-64 and adult, p<0.05) and soleus
(11.1£6.3um3, 58.2+47.6um3, 70.7+40.4 ym?® and 272.5+88.2um3 for day 50-54, 55-
59, 60-64 and adult, p<0.05). This is the same for the mitochondria located at the SS
for psoas (1.03+0.5 um3, 1.6+0.8 ym?3, 18.7+18.6 um?3 and 74.3+65.7um? for day 50-
54, 55-59, 60-64 and adult, p<0.05) and soleus (1.4+1.0 pm3, 6.0+2.5um3,
19.5+10.3um?® and 106.2+51.1um?3 for day 50-54, 55-59, 60-64 and adult, p<0.05).
There was no significance found within the group for PN located mitochondria in the
psoas (0.5+0.7um3, 1.7+£2.0um3, 6.5+10.2um?3 and 6.7+8.9um? for day 50-54, 55-59,
60-64 and adult) but there was in the soleus (1.3+1.3um3, 2.6+2.6um?3, 8.4+6.0um?
and 38.6+41.1um?3 for day 50-54, 55-59, 60-64 and adult, p<0.05). These are shown
in Figure 3.25(A-C) and 3.26(A-C).

To determine the proportion of mitochondria at each location the percentage of total
volume at each location was calculated. This is shown in Figure 3.25(D) and 3.26(D)
for the psoas and soleus respectively. Both muscles have a similar ratio of
mitochondria in each of the locations for all age groups. The highest proportion of
mitochondria are located in the IMF. The IMF percentage decreases from fetal day
50-54 to adult for the psoas (87.6+6.4%, 80.6£12.3%, 791£5.9% and 68.1+6.1% for
day 50-54, 55-59, 60-64 and adult, p<0.05) and soleus (79.41+9.8%, 82.9+8.0%,
70.217.6% and 66.8+8.3%, for fetal day 50-54, 55-59, 60-64 and adult, p<0.05).
Significance was found between fetal day 50-54 and adult for both psoas and soleus,
indicated on graph. In contrast there is an increase in percentage of mitochondria
located SS for psoas (9.6£6.8%, 9.9£3.5%, 16.6+7.6% and 27.9+5.6, for fetal day
50-54, 55-59, 60-64 and adult, respectively, p<0.05) and soleus (10+3.6%,
12.5+6.3%, 21.3+8.8% and 25.6+7.6% for fetal day 50-54, 55-59, 60-64 and adult,
p<0.05). Significance was specifically found between the fetal day 50-54 and adult
groups for both psoas and soleus, for the proportion of IMF and SS mitochondria.
There were no differences in the percentage of mitochondria in a perinuclear location

during development of either muscle tissue.
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group in the psoas. (A), (B) and (C) show the volume results for the IMF, SS and
PN locations respectively for the reconstructed mitochondrial volume (50
sections). (D) shows the percentage of the mitochondria volume at each of the
locations between the age groups. Only cells with nuclei present in the
reconstructions were analysed, signified by individual points, the mean is shown
as a bar chart and significance is (*) p<0.05.
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Figure 3.26 — Results of the mitochondrial volume for each location and age
group in the soleus. (A), (B) and (C) show the volume results for the IMF, SS
and PN locations respectively for the reconstructed mitochondrial volume (50
sections). (D) shows the percentage of the mitochondria volume at each of the
locations between the age groups. Only cells with nuclei present in the
reconstructions were analysed, signified by individual points, the mean is shown
as a bar chart and significance is (*) p<0.05.
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The complexity of the mitochondrial network is important for function of the cell. How
the network changes over development are unknown. As such a portion of IMF
mitochondria was segmented over 200 sections, reconstructed and analysed for
evidence of network complexity via an assessment of branching, as described in the
methods. Figure 3.27 shows the results from the branching analysis as a percentage
of segments above the threshold degree. In the comparison between psoas and
soleus, the only significance found was between the adult psoas and soleus. There
was significantly less branching in adult psoas (5.8+3.2%) than the soleus
(29.3+15.1%), as shown on the graph. For the comparison across development
groups, the soleus muscle showed no change in mitochondrial branching. However,
in the psoas muscle there was a significant drop in the percentage of branching in
the adult (p<0.05), specifically between the adult (5.8+3.2%, 0.06+0.04) and each
fetal group (day 60-64 (27.0+£8.7%, 0.39£0.17), day 55-59 (28.5+16.8%, 0.51+0.48)
and day 50-54 (29.6+9.1%, 0.44+0.2)), as indicated on the graph. The differences in
the complexity of the adult fibres in the psoas and soleus can be seen in the 3D

reconstructions, shown in Figure 3.28.
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Figure 3.27 — Branching analysis of mitochondrial network by percentage of
segments >50 degrees. (A) and (B) show the results of percentage of segments
of reconstructed mitochondria network >50° for each age groups for the psoas
and soleus, respectively, (*) p<0.05. (C) Is the comparison between the two
muscle types for each group, (*) p<0.05.
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Adult
Soleus -

Figure 3.28 —Reconstructions of mitochondrial network from adult psoas
and soleus cells. (A) Single section from adult psoas and soleus muscle with
mitochondria segmented, light blue. (B) And (C) Shows the reconstructions of the
example shown in the single sections, with the segmented mitochondria, light blue
at different orientations. Scale bars 5um. Video:
https://doi.org/10.6084/m9.figshare.11973753.v1
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3.2.3. Individual Mitochondria Analysis

As described in the methods, individual whole mitochondria were segmented and
analysed via random selection from the same datasets used for the mitochondrial
network analysis. This allowed for average size as well as morphology of individual
mitochondria to be determined. Determining rate of individual growth in mitochondria
will indicate whether it is the number of mitochondria or size that increases the
mitochondrial volume during development. The volume and surface area were
extracted from each analysed mitochondrion, and average values for mitochondrial
surface area and volume obtained for each cell analysed, the results are shown in
Figure 3.29. There is an increase in mean surface area and volume of the
mitochondria in psoas and soleus (p<0.05). Specifically, there is significance found in
the psoas between all fetal groups and the adult for surface area (2.6+1.4uym? for
fetal day 50-54, 5.4+2.2 ym? fetal day 55-59, 5.9+1.6um? fetal day 60-64 and adult
9.4+2.7 ym?). For the volume significance is found between the adult group
(1.1£0.3um?3) and fetal day 50-54 (0.2+0.1um?) and day 55-59 (0.4+0.2um?3) and
between day 60-64 (, 0.7+0.3um?3) and fetal day 50-54. The soleus has significance,
in both surface area and volume, between fetal day 50-54 (2.3+0.5um?,
0.2+0.04pm3), day 55-59 (3.3+0.9 um?, 0.22+0.04um3), day 60-64 (5.2+2.2 ym2,
0.5+0.3 pym?3) and the adult group (9.8+3.9 um?, 1.2+0.6um?3).
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Surface area and volume of individual whole mitochondria. (A)

Figure 3.29 -

Show the results for the surface area and (B) the volume for the psoas muscle.
(C) and (D) are the results for the soleus muscle. Each point represents the

average measurement of the individual mitochondria (n) for each cell (N) and the
overall mean for the cell is represented by the bar. Significance is denoted as (*)

P<0.05.
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During the segmentation of individual mitochondria, the location of the mitochondria
was also noted. The mitochondria were divided by location and a similar analysis as
above was performed comparing the mitochondria based upon location. No
significant difference was seen in the comparison of volume and surface area, Figure
3.30, between the mitochondria at the different locations for both the psoas and
soleus. For all, except the psoas PN, there was significance found (p<0.05) for the

size of the mitochondria between the age groups, as detailed above.
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Figure 3.30 — Results of volume and surface area of whole mitochondria for

psoas and soleus divided by location. (A) And (B) results of volume and

surface area for the individual mitochondria for psoas (C) And (D) are the results
for the soleus muscle. Each point on all graphs is the average of the individual

mitochondrion (n) from each cell (N),
average is represented by a bar.

only including cells containing nuclei and the
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The individual mitochondria were analysed further using a classification system based
upon the morphology of the models. Through qualitative analysis it was found that a
mitochondrion could be divided into three categories based on the overall shape of
the mitochondrion, Figure 3.31. By analysing thousands of whole individual
mitochondria, three terms were decided upon to describe the shape, these are
‘column’, ‘spheroid’ and ‘irregular’. In transverse orientation the ‘column’ shaped
mitochondria stretch over a number of sections and are longer than they are wide.
‘Spheroid’ shaped mitochondria are as long as they are wide and appear round and
shaped like a ball. Any mitochondrion not found to fall into either of these two

categories was described as being ‘irregular’.

B ’C$ D
Spheroid q ‘ a a \;\)d .‘
Irregular ‘ ’ Eﬁ‘ \f{‘) 2}0

Figure 3.31 — Examples of shapes of mitochondria found. 3D
reconstructions of individual whole mitochondria from each of the age groups,
fetal day 50-54 (A), fetal day 55-59 (B), fetal day 60-64 (C) and adult (D) for
each of the shapes are shown. The column shape is characterised by
extending over multiple sections, in transverse orientation, and having greater
length then width. Spheroid mitochondria are round, will have a similar width
and length. Mitochondria that have an overall shape that does not fall into either
of these two categories are classified as irregular. Video:
https://doi.org/10.6084/m9.figshare.7159775.v2
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The results of the shape analysis for the psoas and soleus can be seen in Figure
3.32. Both the psoas and soleus were found to have different proportions of the three
shapes for all age groups (p<0.05). The primary shape seen in the psoas muscle is
the columnar shape, as seen in the fetal day 55-59 (86.1+9.5%), 60-64 (65.3£16.1%)
and adult (68.6£15.2%) age groups. This is significantly higher than the percentage
of irregular shaped mitochondria found in fetal day 55-59 (13.3+8.9%), fetal day 60-
64 (31.3£12.1%) and adult (29.3+14.9%). The spheroid shaped mitochondria formed
the lowest proportion in each group of psoas muscle (fetal day 55-59, 0.3+0.8%; day
60-64, 3.414.6%; adult, 1.3£1.4%). In contrast in the soleus muscle, there was no
significant difference found between the percentage of column and irregular shaped
mitochondria for fetal day 50-54 (column 50.7+31%, irregular 45+30.3%), fetal day
55-59 (38.7+28.1%, 52.7+17.4%) and adult (42.2+23.2%, 50.8+20.7%). The spheroid
shaped mitochondria again formed the lowest proportion in each group (fetal day 50-
54 4.3+2.8%, fetal day 55-59, 8.7+13.2%; day 60-64, 5.4+7%; adult, 7£5.5%).
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Figure 3.32 — Results from analysis of central shapes for individual
mitochondria for psoas and soleus. (A) And (B) show percentage of each
central shape present at each of the age groups for psoas and soleus
respectively. (C) Shows results from comparison between the central shape
proportion for each age group for the psoas and (D) for the soleus. Each point
represents the average measurement of the individual mitochondria (n) for each
cell (N) and the overall mean for the cell is represented by the bar. Significance is
denoted as (*) p<0.05.
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For ease of comparison between the psoas and soleus muscles data is re-presented
in Figure 3.33. This indicates for age group fetal day 55-59, day 60-64 and adult, that
there is a higher proportion of columnar shaped mitochondria present in the psoas
muscle than in the soleus (p<0.05). In contrast, there is a higher proportion of
irregular shaped mitochondria for fetal day 55-59, 60-64 and adult age groups in the

soleus muscle than in the psoas (p<0.05).
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(*) p=<0.05.
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The shape analysis for the psoas and soleus was also divided based on location,
shown in Figure 3.34 and 3.35. The results from the adult show a significant
difference between the percentage of mitochondria located at the IMF between
column (75.948.5%,) and irregular (21.9+8.8%). However, the mitochondria located
SS had a similar proportion of columnar (52.2+23.9%) and irregular (46.6+£22.3%). In
comparison, the soleus does not have any significant difference in the adult at the
IMF location for column (52.3+28.8%) and irregular (42.2+25%) or at the SS location
for column (32.41£20.5%) and irregular (55.8+27.4%). Similar results are seen at the
fetal day 50-54, 55-59 and 60-64 age groups, with similar proportion of each of the
shapes seen in each of the locations. However, there is wide variation present for all

age groups at all locations.
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Figure 3.35 — Percentage of central shapes divided by location for soleus
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The results for the branching analysis for psoas and soleus individual mitochondria
are shown in Figure 3.36 and the results from the comparison between the two
muscles is shown in Figure 3.37. Although, no significance was found in the one-way
Anova when comparing the age groups for both the psoas (and soleus), there is a
slight increase in mitochondria that are non-branching from fetal day 50-54 group to
the adult group for the psoas. A further test (paired T-test) showed significance
between branching and non-branching percentages for only day 55-59 for the psoas
and day 50-54 for the soleus (shown on the graph). When the psoas and soleus are
compared directly, significance is found in the fetal day 55-59 and 60-64 age groups
and the adult group is very close (p=0.057).
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Figure 3.36 — Results of the percentage of branching and non-branching
mitochondria for psoas and soleus. (A) Comparison between percentage of
branching and non-branching mitochondria in the psoas and (B) soleus. Each
point represents the average measurement of the individual mitochondria (n) for
each cell (N) and the overall mean for the cell is represented by the bar.
Significance is denoted as (*) p<0.05.
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adult (D). Each point represents the average measurement of the individual
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by the bar. Significance is denoted as (*) p<0.05.
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Results of the branching versus non-branching divided by location is shown for
psoas, Figure 3.38, and soleus, Figure 3.39. In the adult psoas there is a significant
difference between the branching and non-branching within the IMF. For the other
age groups, significance was only found in fetal day 55-59 between the PN located
mitochondria and the IMF and SS mitochondria. In the soleus, there is little difference
between the proportion of branching and non-branching at the different locations for
fetal day 55-59, 60-64 and adult age groups. Significance was found in the 50-54 age
group when comparing the IMF and SS with the PN mitochondria, but the number of
PN mitochondria analysed is far lower than for IMF or SS, and within the IMF and SS

groups.

Overall, each location for both the psoas and soleus shares similar results, with only
a few significant differences found for each shape and branching at each locations.
For both muscles, only a few PN mitochondria were found, limiting the results for that

location and the comparison between the PN to the IMF and SS mitochondria.
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Figure 3.38 — Percentage of branching and non-branching mitochondria
divided by location for psoas muscle. (A) Results for fetal day 50-54. (B)
Results for fetal day 55-59 (C) Results for fetal day 60-64 and (D) Results for adult.
Each data point represents the average pf the mitochondrion (n) from the cells (N)
analysed and the overall average by the bar. Significance is denoted as (*) p<0.05.
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Figure 3.39 — Percentage of branching and non-branching mitochondria
divided by location for soleus muscle. (A) Results for fetal day 50-54. (B)
Results for fetal day 55-59 (C) Results for fetal day 60-64 and (D) Results for
adult. Each data point represents the average pf the mitochondrion (n) from the
cells (N) analysed and the overall average by the bar. Significance is denoted as
(*) p<0.05.
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3.2.4. Nuclei Analysis

Not all of the SBF-SEM datasets contained a nucleus or a complete nucleus.
However, on occasions whole cell nuclei could be reconstructed (see Figures 3.40
and 3.41 for examples at each biological grouping for each muscle type). Therefore,
for the quantitative analysis, the nuclei were partially reconstructed along with the

corresponding cell volume to ensure consistent representation across all datasets.
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Fetal Day
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Fetal Day
60-64
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Figure 3.40 — Examples of whole and partially reconstructed nuclei for psoas
muscle for each age group. (A) Examples of reconstructions of entire nuclei at
two different orientations from each of the age groups. (B) Single sections showing
segmentation of the nuclei that were partially segmented, reconstructed (50
sections) and analysed, in magenta. (C) Shows the subsequent reconstructions of
the partial nuclei, magenta, and cell boundary, green. Scale bar 5um. Video:
https://doi.org/10.6084/m9.figshare.7166357.v2
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Figure 3.41 — Examples of whole and partially reconstructed nuclei for soleus
muscle for each age group. (A) Examples of reconstructions of entire nuclei at
two different orientations from each of the age groups. (B) Single sections showing
segmentation of the nuclei that were partially segmented, reconstructed (50
sections) and analysed, in magenta. (C) Shows the subsequent reconstructions of
the partial nuclei, magenta, and cell boundary, green. Scale bar 5um. Video:
https://doi.org/10.6084/m9.figshare.7166363.v2
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The results indicate that the volume of each individual nucleus is not significantly
different between the age groups for either psoas or soleus, Figure 3.42(A) and (B).
In the psoas, the volume is similar for the fetal day 50-54 (31.7+6.4um3), day 55-59
(30.7+17.4pm3), day 60-64 (41.8+10.6um3) and adult (39.2+20.9um?3). Similar results
were also seen in the soleus between the fetal day 50-54 (23.6+14um?3), day 55-59
(27.946.2um?3), day 60-64 (36.4+20.6um?) and adult (34.7+12.2um3). However, due
to the increase in cell size with development, the nucleus volume was also expressed
as a percentage of the reconstructed cell volume (same 50 sections), Figure 3.42(C)
and (D). The psoas results show a decrease in cell volume occupied by nuclei
volume from fetal day 50-54 (10.412.9%), day 55-59 (6.5+3%), day 60-64 (4.6+1.5%)
to adult (1.9£1.2%). The same is seen in the soleus with the percentage decreasing
between fetal day 50-54 (9.415.4%), day 55-59 (3.3+2%), and day 60-64 (3.8+1.8%)
to adult (1£0.43%). For both muscles this was found to be significant (p<0.05). With
further post hoc testing, significance was found between fetal day 50-54 and day 60-
64 and the adult group, and fetal day 55-59 and the adult group for the psoas. For
the soleus significance was found between fetal day 50-54 and all of the other age

groups.
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Figure 3.42 — Volume and percentage results of partially reconstructed
nuclei for psoas and soleus for all age groups. (A) Shows the volume of
partially reconstructed nuclei (50 sections) for each of the age groups for the
psoas and (B) for the soleus. Each data point represents a single nucleus
reconstructed, with bar indicating the average volume of nuclei for each age
group. The percentage of cell volume taken up by single nuclear volume, both
partially reconstructed (50 sections) is shown for the psoas (C) and soleus (D).

Each data point is a single nucleus, the average is indicated by the bar and the
significance denoted by (*) p<0.05.
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3.2.5. Summary

Overall, the results show that the development of the guinea pig skeletal muscle
mitochondrial network occurs in stages between foetus (mid- to late gestation) and
adult. There is an increase in size and number of mitochondria, preceding cell
growth, and by late gestation, the mitochondrial network occupies a similar area of
the cell as that seen in the adult. Indicating that by late fetal gestation the ratio
between mitochondria volume and cell size is determined. Distinct morphologies of
mitochondria were found in both skeletal muscles examined and across all age
groups. From this a morphological classification was developed so as to quantify the
shapes found for analysis. Branching of mitochondria is indicative of the rate of
fusion and fission and will differ based on functional requirements of the individual
muscle fibre. As such it was analysed in a portion of the mitochondrial network and in
the individual mitochondria reconstructions. Overall, from this analysis, it was found
that the differences in branching are only seen in the adult fibres and not in the fetal
age groups. These are all important factors to know to be able to understand the
development of the mitochondrial network, as a whole and in individual mitochondria.
As well as mitochondria a second important organelles were also analysed, the
nucleus. The analysis of the nuclei during the fetal stages, and when compared of
the adult fibres, shows that the nuclei maintain a similar volume during fetal gestation
and is similar to adults. Conversely the cell volume increases, and due to this the
percentage of cell volume occupied by the nucleus decreases from the earliest fetal
group and into the adult group. As with the mitochondria results, this analysis
indicates stages in the development of the muscle fibre associated with the nuclei. All

of this, mitochondria and nuclei results, are further discussed in the Chapter 4.2
(pg192).

178



Chapter 4. Discussion
In this project SBF-SEM has been used to study morphological features of two
distinct biological tissues, the locust lobula and guinea pig skeletal muscle. From this
novel information was found for both tissue types. The following discussion
summaries the findings and speculates on potential biological impact or function, as
well as discussing the application of SBF-SEM to tackle two different types of

experiments and tissue types.
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4.1. Locust

4.1.1. Summary

A branch of the LGMD 2 neuron was identified, based upon its location (Leitinger and
Simmons, 2000, Rind et al., 2016), subsequently imaged and analysed within an
area of the lobula, 48 by 48 by 30um? (x by y by z). This is the first time such a
detailed analysis of the LGMD 2 neuron branches have been performed. In particular
it is the first time the complete arborisation of each TmA neuron as it synapses with
the LGMD 2 neuron has been revealed, along with the path neighbouring TmA
neurons synapsing with the LGMD 2 neuron take through the lobula. All the
synapses along the length of specific LGMD 2 neuron branches were noted and the
TmA neurons followed and reconstructed through the whole dataset. From this the
following conclusions were made. The TmA neurons synapse upon the LGMD 2
neuron branches in an organised manner, each covering a certain area of the LGMD
2 neuron. This ensures that there is retinotopic mapping onto the LGMD 2, that
preserves the mapping according to the position of its input facet in the locust eye.
Each TmA neuron has two post-synaptic targets, another TmA neuron and the
LGMD 2 neuron. The paired reciprocal synapses between TmA neurons and the
LGMD 2 neuron occur back-to-back with one another and share a common synaptic
cleft. Because of these reciprocal synapses with other TmA neurons, onto the LGMD
2, the TmA neurons form a network over the LGMD 2 neuron branches. Each TmA
neuron has been shown to synapse upon the LGMD 2 neuron within a certain
volume and mainly on a single branch. The TmA neurons found to synapse onto
multiple branches, no more than 4, were shown to have a primary branch on which
they synapse. The majority of TmA neurons form connections with multiple other
TmA neurons, often more than once, and synapse multiple times onto the LGMD 2
neuron. Within the neurons a small proportion were found to have a higher number of
synapses and synaptic partners and cover a larger portion of the LGMD 2 neuron,
when compared to the other TmA neurons. These neurons were termed hub neurons
and are highly connected and vital for ensuring that the network is fully connected.
Without these hub neurons, non-connected islands of TmA neurons form and some
lose their only synaptic partner. The hub neurons and their associated connectivity
are a new find, within the TmA neuron to LGMD 2 neuron system. A summary of this

is seen in the Figure 4.1.
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Figure 4.1 — Summary diagram of TmA interaction onto the LGMD 2
neuron. The schematic shows how from a single stimulated facet an area of the
LGMD 2 neuron can be stimulated. The colour of the facet (red, green and
yellow) is the same as the TmA neurons associated with it. TmA neurons,
originating from the medulla (red, yellow and green) travel into the Lobula and
synapse upon the LGMD 2 neuron branches (blue). There is an example of a
hub neuron (red), showing how they synapse multiple times onto multiple
branches of the LGMD 2 neuron. The direction of synapsing is indicated by the
coloured, each TmA neuron has two post synaptic targets, the LGMD 2 neuron
and a second TmA neuron. By mapping these connections an idea of the
network in the Z direction (up-down black arrow) and in the X and Y direction
(left-right black arrow) was determined.
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4.1.2. Synaptic Density

The results of the analysis of synaptic density over the LGMD 2 neuron branches is
consistent with previous work on other neurons within the locust nervous system
(Killmann et al., 1999, Watson and Burrows, 1985) and the LGMD 1 neuron (Rind
and Simmons, 1998, Rind et al., 2016) and LGMD 2 (Rind et al., 2016). The highest
density found in this dataset is not yet at the mean found in previous studies (Rind et
al., 2016). However, the branch and sub-branches analysed here are from a thicker
portion of the LGMD 2 neuron closer to the protocerebrum and the beginning portion
of the synaptic area of the LGMD 2 neuron. The synaptic density was higher on the
smaller sub-branches extending from the branch analysed, as expected based on
what is known. As found here the synaptic density increases on the thinner

processes of the LGMD neurons closest to the medulla.
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4.1.3. The TmA Neuron Network

Previous studies followed the TmA neurons but not over the same distance as
performed here. By reconstructing the full length of a TmA neuron’s arborisation,
where possible, the identity of TmA network pairs at the synapses onto the LGMD 2
neuron was found. By following the TmA neurons through the dataset, originating
from synapses onto the LGMD 2 neuron, identifying the TmA neuron pairs has
allowed for quantification and analysis of the TmA neuron connections, both to other
TmA neurons and the LGMD 2 neuron. The complete TmA neurons, as defined by
tracing throughout the dataset and consisting of all the terminals of the TmA neurons,
were found to form a complex network over a series of branches of the LGMD 2, not
previously shown structurally before. The identification of a TmA neuron network and
of hub TmA neurons are new observations and are currently unique to the LGMD 2
neuron. Their implications for connectivity have been shown here for the first time.
This connectivity may be crucial to detect looming stimuli, because with looming
stimuli, image edges can move out over the eye in many directions simultaneously.
The detail necessary to reveal this organisation was only possible using long series
of consecutive sections. No alternative methods, apart from consecutive ssEM, could
have revealed such a connectivity network maintained by hub neurons, and it has not

been seen elsewhere in the animal kingdom.

There is known to be a retinotopic map preserved from the facets of the locust eye,
through the TmA neurons and onto the LGMD 1 neuron branches (Rowell et al.,
1977, Rind and Bramwell, 1996, Rind and Simmons, 1998, Krapp and Gabbiani,
2005, Peron et al., 2009, Rind et al., 2016, Zhu and Gabbiani, 2016), with a facet
being associated with a TmA neuron and a specific portion of the LGMD 1 neuron.
However, it was not known whether TmA neurons synapsing upon the LGMD 2
neuron also maintained retinotopy from the eye and how fine any retinotopy may be.
The organised nature of the network found and seen within the reconstruction
supports the preservation of the retinotopic map from the facet onto the branches of
the LGMD 2 neuron. Using this principle and results from previous studies (Rind et
al, 2016) allows for estimations on the nature of the facet to TmA neuron relationship.
Previous estimations suggest that the number of synapses on the LGMD 2 neuron
per facet is at maximum 23 and the maximum number estimated for TmA neuron
synapses is 42 (6 synaptic partners up to 7 times) (Rind et al, 2016). From this it was
suggested that TmA neurons from a facet will interact with up to 6 TmA neurons

associated with the neighbouring facets. In comparison, the results from this study for
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total number of synapses per TmA neuron the median number is 7, with 5 unique
synaptic partners meaning they synapse with the same partner at least twice (the
upper range extends up to 26 for total synapse number and up to 13 for synaptic
partners). This coincides with the previous results, which found TmA neurons
synapsing onto the LGMD 2 to have up to 6 different synaptic partners (Rind et al.,
2016). In Rind et al, (2016), by dividing the scaled total number of synapses by the
number of facets, it was calculated that each facet is associated with an estimated 23
synapses upon the LGMD 2 neuron. Combining this with the findings from the
dataset analysed here, that each TmA neuron has an average of 8 synapses, it
suggests that up to three TmA neurons are linked with a single facet. These TmA
neurons will most likely interact primarily within the facet, with some interaction with

the neighbouring facets, this is shown in Figure 4.1.

Although, as shown in the results, a sub-type of TmA neuron is distinct in that it
synapses above the average number of times and with a high number of different
synaptic partners, termed hub neurons. The small group has a median of 18
synapses and up to 9 synaptic partners, whereas the non-hub TmA neurons have 5
synapses and 4 synaptic partners. Both the hub and non-hub TmA neurons extend
past their own facet and interact with TmA neurons associated with neighbouring
facets, but the hub neurons extend much further than the majority of TmA neurons.
This relationship between neighbouring facets gives rise to possible scenarios in
regard to, distribution of TmA neuron. Firstly, that for each facet there is an
associated hub neuron and 2 non-hub neurons, with the two non-hub neurons
synapsing mainly within their facet, the majority of synapses outside the facet made
by the hub neuron. The other possibility is that only a proportion of facets are
associated with a hub neuron and a small number of non-hub neurons. The
remaining facets would only have non-hub neurons, with an equal share of synaptic
activity. This is the most likely option suggested by the results here. A large number
of facets are represented in this dataset, by the large number of TmA neurons
present. However, there are only a small number of hub neurons, and the majority of
the non-hub neurons have equal weighting, meaning they synapse the same number

of times onto the LGMD 2 neuron and have the same number of synaptic partners.

These hub neurons were also found to be highly connected in the X and Y direction.
The majority of the hub neurons synapse on more than 1 branch of the LGMD 2

neuron. It is known from calcium imaging during localized visual activation that the
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TmA neurons upon the LGMD 1 neuron map the retina in two directions, both along
the dendrites and across neighbouring dendrites (Zhu and Gabbiani, 2016, Jones
and Gabbiani, 2012, Fotowat and Gabbiani, 2011, Jones and Gabbiani, 2010). In the
current study a small proportion of the TmA neurons were found to synapse onto
other LGMD 2 neuron branches, when followed through the dataset, shown in Figure
4.1. Thus, a single TmA neuron, associated with a facet, has the potential to not only
synapse onto one LGMD 2 neuron branch but onto multiple branches. The majority
of the neurons synapse onto a single branch so there is a possibility that the TmA
neurons that synapse onto multiple branches are a sub type of TmA neuron. The
network observed in the Z direction from the primary branch is also observed across
the other branches and there is an additional network that links the branches via the

TmA neuron to TmA neuron interaction.

Recent studies using calcium and fluorescence imaging have shown that when a
single facet is stimulated there is excitation onto multiple non-associated branches
(Zhu and Gabbiani, 2016). In the same study they presented overlapping areas of
excitation along the LGMD 1 neuron, when neighbouring but distinct facets were
iluminated. This suggests that TmA neurons from one facet potentially cover a larger
area and associate with TmA neurons outside their respective facet. This agrees with
the structural evidence shown in previous studies and presented here. The calcium
imaging (Zhu and Gabbiani, 2016) was performed on the LGMD 1 neuron and the
structural evidence presented here is from the LGMD 2 neuron, so this means that in
both the LGMD 1 neuron and in the LGMD 2 neuron, TmA neurons can have an

influence on the excitation pattern of their neighbours.

Both LGMD neurons function similarly, albeit with different preferences, the LGMD 2
neuron to dark objects. Any differences would be seen at the medulla level, where
the ON and OFF circuitry is thought to differ between the two neurons (Gerd
Leitinger, personal communication). The other differences between the LGMD 1
neuron and LGMD 2 neuron is the action of inhibition, the LGMD 1 neuron has a
direct inhibitory GABAergic input onto the dendritic sub-fields B and C, whereas it is
thought that in the LGMD 2 neuron inhibitory GABAergic neurons may synapse upon
the TmA neurons instead (Rind et al 2016).

Overall, the hub neurons are highly connected within the TmA neuron network. They
are located around areas of branching along the LGMD 2 neuron volume, areas

which have high synaptic density, such as near or around small processes. As
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mentioned, they are required for the network to be fully connected. The maijority of
the non-hub neurons are connected to a hub neuron directly, or indirectly via shared
TmA neuron partner. It is these hub neurons that would cause the overlap in
excitation and the wider spread of excitation, down a branch and across multiple

branches

Knowing the structure of the TmA neuron network and the patterning of synapses
onto the LGMD 2 neuron is needed to understand the function of the network. The
structural analysis has revealed the presence of the hub neurons. Previously it was
thought that all TmA neurons had a shared weight in the integration of the signal onto
the LGMD neuron branches (Rind and Bramwell, 1996). However, the hub neurons
have a higher proportion of synapses within the TmA neurons, suggesting that not all
TmAs are equal. The impact of this functionally requires further investigation but
some assumptions can be made based on what is known already about the network.
It is known that the TmA neurons are excitatory upon the LGMD 2 neurons, but the

interaction between TmAs neuron is debated.

Based on structural evidence and calcium imaging studies (detailed above) when a
facet is stimulated the area of the LGMD neuron excited extends past the area
covered by the facet, both in up-down (along a branch) and right-left (across
branches). This spread of the excitation is most likely caused by the action of hub
neurons and their lateral connectivity onto neighbouring TmA neurons. If every facet
has an associated hub, regardless of which facet is stimulated the resulting spread of
excitation would be the same. A stimulation of multiple facets associated with hub
neurons would result in a larger driving force. As more facets are stimulated the
LGMD neurons will reach the threshold, with the minimum number of facets required.
The overlapping and extensive coverage by the hub neurons will extend the signal
across the dendritic field. So that once the number of facets needed for signal
propagation has been reached the LGMD neuron is close to the threshold, easily
excitable and the progression of the signal is rapid. If there were facets that do not
have a hub TmA neurons, the resulting stimulation would be lessened and would

require number of facets to be stimulated to produce the downstream signal.

However, as hub neurons are interspersed throughout the network in an organised
way, ensuring that each TmA neuron is connected either directly to a hub, the most

common, or via a shared synaptic partner. The majority of the TmA neurons were
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found to be directly connected to a hub, indicating that the stimulation may extend

further as a result.

The nature of the interaction between the TmA neurons is debated and it not known
whether it is inhibitory or excitatory. It is known that there is a form of cross
communication between the partnering TmA neurons at a synapse (Rind and
Simmons, 1998, Rind et al., 2016, Zhu et al., 2018). Inhibition was proposed in the
model of the LGMD 1 neuron (Rind and Bramwell, 1996), and is now thought to
sharpen the signal in response to stimuli rather than stop the signal (Rind et al.,
2016). Although still under debate, a recent publication provides evidence for the
presence of excitatory acetylcholinergic receptors on the TmA neurons (Zhu et al.,
2018), but does not provide evidence against the presence of inhibition occurring but

suggests it is weak.

This connectivity between TmA neurons could be a modulation system to control
signal propagation. Without enough of the hub neurons stimulated, excitation of the
non-hub TmA neurons would not be strong enough to generate a propagating signal
in the LGMD 2 neuron. For this, enough facets would need to be stimulated to ensure
a hub neuron is stimulated. As facets are stimulated the TmA neurons become
excited and at the same time potential inhibition occurs between the same neurons. If
a large number of the TmA neurons, including hub neurons, are excited then the
signal will be propagated at the LGMD 2 neuron level. However, if not enough hub
neurons are stimulated, the inhibition across the TmA neuron network will overcome
the excitation from TmA neuron to LGMD 2 neuron. The hub neurons connect with a
larger number of TmA neurons and would inhibit the excitation of the TmA neurons of
neighbouring facets. However, if these neighbouring facets are also stimulated, as a
looming object covers more of the eye field, this would overcome the inhibition

received from the hub neurons.

In contrast, if the TmA neuron to TmA neuron connection was excitatory, and a
lateral inhibition between the TmA neurons happened further upstream in the
medulla, then the excitation of hub neurons would help increase the signal so that the
LGMD 2 neuron is able to distinguish between approaching and passing objects
more quickly. This would help to explain how the collision detection network is rapid
and allows for a quick response as soon as the stimulus reaches a threshold angular
size (covers enough of the facets). The LGMD 2 neuron will be partially excited by

the action of the TmA neuron network, causing a spread of excitation in all directions
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via the reciprocal TmA neuron to TmA neuron synapses. Leading the LGMD 2
neuron into an easily excitable state, so that as soon as the threshold is reached it

causes a signal resulting in a rapid response.

Regardless of whether the TmA neuron to TmA neuron interaction is inhibitory or
excitatory, for the threshold to be met at the LGMD 2 neuron level, the action of
excitation has to be stronger and faster than that of the rate of inhibition. Inhibition
alone between the TmA neurons may not be enough to do this. The LGMD 1 neuron
has a specific dendritic field that receives inhibitory inputs directly and the LGMD 2
neuron indirectly, via action upon the TmA neurons and not the LGMD 2 neuron
branches. As the LGMD 1 neuron and LGMD 2 neuron each have several
mechanisms for inhibition understanding these require further experimental and

modelling work and is discussed in Chapter 4.1.5. Future Work (pg190)
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4.1.4. Conclusion

Overall, the structural analysis of the LGMD 2 neuron performed here supports
results from previous studies of the TmA neuron inputs onto the LGMD neurons.
Understanding the network that forms, due to the reciprocal nature of the synapses in
the locust and other insects, is of importance. The presence of excitation (and or
inhibition) adds complexity to the computation of the signal, prior to synapsing onto
the LGMD neurons. The results from this structural study of the TmA neurons also
shows why this type of analysis is important and needed. By being able to elucidate
the organisation of the network, it is possible to understand how the signal is
integrated across the dendritic field and also the computation that the TmA neurons
undergo. This is of particular interest as the majority of studies mentioned use

calcium imaging, which is a coarse form of imaging and lacks high specificity.

This type of experiment is novel, in that it has only been performed on the LGMD 1
neuron. Previous work on the LGMD 2 neuron using SBF-SEM is also limited in the
size of the dataset analysed (Rind et al., 2016) and for this dataset a different
analysis approach was applied. By following the TmA neurons throughout the dataset
the pattern of their synapsing onto the LGMD 2 neuron and their respective partners
could be mapped, and various insights have been gained based upon the results of
this analysis. The identification of a TmA neuron network and hub TmA neurons are
new findings, currently unique to the LGMD 2 neuron. Their connectivity may be
crucial for the collision avoidance pathways in the locust. Only 3D-EM imaging
methods allow for the 3D imaging at high resolution required to reveal the
organisation of neurons and the connectivity network maintained by hub neurons.

This has yet to be shown in other species.
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4.1.5. Future Work

There are a number of possibilities for the distribution of these neurons that requires
further analysis. These hub neurons could either be placed throughout the dendritic
field of the LGMD 2 neuron at equal distances along the dendrites or concentrated in
areas of thinner processes. However, in this portion of the dataset where the LGMD
2 is still relatively large in comparison to the thinner neurites closer to the medulla, it
cannot be determined by which of these conditions the ‘hub’ neurons are organised.
Further work is required into the ‘hub’ neurons, to not only determine their spatial
organisation but whether they are a real sub-type of the TmA neuron and not due to

the spatial sampling limitations of the technique (discussed in the main discussion).

A lot more information can be garnered from the dataset collected. The analysis
performed could be continued, focusing on the other branches of the LGMD 2 neuron
and their afferent neurons. The other branches are only briefly analysed in this study
and by repeating the analysis could test whether the pattern seen is replicated on
multiple branches. A similar analysis should also be repeated on thinner branches
closer to the medulla. The distribution of synapses is thought to increase as the
branches get thinner (Rind et al., 2016). The next step would be to determine the
circuitry of the afferent neurons at the thinner branches, to see whether the pattern
found here is maintained over the branches or changes. This could be important for
understanding the integration of the signal and the speed at which it occurs. To
determine whether the patterning differs in the thinner branches closer to the origin of

the afferent neurons from the medaulla.

Differences between the inputs to the LGMD 1 and LGMD 2 neurons may only be
observable in the medulla region. In other insects the ON and OFF signals are
transmitted via separate motion detecting neurons (Joesch et al., 2010, Takemura et
al., 2011, Shinomiya et al., 2019) The LGMD 2 neuron has a preference towards
darker objects, via the OFF path from the eye. Both the ON and OFF paths will
connect with TmA neurons, directly or potentially indirectly. However, once the TmA
neurons are stimulated they follow the same path through the chiasm and into the
lobula, regardless of whether it is connected with the ON or OFF paths within the
medulla. This means that within the lobula there may be minimal difference in the
TmA neuron interaction between the two LGMD neurons. Widening this type of study
to include the medulla would answer this question. Such as attempting to image from

the medulla and into the lobula within the same dataset using SBF-SEM.
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Other types of neurons that can be identified in the dataset are inhibitory neurons.
The inhibitory GABAergic neurons in the locust can be identified by a darker
cytoplasm and pleiomorphic vesicles (Rind and Simmons, 1998). Although the
resolution in the dataset is not high enough to visualise the shape of the vesicles in
the pre-synaptic neurons. The action of GABAergic inhibition is unknown in the
LGMD 2 neuron. As mentioned, in the LGMD 1 there are inhibitory inputs onto the
sub-fields of the dendritic tree (Rind and Bramwell, 1996, Gabbiani et al., 2005) but
the LGMD 2 neuron dendritic tree differs in structure and does not have these sub-
fields (Simmons and Rind, 1997, Rind et al., 2016). The inhibition onto the LGMD 2
neuron must then occur either directly onto the afferents, to stop the signal, or onto
the LGMD 2 neuron, to reduce excitation. Preliminary analysis of the GABAergic
neurons within the dataset has been performed. What was found was evidence of
GABAergic neurons partnering with an afferent neuron to synapse onto the LGMD 2
neuron directly or to synapse onto the afferent neurons themselves. The presence of
these two forms of potential GABAergic inhibition would impact onto the signal

integration.

Currently only a portion of the dataset has been analysed so far in regard to the
location and structure of the inhibitory neurons that can be identified. The
combination of labelling and other imaging methods would also be beneficial for
studying the inhibitory neurons further. One such method would be through
immunolabelling of receptors present in the neurons, in this case GABA receptors.
Immunogold labelling has been routinely used in EM studies (Hainfield and Powell,
2000). However, it is not yet widely used in combination with 3D-EM techniques and
as such would require extensive testing and optimisation to combine immunogold
labelling with SBF-SEM. In principle the GABAergic receptors could be labelled with
Nanogold particles, either pre or post embedding on slices of the sample. It would
then undergo an altered EM staining protocol, to allow for visualisation of both the
labelling and tissue on the SBF-SEM. With this the inhibitory neurons and synapses
would be mapped and further understanding on the role of the inhibitory network
specific to the LGMD 2 neuron. Once developed, this type of method could be
replicated to study other receptors within the lobula, such as the acetylcholine

receptors precent on the TmA neurons and the LGMD neurons.
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4.2. Skeletal Muscle

4.2.1. Summary

The principal aim of these experiments was to examine the nature of, and any
differences in, mitochondrial volume, sub-cellular localisations and morphology
during guinea pig skeletal muscle (psoas and soleus) development between fetal and
adult age groups. The underlying perspective was that any changes noted may
reflect the changes in muscle function occurring during the establishment of a mature
contractile phenotype in adulthood. To do so SBF-SEM datasets were taken of psoas
and soleus muscle cells, in transverse orientation, at 3 different time points in fetal
gestation and from adult guinea pig. Datasets for 48 individual cells were collected,

for between 250 to 300 sections, resulting in around 220GB worth of raw data.

From the datasets the following observations were made. The mitochondrial density
increases during fetal development, and by the late fetal stage the density is similar
to that found in the adult group, even though the volume of the cell does not differ
greatly between the fetal age groups. The mitochondrial network branching was also
analysed. Differences were only found between the adult psoas and soleus groups
and not the fetal groups. Size and morphology of each identified mitochondrion were
analysed. There was an increase in surface area and volume across the fetal groups
with the late fetal group similar to the adult for both muscles. From the
reconstructions three distinct morphologies were found across all age groups and in
both muscles, termed columnar, irregular and spheroidal. The branching of the whole
mitochondria was also analysed. Again, the only difference was found between the
psoas and soleus in the adult group. The location of the mitochondria was also
mapped. An increase in the proportion of SS located mitochondria was seen between
the fetal groups and the adult psoas and soleus. Although the location was found not

to impact the size and morphology of the mitochondria.

On a number of occasion nuclei were also found in the datasets collected, due to the
multi nucleated nature of skeletal muscle cells. As such, analysis of the nuclei over
development was also performed. It was found that volume of the nucleus does not
differ greatly between the fetal groups and the adult group for both muscles, even as
cell size increases (increasing the ratio of cell to nuclei volume as the muscle cells

mature).
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4.2.2. Mitochondrial Volume, Surface Area and Location

During development, the volume of a muscle cell and mitochondrial network will
increase. Due to their importance in the homeostasis of metabolically active cells,
such as skeletal muscle, the total mitochondrial volume should increase in parallel
with cell growth. However, during gestation the relationship between mitochondria
and cell growth is non-linear. As fetal age increases the density of mitochondria per
cell volume increases and then stabilises between late fetus and adult. Although an
increase in cell volume is only seen between the late fetal stage and adult groups.
This occurs even as the volume and surface area of the individual mitochondria show
an increase over development for both muscles, with a sharp increase between fetal
day 60+ and adult.

When the results from the mitochondrial density and individual size of mitochondria
are combined, the developmental pattern of the mitochondrial network can be
determined. Prior to late gestation (day 60-64) there is a steady growth in
mitochondrial size and an increase in mitochondrial density. However, the increase in
individual mitochondria size from day 55-59 to day 60-64 does not account for the
sharp increase in mitochondrial density between the same age groups. This suggests
there could be an increase in proliferation of mitochondria, so that increased
mitochondrial number rather than size contributes to the increased mitochondrial
density in the later stages of fetal development. As there are no studies looking at
mitochondria size or number over development, it would be of interest to determine if
this is the case, using light microscopy methods that can image and track

mitochondria in live cells.

Thus, development of the mitochondrial network appears to undergo a shift between
days 55-59 and 60-64, being well-developed and similar to the adult by this later
stage in gestation. This could be explained by a change in activity of the fetal guinea
pigs. Movement of guinea pig pups in utero increases up until around day 60
gestation. At this point there is a reduction in activity due to the development of
sleeping behaviours, more time spent in rest and lack of room in the amniotic sac
(van Kan et al., 2009). At birth, guinea pig pups have a well-developed muscular and
nervous system, with the in utero development being akin to human gestation (Dyson
etal., 2012).

When the mitochondrial density was assessed by location, it was found that a higher

proportion was found sub-sarcolemmal in the adult than in the fetal groups. As there
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was no significant difference found between the location and surface area and
volume for the individual mitochondria across all age groups, it suggests that the
increase in percentage is due to an increase in number of mitochondria located SS,
not by an increase in their size. It is uncertain as to why there is an increase in
mitochondria in the SS as the muscle develops. One possibility is that the increase in
size and number of mitochondria occurs in the middle of the cell, forcing the
mitochondria to the periphery to occupy the free space as biogenesis of larger
mitochondria increases. It is unknown whether the increase in size of individual
mitochondria is due to fusion of mitochondria already present or the biogenesis of
larger mitochondria. This could only be determined by tracking the development of

individual mitochondria in vitro.
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4.2.3. Branching and Shape Analysis of Mitochondria

From the earlier SBF-SEM experiments different morphologies of individual
mitochondria has been noted. One question that arises is what changes in
morphology and complexity, if any, occur over development within the two different
muscle types? The qualitative analysis of the morphology devised in this study is the
first to do so thoroughly based on 3D-EM data. There have been previous studies
highlighting changes in human muscle focusing on known morphological changes
due to stress or in the cases of disease, donut-shaped mitochondria, and nanotunnel
formations (Vincent et al., 2019, Vincent et al., 2017, Vincent et al., 2016). The shape
analysis presented in this work on guinea pig skeletal muscle indicates the presence

of common mitochondrial morphologies across muscle type and age.

The results show that the majority of the mitochondria for both the psoas and soleus
fall into the column or irregular categories. There is also the consideration of how
mitochondrial shape or branching may change with development. For the psoas
there was no significance found in fetal day 50-54 in the percentage of column or
irregular. Then for fetal day 55-59 and day 60-64 there was a higher percentage of
column mitochondria than irregular, similar to the results seen in the adult group.
Therefore, in the mature psoas muscle column mitochondria is the predominant
shape type. In contrast, in the soleus muscle there was no significance found in
either fetal day 50-54, day 55-59, day 60-64 or adult between the percentages of
column and irregular shaped mitochondria. Although there was a slight majority in
irregular shaped mitochondria. Thus, changes in mitochondrial shape are noted

during psoas muscle development that are not apparent in soleus muscle.

In comparing the two skeletal muscle types in adulthood, it was found that the psoas
had a higher amount of column shaped mitochondria than the soleus, and the soleus
a higher amount of irregular and spheroid shaped mitochondria. For all age groups
the spheroid shaped mitochondria made up the smallest proportion of the
mitochondrion. The full biological meaning of these tissue type-specific proportions of
mitochondrial shape remains to be resolved. Although these simple spheroidal

mitochondria have been found more in cases of disease (Vincent et al., 2019).

From the shape analysis there was no difference seen between the IMF and SS
locations in the soleus for all age groups. For the psoas a difference was noted
between the IMF and SS locations for the adult and none of the other age groups.

The IMF had a higher percentage of column shaped mitochondria and the SS had a
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higher percentage of irregular shaped mitochondria. There was only a small number
of mitochondria segmented that were located at the PN so the results for that location
are varied and explains why there was a number of differences found between the
PN mitochondria and the other locations. Due to differences metabolically the
mitochondria can be treated as sub-populations, it is posited that they develop
separately but through the process of fusion and fission the two populations integrate
and connect (Hood and Igbal, 2013, Picard et al., 2013, Dahl et al., 2015). There is
also evidence found in the results here to suggest that the two sub-populations

develop separately from one another.

The branching of the mitochondrial network and of individual mitochondria was
analysed. From the network analysis, the soleus shows a similar percentage of
branching (protrusions extending off from a single mitochondrion) for all age groups
and the psoas across each fetal group. However, the cells from adult psoas have a
significantly smaller percentage of mitochondrial segments above the threshold,
suggestive of reduced branching and less complexity. For the individual
mitochondria, the psoas has a higher percentage of non-branching mitochondria from
fetal age day 55-59 to adult. Whereas the soleus at fetal day 50-54 has a higher
proportion of non-branching, which switches to branching by the adult group. Again,
there are no studies that have measured the rate of fusion and fission in mammalian
skeletal muscle over development, so as to determine whether the shift in branching

is due to alterations in the balance between fusion and fission.

As shown in the results mitochondria are malleable and the complexity and shape of
the mitochondrion is dictated by the action of fusion and fission and the balance
between these two processes. A balance is maintained to ensure a steady state of
morphology, mtDNA and metabolic mixing and bioenergetic functions and organelle
number (Griparic and van der Bliek, 2001). An imbalance has been noted to lead to
shifts in morphology and impacts cell vitality (Palmer et al., 2011). Fission is the
division of the organelle, and, if unregulated, leads to heterogeneous distribution of
MtDNA, variations in ATP production, an increase in the presence of the reactive
oxygen species and an increase in the likelihood of apoptosis (Parone et al., 2008). It
also removes old or damaged mitochondria, by dividing the organelles into small
enough portions to undergo mitophagy by lysosomes (Kim et al., 2007). Fusion aids
in maintaining a homogenous population. There is a large amount of information

regarding the dysfunction of fusion and fission related to disease and in studies
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discovering the regulatory mechanism of fusion and fission. However, there is very

limited studies on the role of fusion and fission over development.

The shape of the mitochondria will have a direct impact on the function of the
organelle. The limitation in this study and in previous is that the 3D data presented
here is not combined with functional tests. Previous functional studies are limited as
they do not image the mitochondria in 3D to map the mitochondrial network shape or
at the resolution to determine the shape of individual mitochondria. However, a
recent review paper has compiled evidence from various studies to suggest potential
functional impacts. Elongated mitochondria have an increased surface area which
facilitates interaction with the environment (Glancy et al., 2020). Elongation of
mitochondria was found in proliferating fibroblasts (Yao et al., 2019) and in skeletal
muscle cells in aged mice (Leduc-Gaudet et al., 2015). Elongated mitochondria also
have an increase in oxidative capacity and can protect cells against cell death
(Gomes et al., 2011). On the other hand, more compact mitochondria might have a
more optimal volume for internal functional capacity. On the other hand, more
compact mitochondria are found in quiescent cells (Yao et al., 2019) and the action
of fission, required to for mitochondria to shift from elongated to compact, is needed
for apoptotic signalling (Youle and Karbowski, 2005). Highly branched mitochondria
have a larger surface area, resulting in a better exchange of calcium and other ions
and metabolites, and an increase in interaction with their environment and long-
distance communication (Bleck et al., 2018, Glancy et al., 2020) although it comes at

a large cost of removal.

How this relates to the results found in this study are as follows. The adult psoas
muscle fibres had a higher proportion of elongated mitochondria, columnar shaped,
compared to the soleus, which allows for a greater interaction with other organelles
within the cell and the environment. Whereas the more compact mitochondria found
in the adult soleus would have a higher volume for internal functional capacity. The
soleus fibres were found to have a higher amount of branching than the psoas, which
counteracts the deficit from having a higher proportion of compact mitochondria. Both
elongated and branching mitochondria allow for communication over long distance
and between the mitochondria and their surrounding environment. This long-distance
communication is vital for muscle cells, regardless of fibre type, for uniform
contractions to occur. As to why the two muscle types favour one potential

mechanism for ensuring communication throughout the cell is not known.
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Fusion and fission are driven by the requirements of the muscle, directly related to
function. This is in turn related to the fibre type. Thus, the shapes and complexity of
the mitochondria discussed above will be directly related to the fibre type and the
functional requirements of the muscle. Using parameters from previous studies and
the results found here an attempt at identifying fibre type in the fetal and adult cells

analysed has been made.

For the fetal age groups the results are similar between the two muscles from the
earlier to late gestation stages. This coincides with evidence from studies of
expression during gestation in mice and rats. Prior to embryo day 16 (in mice and
rats), the muscle fibres (including soleus, extensor digitorum longus, anterior tibial
muscles and the myotome found in embryos) in these mammals express both
proteins associated with primary fibres (Myosin Heavy Chain —neo and —emb), as
well as fast and slow isoforms (Condon et al., 1990a, Lyons, 1990, Narusawa et al.,
1987, Niro et al., 2010, Wang et al., 2015). Later in development there is a loss of
slow myosin expression, coinciding with the beginning of neural innervation (Lyons,
1990). Thus, differentiation of the muscle fibres only starts to occur close to birth
(Zhang et al., 1987, Condon et al., 1990a, Condon et al., 1990b, Lyons et al., 1990,
Narusawa et al., 1987, Niro et al., 2010, Wang et al., 2015, Schiaffino and Reggiani,
2011). Therefore, for the fetal age group no specific fibre type for any of the cells

analysed was found.

From previous imaging studies, slow twitch fibres appear to be abundant in
mitochondria and these mitochondria have been shown to have a high degree of
branching (Kayar et al., 1988, Ogata and Yamasaki, 1997, Picard et al., 2012,
Fujioka et al., 2013, Mishra et al., 2015, Bleck et al., 2018). From previous fibre type
identification (Peter et al., 1972, Gollnick et al., 1974, Soukup et al., 2002) the cells
analysed from the soleus muscle are most likely to be slow twitch fibres. The higher
proportion of branching in the network and individual mitochondria found in this study
coincide with results from previous studies on slow twitch muscle mitochondria
morphology. All this evidence suggests that it is highly probable that the cells

analysed from the soleus are slow twitch.

On the other hand, the fast twitch fibres are less dense in mitochondria, have a lower
percentage of branching (Ogata and Yamasaki, 1997, Picard et al., 2012, Mishra et
al., 2015) and are more string-like, extending through the muscle fibre (Fujioka et al.,

2013). The psoas muscle is more complicated due to the combination of fibre type
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shown previously (Johnson et al., 1973, Parkkola et al., 1993, Arbanas et al., 2009).
Although when the results are compared to the soleus, lower complexity and smaller
number of branching mitochondria are found. In alignment with fibre morphology from

past studies the results are indicative of primarily fast twitch fibres.

An overall summary of the differences found between the adult muscle types and
potentially in relation to their fibre type is shown in Table 4.1. However, the muscle
fibres can be homogenous or heterogeneous (Bottinelli et al., 1994, DeNardi et al.,
1993, Gorza, 1990, Schiaffino et al., 1988, Bagust et al., 1974, Peter et al., 1972,
Schiaffino et al., 1989, Burke et al., 1971). This makes the fibre type highly specific to
each muscle and thus makes it difficult to determine the fibre type of the muscle

without combining different studies.
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However, without functional studies, the full impact of these shapes on the function of
mitochondria and even on the cell remains unknown. Currently, there have been
minimal studies that focus on the shape of individual mitochondria and impact on
function of the mitochondria themselves and the overall impact on muscle tissue
specifically. Within the studies that have the main imaging methods used have been
light microscopy or TEM, which do not provide the detail in 3D that can be gained
through use of SBF-SEM. That being said there has been an increase in the use of
3D-EM techniques to study individual mitochondria shape (Vincent et al., 2016,
Vincent et al., 2017, Bleck et al., 2018, Vincent et al., 2019). The development and
improvements in combining other techniques, such as anti-body labelling, with EM
(discussed further in Chapter 4.2.6. Future Work, pg205), will increase the output of

information from such 3D-EM studies as this.

201



4.2.4. Nuclei Analysis

An important step in nucleus development is the migration of the nucleus to the
periphery. Nuclei are found primarily in the centre of the muscle cell early on in
muscle formation (Capers, 1960, Cadot et al., 2015, Folker and Baylies, 2013,
Roman et al., 2017, Roman and Gomes, 2017, Rosen and Baylies, 2017, Roman et
al., 2018). Then the nuclei migrate to the periphery, which was previously debated,
with recent research suggesting it is the crosslinking of myofibrils during development
that forces the nuclei to the periphery (Rosen and Baylies, 2017, Roman et al.,
2018). Without this movement of the nuclei to the periphery the muscle function can
be impaired, as seen in central nuclear myopathies (Jungbluth et al., 2008, Jungbluth
and Gautel, 2014). Although what is not known is at what stage in development this
occurs. In the datasets collected there were some examples of centrally located
nuclei found in the day 55-59 (two examples) and day 50-54 (one example) for both
muscle types. However, for all other cells the nuclei were located at the periphery,
suggesting that all of the nuclei have re-localised to the periphery by day 59
gestation. Although there are numerous studies on the positioning of nuclei, there are
few studies that have shown the time points at which the nuclei move to the
periphery during development, but it can be assumed to occur very early in
myogenesis based on studies into chick embryos, day 13 of a 21 day gestation
(Capers, 1960).

The results from the nuclear volumes show that also by day 50 the nuclei are a
similar size to that seen in later fetal and adults, including both peripheral and
centrally located nuclei. This suggests that the nuclei, which originate from the fusion
of myoblasts (Shenkman et al., 2010, Roman and Gomes, 2017), do not increase in
size over development but are already at the required size. Indeed, when the volume
of each individual nucleus is calculated as a percentage of cell volume there is a
significant decrease from the earliest fetal to the later fetal and adult groups. This is
due to the increase in cell size that occurs during this time. However, these
calculations are based upon estimating the volume of one nucleus per cell (due to
pragmatic issues around the area of image data to be segmented and quantified). It
has not factored in the potential increase in total nuclei numbers, as post-natal
growth, induced hypertrophy (exercise) and repair can increase the number of
myonuclei by fusion of satellite cells or myoblasts (Shenkman et al., 2010). Thus,
although the percentage volume of the cell in which a single nucleus occupies

decreases, the percentage of the cell occupied by total nuclear volume may not.
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Further analysis could be performed on earlier fetal datasets and taking more
samples from the day 50 age group. This could help to determine the percentage of
nuclei that are centrally versus peripherally located and potentially provide a timeline
in the migration of the nuclei to the periphery in the guinea pig. This could be
repeated in a variety of animal models of disease, either during gestation or

comparison of myopathies.
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4.2.5. Conclusion

Overall, this study found that over development not only do the size of the
mitochondria increase but also the number. An increase in proliferation of new
mitochondria was found from the early to the late fetal age groups and the ratio of
cell to mitochondrial network volume was found to be set by the latest fetal age group
for both the psoas and soleus muscle. Although two different muscle types with
varying fibre type proportion were used, many features of mitochondrial network
development were similar including mitochondrial volume changes, and sub-cellular
location proportions during skeletal muscle maturation. From a qualitative analysis
three distinct morphologies of mitochondria have been found, columnar, spheroidal
and irregular. Although these morphologies have been suggested previously, this is
the first instance that a qualitative classification system has been devised. There
were very few differences seen between the fetal age groups in regard to
morphological analysis for both the psoas and soleus. The largest difference in
morphology was seen in the comparisons between the psoas and soleus, especially
in the adult. This is indicative of the morphology of the mitochondria being driven by
fibre differentiation, which does occur during fetal development but is primarily seen

in very late fetal and during post-natal development.

This type of analysis has not been performed before on the nuclei and mitochondria
in skeletal muscle over development. This was only made possible through the use
of SBF-SEM, which provides both the necessary resolution but also the 3D
capabilities to reconstruct a mitochondrion, the mitochondrial network, the nuclei and
the whole cell from a single dataset. The study presents a method of analysing the
structure of skeletal muscle organelles and provides a novel way to classify the
morphology of mitochondria and determine complexity of the network. It has the
potential to be applied to other experimental settings using SBF-SEM or in

combination with other methods, as discussed in future work below.
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4.2.6. Future Work

The next step would be to combine a method of fibre type identification with SBF-
SEM. The results are indicative of a specific fibre type (in the adult only) however
further experiments would be needed to verify this. This could be achieved by
combining known methods for fibre typing, for example immunohistochemistry and
light microscopy (Barnard et al., 1971, Peter et al., 1972), antibody labelling and
gene expression (Moore et al., 1984, Zhang et al., 1987, Condon et al., 1990a,
Schiaffino and Reggiani, 2011, Wang et al., 2015), with SBF-SEM in parallel.

Analysis of earlier fetal groups will help establish the timeline of the nuclei migrating
from the centre to the periphery of the skeletal muscle fibres. In the data currently
collected there are examples of centrally located nuclei in both the psoas and soleus.
However, the proportion of centrally located nuclei in the fetal day 50-54 datasets is
not known and reimaging and quantification is required. Instead, the focus of the data
collection will be on ensuring that nuclei are present and attempting to image whole
nuclei. This type of analysis could be repeated on all of the other age groups and
also in aged adults, proposed to have a higher number of centralised nuclei (Valdez
et al., 2010). This would require imaging tissue block faces at lower magnification,
and for greater depths which, of course, has knock-on considerations for volume of

data storage and subsequent analysis.

Collection of data from neo-natal guinea pigs would also inform us of trajectories of
skeletal muscle development, and mitochondrial and nuclear morphology changes
associated with this, to adulthood. Research suggests that the period shortly after
birth is important for fibre type specification (in mice and rats) (Moore et al., 1984,
Narusawa et al., 1987). Collection and analysis of data from aged adult guinea pigs
would also be of importance. Research shows that this balance of fusion and fission
is affected in aged adults (Wyckelsma et al., 2017), which would affect mitochondrial
network morphology. Other factors that affect mitochondria morphology, such as
exercise, fasting and other stressors (Holloszy, 1967, Bizeau et al., 1998, Holloszy,
2008), could also be explored and may benefit from this type of structural analysis at

high resolution.

The morphological analysis presented here could be applied to muscular diseases
that may affect the morphology and function of the mitochondria and cells.
Mitochondria from patients with mitochondrial diseases have been shown to present

with distinct shapes (Vincent et al., 2016), which may benefit from applying the
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classification system presented here. Another disease that would benefit from SBF-
SEM analysis is Duchenne muscular dystrophy (DMD), which affects the structure of
skeletal muscle cells. From previous studies it is known that the nuclei are mis-
localised in MDX mice and are not distributed equally (Totsuka et al., 1998, Terada et
al., 2010, lyer et al., 2017). Samples from MDX and control mice have been
collected, processed for SBF-SEM but only viewed on TEM for preliminary results.
From the samples a high number of centrally located nuclei were found, as well as
changes in the appearance of the mitochondria. SBF-SEM would determine whether
there are any structural differences in the 3D structure of the nuclei and the shape of
the mitochondrial network and individual mitochondria between the control and MDX

mice.
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4.3. Consideration of the Utility of SBF-SEM for the Study of Neuron and
Skeletal Muscle Biology

4.3.1. Summary

The extensive application here of SBF-SEM to the study of two distinct sets of
biological tissues and questions has allowed for the discovery of previously unknown
concepts in skeletal muscle development and neuronal networks in the Locust.
These experiments present novels methods for analysis of mitochondria and for the
first time present a connectomic-type analysis applied to the locust visual system. In
doing so a large amount of raw data was collected for both experimental projects and
all of this, plus segmented and 3D reconstructed datasets, have been made available

online for people to access, analyse and use as they wish.
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4.3.2. 3D-Electron Microscopy (Microscopy)

The limitation of the locust data collected using SBF-SEM is that the sample is lost
during the in-situ sectioning. By sectioning the entire cross-section of the optic lobe
with the ATUMtome, multiple areas can be imaged, either using mSEM or SEM. In
theory the entire lobula region could be imaged from beginning to end, this would

allow for the full reconstruction of the TmA neuron and LGMD neuron connectome.

In regard to the skeletal muscle data, the amount of resin surrounding the individual
cells limits the capability of the imaging. A large amount of resin requires a higher
amount of nitrogen in the chamber to compensate and reduce charging. This has
been counteracted by the development of the Focal Point Injector (Deerinck et al.,
2018). This injects a small amount of nitrogen close to the surface of the block after
the block is cut and during the imaging cycles, allowing for the chamber to remain at

high vacuum, maximising resolution available

Advances in SBF-SEM imaging have been dramatic in the last decade. The current
project used Zeiss Sigma with Gatan 3View, the latest model as of 2015 when this
project started, for obtaining images of high-quality resolution for a variety of
experimental purposes. The technological options have continued to increase since
then and there are a variety of SBF-SEM microscope manufacturer options available
(including the Merlin, Sigma and Gemini from Zeiss and the Teneo VolumeScope
from Thermofisher) each with different capabilities. The most notable development in
recent 3D-EM techniques is the creation of the mSEM (Eberle et al., 2015, Pereira et
al., 2016). It has a single strong electron beam that is split into multiple beams, up to
91 parallel beams, and each of these beams can scan an area of a section
simultaneously. Out of all the 3D-EM techniques so far described this has the highest
throughput of data acquisition, imaging an area of 1cm? at 4nm resolution in under 3

hours (https://www.zeiss.com/microscopy/int/products/scanning-electron-

microscopes/multisem.html).
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4.3.3. Analysis

Like many other biology experimental approaches, the manual and computational
analyses of the large volumes of data collected from 3D-EM techniques still remains
a bottleneck. The analysis is often the most time-consuming portion of the
experiments. The segmentation of the neural dataset took roughly 9 months, average
6hrs a day and 5 days a week. The analysis of the skeletal muscle data took roughly
10 months, again 6hrs a day 5 days a week. For both experiments a range of tools
were used from manual brush and semi-automatic methods, like interpolation and
thresholding. For this reason, there has been an increase in finding ways to reduce

the time it takes to analyse the data produced.

Computer-based machine learning is the current focus of computational scientists in
analysing EM data. Training a program to recognise multiple feature types from
different tissues would reduce time spent analysing data but this process takes time
to build a library of training data. There have been researchers working to develop
automated segmentation, often involving machine learning (Kasthuri et al., 2015,
Kaynig et al., 2015, Beier et al., 2017, Krasowski et al., 2018). On the other hand,
this is currently limited to neuronal EM datasets and also requires computing
experience. The next step would be to make automated workflows accessible to
those with a range of computing knowledge and also applicable to a broad range of
datasets (e.qg., different biological specimens, structures and dataset resolutions).
Researchers may analyse a variety of tissue types, therefore an automated
segmentation tool or program that can be applied to multiple types of data would be
beneficial. In theory the best program or tool would be able to identify different
structures and individual cells, based upon computer-based learning, and segment
the structures of choice for all sections in the data. This is a major challenge that will

require multi-lab iterative collaboration.

Another option, which also assists, if given appropriate training, with experimental
rigour, is to increase the number of people performing the analysis. This has been
the case for many connectomic studies (Helmstaedter et al., 2013), where students
are trained on analysing the data with a particular purpose. Alternatively, there is also
an increase in ‘citizen science’ projects, where members of the public can aid in the
segmentation of a dataset or in computer training to improve automated workflows

(example: https://www.zooniverse.org/projects/h-spiers/etch-a-cell). However, for
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both cases an expert is required to oversee and check the work produced to ensure

accuracy of segmentation.

Everything above is helped by the deposition of experimental raw data in open
access repositories, the granting of permission to semi-accessible repositories or
proving data upon request. However currently the availability of the data that is
analysed and presented in publications is limited. As indicated in the literature review
table in the introduction (Appendix 1), only 21 publications have made their data
accessible online, from a total of 238 publications using SBF-SEM. The majority of
publications show either the segmented data or reconstructions in video form,
sometimes with small portions of the raw or processed data in video form. Although
there has been a drive to increase the accessibility of data related to EM and for
other types of experimental studies. This has been aided by the funders making it
mandatory to make all data available (BBSRC) and easier deposition and linking of
data to publications (EMPIAR or Zenodo). As previously indicated, all of the raw data
analysed here have been made accessible online for download, which is around

16GB of neural data and total of over 200GB of skeletal muscle data.
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4.3.4. Conclusion and Future Work

The two experiments overall achieved success using SBF-SEM, with novel
information regarding structure found from the analysis of the locust and the skeletal
muscle data. The network of TmA neurons synapsing upon the LGMD 2 neuron in
the locust had never been studied previously to the extent shown here. The
discovery of a potential sub-group of highly connected TmA neurons is entirely novel
and only made possible with SBF-SEM. For the skeletal muscle study, it is the first
time a classification system for mitochondria shape in skeletal muscle has been
devised. This was only made possible with the resolution and 3D imaging able to be
performed with SBF-SEM.

However, both studies share a limitation and is one found in a lot of research
involving SBF-SEM. This limitation is that in some tissues the identity of the cell can
sometimes be difficult to determine, unless there are specific structural markers or
only a single cell is being imaged. For the locust the identification of inhibitory cells
can be done visually within the EM dataset however identification via labelling
methods would aid in this. This could also apply to identification of other receptors at
the synapses between the TmA neuron and LGMD neurons. For skeletal muscle the
fibre type of the cells analysed can only be assumed based on structural evidence in
the adult cells and could not be determined from the data collected of the fetal cells.
Being able to stain the muscle cells to determine fibre type and image prior to
imaging with SBF-SEM or combine so that the labelling can be visualised in the SBF-
SEM. Such a technique is described as Correlative light microscopy and electron

microscopy (CLEM) would aid in answering this question and many more.

Although a combination of molecular labelling, and EM has been performed for a
number of years, such as immunogold labelling with TEM (Vandré and Burry, 1992,
Burry et al., 1992, Hainfield and Powell, 2000), there has been an increase in the
need to combine such methods with the 3D-EM techniques. Currently alterations to
the labelling and staining methods, CLEM has been made possible (Ou et al., 2015,
Shu et al., 2011).There are now a number of examples using fluorescence and light
microscopy followed by 3D-EM acquisition (Bolasco et al., 2018, Booth et al., 2019,
Shami et al., 2016, Drawitsch et al., 2018, Maclachlan et al., 2018, Hoover et al.,
2017). Immunogold labelling has difficulties with penetrating through samples and
other staining methods used for light microscopy will impact on the EM staining and

alter the contrast. However, these methods are currently limited. Use of fluorescence
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combined with EM is still novel and as with all these methods will improve in the

future.

Although the usage of 3D-EM, in particular SBF-SEM, is constantly growing and
improving. However, access to 3D-EM techniques is still limited, due to cost and
access to machinery, and as such is still relatively unknown outside of specific
research areas, such as connectomics. The largest limitation to the technique
currently is the data analysis. The size and amount of data produced has increased
greatly as the technique improves but the segmentation and analysis still rely on user
input and the automated methods are not routinely available for novices. That being
said there are still examples of large amounts of data being analysed with the aid of
citizen science or students, so the daunting nature of the analysis should not limit the
majority of experiments. As mentioned previously, all the data collected here has
been made available online. Hopefully as the users of SBF-SEM and other 3D-EM
techniques grows the amount of data available online to be used by others will
increase. The hope for the future is to be able to have a library of segmentation

scenarios appropriate to tissues from different animal models.

Overall 3D-EM, the experiments described here have illustrated benefits in using
SBF-SEM for the quantitative and qualitative study of neural and muscle tissues. The
technique can be applied to a range of biological circumstances to answer a variety
of experimental questions. An additional aspect of this project is that all of the data
collected has been made available online for further analysis by others or to be used

to answer other questions.
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Appendix

Appendix A - Literature Review.

Collection of publications using SBF-SEM found using the search term ((((((((serial
block face) OR sbfsem) OR sbf-sem) OR sbem) OR sbf-em) OR 3VIEW) OR volume
scope)) AND microscopy in PubMed. The category of the publication was defined by
the main purpose. Methods describes any paper that described how to prepare
(staining), image (technical) and analyse the datasets (analysis), this also included
papers which described the method specific to a tissue or aim (experimental). Other
papers were designated as either connectomics (neuronal network-based studies) or
experimental (for example disease versus control cases). ‘Y’ Indicated that the raw
data are available to download online, and ‘N’ is not, if the data are available upon

request, it is stated as ‘upon request’.
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Appendix B — Locust Protocol

1. Dissolve compounds as listed and fill up to 500ml| ddH20 for Insect Ringer Solution:

a. NacCl 51g
b. KCl 0.36g
c. CaCl; 0.11¢g
d. MgCl; 6H.0 0.43g
e. NaHCO3 0.035¢g

f. NazHPO42H,00.15g
g. CeH1206H,O0 3.85¢g
2. Dissect Brains in cold insect Ringer solution.
3. 2% Formaldehyde, 2.5% glutaraldehyde in 0.1M sodium cacodylate buffer for
minimum of 24hrs.
4. Wash in 0.1M sodium cacodylate pH7.4
a. 100 ml of 0.2M Sodium Cacodylate (21.4g sodium cacodylate in 500ml ddH,0)
b. 5ml of 1M HCL.
c. Made up to 200ml with ddH,0 and pH 7.4
5. Place in solution of 1% osmium tetroxide and 3% potassium ferrocyanide in d ddH,0
for 30 minutes at RT.
6. 3 x 5minute washes in ddH0.
7. Filtered 10% Thiocarbohydrazide for 1hr at RT.
8. 3 x5minute washes in ddH;0.
9. 1% osmium tetroxide in ddH,0 for 30 minutes at RT.
10. 3 x 5minute washes in ddH0.
11. In 1% Uranyl Acetate in ddH;0 for 2h at 60°C.

12. 3 x 5minute washes in ddH-0.

282



13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24,

Lead Aspartate Solution made prior to next step as follows:
a. Lead nitrate, 0.12g
b. Aspartic acid solution, 0.03M 20ml
c. 30mins at 60°C.
Tissue in Lead Aspartate Solution overnight at RT.
3 x 5Sminute washes in ddH0.
50% Acetone for 30mins.
75% Acetone for 30mins.
2 x 100% Acetone for 1hr.
25% Resin (TAAB 812) in Acetone for 1hr.
a. Hardener Resin Component 812 Resin-Premix, 52g

b. Resin Component 812 Resin-Premix, 48g

c. Accelerator TAAB812-Ter-Araldite Resin Premix, 2.5ml

50% Resin in Acetone for 1hr

75% Resin in Acetone for 1hr.

3 x 100% Resin for 1hr.

100% Resin for minimum of 3hrs.

Embed in 100% resin and placed in oven at 60°C for minimum of 72hrs.
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Appendix C — Guinea Pig Protocol

1.

10.

11.

12.

13.

14.

15.

16.

Dissect muscle in 2% glutaraldehyde in 0.1M sodium cacodylate buffer for minimum
of 24hrs.
Wash in 0.1M sodium cacodylate pH7.4
a. 100 ml of 0.2M Sodium Cacodylate (21.4g sodium cacodylate in 500ml ddH,0)
b. 5ml of 1M HCL.
c. Made up to 200ml with ddH,0 and pH 7.4
Place in solution of 2% osmium tetroxide and 3% potassium ferrocyanide in ddH20
for 1hr at RT.
3 x 5minute washes in ddH0.
Filtered 10% Thiocarbohydrazide for 20 minutes at RT.
3 x 5Sminute washes in ddH0.
2% osmium tetroxide in ddH,0 for 1hr at RT.
3 x 5Sminute washes in ddH0.
In 1% Uranyl Acetate in ddH,0 overnight at 4°C
3 x 5minute washes in ddH0.
Lead Aspartate Solution made prior to next step as follows:
d. Lead nitrate, 0.12 g
e. Aspartic acid solution, 0.03M 20 ml
f.  30mins at 60°C.
Tissue in Lead Aspartate Solution for 30 minutes at 60°C.
3 x 5Sminute washes in ddH0.
50% Acetone for 30mins.
75% Acetone for 30mins.

2 x 100% Acetone for 1hr.
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17. 25% Resin in Acetone for 1hr.

a. Hardener Resin Component 812 Resin-Premix, 52g

b. Resin Component 812 Resin-Premix, 48g

c. Accelerator TAAB812-Ter-Araldite Resin Premix, 2.5ml

18. 50% Resin in Acetone for 1hr

19. 75% Resin in Acetone for 1hr.

20. 3 x 100% Resin for 1hr.

21. 100% Resin for minimum of 3hrs.

22. Embed in 100% resin and placed in oven at 60°C for minimum of 72hrs.
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Appendix D — Chemical List

Reagent Company Product Code
NaCL Sigma-Aldrich S9888
KCL Sigma-Aldrich P3911
CaClz Sigma-Aldrich C1016
MgClz; 6H20 Sigma-Aldrich M2670
NaHCOs3 Sigma-Aldrich S6014
Na2HPO4 2H20 Sigma-Aldrich 71643
CeH1206 H20 Sigma-Aldrich 49158
Formaldehyde TAAB Laboratories F017
Equipment Ltd
Glutaraldehyde TAAB Laboratories G003
Equipment Ltd
Cacodylate Buffer Agar Scientific R1104
Osmium Tetroxide TAAB Laboratories 0014
Equipment Ltd
Potassium Ferrocyanide Sigma-Aldrich 244023
Thiocarbohydrazide Sigma-Aldrich 223220
Uranyl Acetate Agar Scientific AGR1260A
Lead Nitrate Sigma-Aldrich 228621
Aspartic Acid Sigma-Aldrich A9256
Acetone Fisher Scientific A/0560/PC17
TAAB 812 Hard Epoxy TAAB Laboratories T030
Resin Equipment Ltd
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Appendix E — Image Analysis Protocol

1.1 Conversion from DM3 to Tiff

For use by the programs the image datasets had to be first converted into a file type
different from the ones produced by Gatan digital micrograph, DM3 and DM4. This

was performed in Fiji by following the procedure below:

1. Import into Fiji by selecting ‘File’ > ‘Import’ > ‘Image Sequence’ in Fiji.

2. Select first image, or entire folder of images, a new dialogue box appears.

3. Check the number of images to be imported and ensure nothing else is ticked.

4. Convert 16-bit images to 8-bit images, to speed up the processing of the
images and reduce the final size of the data.

5. Image stack opens.

6. Normalise contrast by selecting ‘Process’ > ‘Enhance Contrast’.

7. Change saturated pixels to 1% and select ‘Normalize’ and ‘Process All'.

8. Enhance contrast by going to ‘Image’ > ‘Adjust’ > ‘Brightness/Contrast’.

9. Manually adjust brightness and contrast by moving the sliders.

10.Change image parameters by selecting ‘Image’ > ‘Properties’.

11.The parameters for x and y are always correctly registered in Fiji; however,
the z parameter needs to be changed to the correct thickness of slices taken.

12.Adjust images, if required, using filters (such as denoising) found in ‘Process’ >
‘Noise’ or ‘Process’ > ‘Filters’ for all the other filter options.

13.Save adjusted images as a series of TIFF files by clicking ‘File’ > ‘Save as

Image Sequence’.
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1.2. Fiji/TrakEMZ2 Analysis Method

1. Open image stack in Fiji, as detailed above.

2. To create a new TrakEMZ2 file, select ‘File’ > ‘New’ > “TrakEM2 (Blank)'.

3. Two new windows open; object window and analysis window.

4. Import the open stack by right-clicking and selecting ‘Import’ > ‘Import Stack’ in
the analysis window.

5. To add objects and start the segmentation, right-click in the object organiser
window and selecting ‘Anything’ > ‘Add New Child’ > ‘Area_List’.

6. Dragging ‘Anything’ into the middle column creates a new folder; dragging
‘Area List’ creates a new object in that folder.

7. Rename object by right-clicking and selecting ‘Area_List’ > ‘Rename’.

8. Object appears under the ‘Z Space’ tab in the analysis window; select to begin
segmentation.

9. Using the brush tool, draw an outline around the selected object on the image.

10.Hold the shift button and click in the centre of the outline to fill in the outline.

11.Repeat over each slice and segment each object.

12.0nce the segmentation of an object (s) is completed, view results in the 3D
viewer, by right-clicking in either of the windows and selecting ‘Show in 3D’.

13.The 3D reconstruction(s) appear in a new window and can be checked.

14.Save model as an .obj file to be exported to other packages if required.

15.3D reconstructions created in Fiji can be analysed in Blender.
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1.3. Blender Reconstruction

1. Install Neuromorph tools in Blender: ‘Install from File’ > ‘File’ > ‘User
Preferences’.

2. The tools are found in the side panel in the main interface under ‘Misc’.

3. To open the .obj file of interest, select ‘Scene’ tab on the right-hand side and
click ‘Import Object’.

4. The object appears in the display.

5. Using the neuromorph tools, the volume and surface area of each object can

be measured.
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1.4. Microscopy Image Browser (MIB)

MIB can be opened through MATLAB or as a standalone program, and the

information on how to do either is found on the MIB website (http://mib.helsinki.fi/).

1.

VI.

VII.

VIII.

IX.

Opening Dataset and Starting Segmentation

Use the ‘Directory Contents’ to navigate to the location where the files are
stored.

Open the images to be analysed by highlighting them all, then right-clicking
and selecting ‘Combine Selected Datasets’.

The image stack opens in the image window.

Change dataset parameters by going to ‘Dataset’ > ‘Parameters’.

Start segmentation by clicking ‘Create’ in the ‘Segmentation’ panel and
either selecting 63 or 255 models (depending on how many objects are to
be segmented).

Add each material to the ‘Segmentation’ panel by clicking the ‘plus’ button,
then changing the name of the material; it appears in the material column.
In MIB, pixels can only be selected and assigned to one material at a time,
so segmentation has to be performed one at a time.

Change the chosen colour for each material by double clicking on the
coloured square to the left of the material name.

A variety of tools are used for the segmentation.

2. Manual Segmentation

Below the material panel is the segmentation tool drop down list. The
default when the program is started is the ‘Brush’ tool, a manual
segmentation tool.

Use the brush tool to trace the outline of an object and repeat over each

slice. Press Shift and F to fill the object throughout all the slices.
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3.

VI.

4.

Hold down the Ctrl button to turn the brush tool into an eraser to remove
any errors.

The selected pixels appear as green on the image.

Assign the selected pixels to the correct material by ticking the material

under the ‘Add to’ column and pressing Shift and A.

Watershed/SLIC

Select the ‘Brush’ tool; two more options of segmentation appear called
‘Watershed’ and ‘SLIC’.

When using the ‘Watershed’ tool the pixels in the image are combined into
superpixels, based upon boundaries and changes in contrast.

The size of the superpixels is adjusted by changing the ‘N’ number, the
higher the number, the larger the superpixel.

The ‘SLIC’ option is a similar tool but the pixels are grouped into
superpixels based on similar contrast; the smaller the N number, the larger
the resulting superpixel.

By clicking on the image using the brush tool the superpixels appear on the
image as pink outlines; the superpixels are selected by moving over them
using the brush tool.

The superpixels only appear in the area of the image seen in the ‘Image

View’ and not over the entire image.

Interpolation

Use the brush tool to segment the object on every nth slice; ‘Selection’ >
‘Interpolation’, or click ‘I', to fill in the gaps in the segmentation.

Check segmentation and correct any errors.
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5. Thresholding

VI.

VII.

With thresholding the pixels are selected based on a user inputted contrast
range and in MIB there are two types, B/W thresholding and the Magic
Wand tool.

Select ‘B/W Thresholding’ from the menu. Alter the range of contrast by
adjusting the two sliders until the correct selection is seen on the image in
green on the first slice.

Click ‘All' to apply the B/W thresholding to all images.

Select the ‘Magic Wand-Region growing’ tool to change the variation and
radius of the selection tool.

Use the tool to click on a single pixel in the object; select all the pixels
within the range and radius around the selected pixel; alter the variation
and radius until the desired selection is made.

Select ‘3D’ in the ‘Selection’ panel to apply the thresholding to the whole
stack.

Correct any errors using the brush tool.

6. Saving file

Once segmentation is finished (by whichever chosen process) the model is
saved as a separate file by going to ‘Model’>’Save Model'.

During the segmentation process, save as the suggested MATLAB file
format (.model) and the model will be automatically saved in this format
each time.

Once the segmentation is complete, the model file is also saved in an .am

file format to open in Amira.
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1.5. Amira
1. Opening Dataset and Starting Segmentation

I.  Import images by selecting ‘Open data’, highlighting all the TIFF images
and clicking open.

II. A new window appears, and the voxel measurements change to the pixel
measurements.

lll.  In the main interface, a file appears corresponding to the image stack and
a single orthoslice automatically appears in the main viewing area.

IV.  The segmentation is started by right-clicking on the main file and selecting
‘Edit New Label’ or switching to the ‘Segmentation Panel’.

V. New objects are added by clicking ‘Add’ in the segmentation panel, the
name is changed by double-clicking on the new object and the colour
altered by right-clicking on it.

VI.  The segmentation tools are found at the bottom of the right-hand panel.

2. Manual Segmentation and Interpolation
I.  Select the brush symbol to manually highlight the objects.

II.  Annotate every nth slice manually and then select ‘Interpolate’ under the
‘Selection’ tab.

lll.  The selection appears as red upon the image.

IV.  Assign the selection to the correct label by selecting the ‘plus’ sign, and to
add the selection from all slices select ‘Volume’ instead of ‘Current Slice’.

V. Remove the selection by selecting the ‘minus’ sign and correct any errors
by holding down the ‘shift’ key and using the brush tool.

3. Thresholding
I.  Select the magic wand thresholding tool by selecting the ‘magic wand’
symbol in the panel.

IIl.  When selected, a graph appears in the panel with sliders.
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lll.  When a pixel is selected on the image, a pointer appears on the graph to
show where on the contrast scale that specific pixel sits.
IV.  Adjust the sliders around this point until the correct pixels are selected.
V. Tick ‘3D’ to perform the action across all slices.
VI.  During the segmentation, view the rough object by choosing the four-panel
viewer above the viewing window.
4. Reconstruction
I.  Once the segmentation is complete, select the project panel tab to go back
to the view when Amira was first opened; the new label file (.label) is
created and is found connected to the first image file.
II.  To create the surface for reconstruction, right-click the .Labels file and
select ‘Generate Surface’ > ‘Apply’ selected.
lll. A .surf file appears, connected to the .Labels file.

IV.  View the surface by right clicking the .surf file and selecting ‘Surface view'.
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Summary

Serial block face scanning electron microscopy (SBF-SEM) is a
relatively new technique that allows the acquisition of serially
sectioned, imaged and digitally aligned ultrastructural data.
There is a wealth of information that can be obtained from
the resulting image stacks but this presents a new challenge
for researchers — how to computationally analyse and make
best use of the large datasets produced. One approach is to
reconstruct structures and features of interest in 3D. However,
the software programmes can appear overwhelming, time-
consuming and not intuitive for those new to image analysis.
There are a limited number of published articles that provide
sufficient detail on how to do this type of reconstruction.
Therefore, the aim of this paper is to provide a detailed
step-by-step protocol, accompanied by tutorial videos, for
several types of analysis programmes that can be used on raw
SBF-SEM data, although there are more options available than
can be covered here. To showcase the programmes, datasets
of skeletal muscle from foetal and adult guinea pigs are
initially used with procedures subsequently applied to guinea
pig cardiac tissue and locust brain. The tissue is processed
using the heavy metal protocol developed specifically for
SBF-SEM. Trimmed resin blocks are placed into a Zeiss Sigma
SEM incorporating the Gatan 3View and the resulting image
stacks are analysed in three different programmes, Fiji, Amira
and MIB, using a range of tools available for segmentation.
The results from the image analysis comparison show that
the analysis tools are often more suited to a particular type of
structure. For example, larger structures, such as nuclei and
cells, can be segmented using interpolation, which speeds up
analysis; single contrast structures, such as the nucleolus, can
be segmented using the contrast-based thresholding tools.
Knowing the nature of the tissue and its specific structures
(complexity, contrast, if there are distinct membranes, size)

Correspondence to: E. Cocks, Newcastle University, Institute of Genetic Medicine,
Central Parkway, Newcastle upon Tyne NE1 3BZ, UK. Tel: 07713583726; e-mail:

E.Cocks2@newcastle.ac.uk

will help to determine the best method for reconstruction and
thus maximize informative output from valuable tissue.

Introduction

Electron microscopy (EM) has evolved to incorporate different
preparation techniques for the imaging of a wide variety of
samples. Transmission and scanning EM (TEM and SEM, re-
spectively) are regularly used to analyse biological material
in order to reveal structural information, which may relate to
function. Yet, there are limitations. For example, SEM gener-
ally images the surface topography of cells and tissues but not
intracellular structures (unless freeze-fracture techniques are
used). On the other hand, TEM provides information on spatial
arrangements within cells to within 1 nm resolution. How-
ever, this is accomplished by examining a single ultrathin sec-
tion, typically 50-100 nm, from a much larger sample, which
could range from ~10 um (single cells) to several millimetres
(tissues). Therefore, important information regarding spatial
arrangements of structures of interest through the depth of
a cell or tissue is difficult to obtain. Manual serial-sectioning
can be combined with TEM to create 3D stacks and visualiza-
tions of data (Andersson-Cedergren, 1959; Kristen & Stevens,
1988; Bock et al., 2011; Takemura, 2015; Lee et al., 2016).
However, this is extremely time-consuming, requires a high
level of experience in microtomy and manual image alignment
and, even then, often results in damaged or lost sections whose
‘missing’ information has to be interpolated.

The desire within the EM community to obtain data in three
spatial dimensions (x—y—z) at the ultrastructural level led to
the development of a rudimentary automated system for serial
sectioning coupled with EM imaging by Kuzirian and Leighton
(1983). Although it was another two decades before the pro-
cedure known as serial block face SEM (SBF-SEM) was de-
scribed in published form by (Denk & Horstmann, 2004). It
consists of a mini-ultramicrotome with diamond knife inside
an SEM chamber. The knife cuts ultrathin sections from a piece
of tissue embedded in a resin block, an electron beam scans
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the block surface and a detector records the backscattered
electrons, producing a digital image. This process is repeated
at an operator-specified depth to produce a digitized stack of
aligned images. Itis possible to obtain tens to hundreds of serial
sections from resin blocks, and aligned images, in a few hours.
In addition to SBF-SEM, there are other methods of 3D volume
collection that have been developed, such as array tomogra-
phy and focused ion beam scanning EM (FIB-SEM) (reviewed
by Peddie & Collinson, 2014; Titze & Genoud, 2016). All tech-
niques produce large quantities of data, which are difficult to
manage and time-consuming to analyse. In this manuscript,
we concentrate on data obtained by SBF-SEM but the same
analyses we describe may be applied to datasets obtained by
other methods.

The stack of images obtained from biological samples allows
researchers to follow cell-to-cell arrangements, or intracellu-
lar structures, in the z-axis in a number of ways. First, this can
be achieved by simply scrolling through the images for qual-
itative assessment of the features of interest. Second, image
analysis software can be used to create 3D reconstructions of
the data. These can aid the qualitative assessment of the data,
for example, creating movies that show the reconstructions on
rotating axis (Kasthuri et al., 2015). Third, such tools can also
be used for detailed quantification of the biological data. The
image analysis can be the most complex and time-consuming
portion of the whole process.

In many ways, the challenges of 3D EM have now shifted
from how to capture the difficult-to-measure to what to do
with all this data? At the outset of an experiment one, ide-
ally, it needs to know how the resultant images are to be
analysed. These considerations vary from simple to complex,
depending upon the experimental question, the tissue or cell
constituency, the resolutions of structures of interest and their
contrast to neighbouring structures.

The mostlikely requirement is the creation of 3D reconstruc-
tions of the image stacks, whether for qualitative or quantita-
tive assessment. There are a number of image analysis pack-
ages that assist with creating reconstructions (for a recent
review of these, see Borrett and Hughes (2016)), each requir-
ing segmentation as a first step. Segmentation is the process
of annotating a specific structure on each image so as to fol-
low it in each consecutive image in the z-axis. There are two
main ways of accomplishing this. In one case, the object(s) is
highlighted manually by adding a coloured layer(s) on top of
the image. An alternative process involves assigning individ-
ual image pixels to only one object, which means if a pixel is
reselected during another segmentation, it will be reassigned.

The methods of segmentation can be further divided into
manual, semiautomated and automated categories. Manual
segmentation tools require the user to annotate the object,
e.g. by colouring, over every slice. Semiautomated tools use
a combination of user input and programme predictions, to
highlight a structure. An example of this is interpolation. The
user manually annotates the structure every nth slice and the

programme will fill in the empty slices using the annotated
image as a guide to predict the possible shape of the object.
Another is the thresholding tool, which selects pixels based on
the contrast limits set by the user. These limits allow for the
selection of light or dark pixels depending on the appearance of
the object. There is the option available in some programmes
for machine learning automated segmentation. Here, the pro-
gramme ‘learns’ object selection based on trial runs performed
by the user on a sample dataset. These settings are then auto-
matically applied to the full dataset to be analysed and can be
implemented on other datasets as well.

The complexity of SBF-SEM datasets, and scenario-specific
analysis requirements, can make it difficult to know which
image analysis tools and procedures to follow to make best
interpretations of the data. Therefore, the purpose of this pa-
per is to compare three popular image analysis programmes,
and the segmentation tools they offer, for the qualitative and
quantitative analysis of SBF-SEM data. We provide detailed
protocols for the data handling and analyses. In doing so, we
aim to provide direction to researchers new to SBF-SEM by
drawing attention to advantages and limitations of the soft-
ware packages and tools. A similar comparison was done by
Tsai et al. (2014 ), which details data reconstruction from mul-
tiple volume EM techniques. However, the in-depth workflow
from these techniques may appear daunting for those new to
image analyses. This paper is aimed at researchers with no or
little experience using image analysis software and SBF-SEM
and provides a simple workflow for deciding which methods
to use.

The material analysed is predominantly guinea pig skeletal
muscle, chosen because it exhibits regular, well-defined
intracellular structures by EM that allowed us to test the effec-
tiveness of each software tool. From the results, we developed
a decision-making map that can be applied to the analysis of
any structure from any sample type and will help researchers
choose the workflow to apply to their SBF-SEM data. By
following this workflow, the researcher will ensure that they
are in the best position to address the aims of their study and
maximize the output from this relatively new technique.

Method

Tissue preparation for SBF-SEM

Skeletal muscle tissue (psoas and soleus muscles) and hearts,
from Duncan Hartley guinea pigs, were terminated under li-
cenced procedures according to the Animals Scientific Proce-
dures Act 1986 (ASPA). They were then microdissected into
2% glutaraldehyde with 0.1M sodium cacodylate buffer and
left for a minimum of 12 h in the fixative at 4°C. The samples
then undergo a heavy metal staining protocol (Wilke et al.,
2013). The tissues were washed in 0.1M sodium cacodylate
pH7.4 followed by a solution of 3% potassium ferricyanide
with 2% aqueous osmium tetroxide in ddH,O for 1 h. Then,
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followed by filtered 10% thiocarbohydrazide, TCH, for 20 min
and then secondary 2% osmium tetroxide for 30 min. The sam-
ples were then placed in 1% uranyl acetate at 4°C overnight
followed by lead aspartate solution, 0.12 g of lead nitrate in
20 mL aspartic acid for 30 min.

The brain from an adult locust (Locusta migratoria) was
sacrificed by ice, dissected in cold saline and placed in 2%
paraformaldehyde, 2.5% glutaraldehyde in 0.1M sodium ca-
codylate buffer. It was processed with an adapted version of
the Wilke et al. (2013) protocol described in Wernitznig et al.
(2016). The main differences to the above protocol are the use
of reduced osmium (1%) and a shorter time in uranyl acetate
but at 60°C.

Between each step, all samples were washed in several
changes of ddH,0. The samples were dehydrated with ace-
tone, from 25% to 100% and then impregnated with increas-
ing concentrations of Taab 812 hard resin in acetone with
several changes of 100% resin. The samples were embedded
into 100% resin and left to polymerize at 60°C for a minimum
of 36 h.

The resin blocks were trimmed using a razor blade to form a
trapezoid block face. Using a diamond knife, 1 pm sections are
taken and stained with toluidine blue and viewed under a light
microscope. Several 70 nm sections were taken, placed on a
copper grid and viewed on a CM100 TEM (FEI), to check tissue
morphology and orientation and penetration of the staining.
This is done to ensure that the tissue has been adequately pro-
cessed for viewing by SBF-SEM. The blocks were then further
trimmed to approximately 0.75 mm x 0.75 mm and glued
onto a pin. In order to reduce sample charging within the
SEM, the block was painted in silver Dag and sputter-coated
with a 5 nm layer of gold.

SBF-SEM settings and image analysis

The specimens were placed into a Zeiss Sigma SEM (Zeiss,
Cambridge, UK) incorporating the Gatan 3View (Gatan inc.,
Abingdon, UK) as the SBF-SEM system. For this particular
project, the following parameters were used. For each sample,
the images were obtained at 2.5-5 kV accelerating voltage,
with an aperture of 30 «m, in variable pressure ranging from
20 to 53 Pa. The blocks were sectioned (unless stated other-
wise) at a thickness of 70 nm and the images recorded at a
range of magnifications with a resolution of 1024 x 1024
pixels or 3000 x 3000 pixels with a 20 us/pixel dwell time
and at resolution ranging from 5 to 20 nm.

Gatan Digital Micrograph was used to collect digitized im-
ages of each experimental run in a DM3 format. The data
were then analysed using three different image analysis pro-
grammes (Fig. 1). These are Fiji (http://fiji.sc/), Amira (http://
www.fei.com/software/amira-3d-for-life-sciences/) and Mi-
croscopy Image Browser, MIB (http://mib.helsinki.fi/). Fiji,
via the plugin TrakEM2 (Cardona et al., 2012), is primarily
an operator-driven programme that is freely available. For a
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comparison of the programmes see Table 1. Amira and MIB
(Belevich et al., 2016) have the capacity for using semiauto-
mated tools: Amira requires a commercial license and MIB
is freely available. Amira enables visualization of all anal-
ysed data, whereas FIJI and MIB are purely analytical pro-
grammes with basic visualization and require a secondary
programme to perform computational analysis of the segmen-
tations. Blender (https://www.blender.org/) is one such pro-
gramme, it is a free graphics software which can be used to re-
construct the objects created in Fiji with the aid of Neuromoph
Tools (Jorstad et al., 2015) (http://cvlab.epfl.ch/NeuroMorph)
and perform computational analysis. These were developed
specifically to import the objects from Fiji and perform quan-
tification analysis. Opening the segmented 3D objects via these
tools also ensures that the dimensions are consistent with
the parameters from the raw data. In MIB, the segmentation
model file can be exported in a variety of formats to differ-
ent programmes, and in this protocol, Amira is used as the
example.

Protocols for image file handling and analyses

The protocols below are applied initially to the examina-
tion of a skeletal muscle SBF-SEM dataset and the steps
in each process illustrated in the accompanying video file
tutorials (Supporting files S1-S5). The raw datasets used
in the videos can be accessed via the EMPIAR website:
http://www.ebi.ac.uk/pdbe/emdb/empiar/ (Accession code:
EMPIAR-10092). The analysis is performed on a Toshiba lap-
top with Intel® Core i7-5500U CPU, 2.40 GHz, 16 GB RAM
and 64 bit.

Converting DM 3 to TIFF (video Fiji image processing)

Theraw data are saved as a DM3 file format from Gatan Digital
Micrograph, GDM, which cannot be opened in all imaging
analysis programmes. The first step therefore is to convert the
images into a TIFF format. During this conversion process,
image contrast can be lost and a normalization step is carried
out to prevent this.

(1) An image sequence is imported by selecting ‘File’ >
‘Import’ > ‘Tmage Sequence’ in Fiji (Supplementary
file S1).

(2) Select the first image, or entire folder of pertinent images
and a new window will appear.

(3) Check the number of images to be imported and ensure
that nothing else is ticked.

(4) At this point, the 16 bit images can be converted into 8
bit images, to speed up the processing of the images and
reduce the final size of the data.

(5) The image stack will open.

(6) Normalize the contrastby selecting ‘Process’ > ‘Enhance
Contrast’.
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Fiji and TrakKEM2

v

Manual Segmentation

Fij

Gatan Digital Micrograph
(GDM)

v

Import DM3 Files

v

Adjust Contrast

v

Convert File to TIFF

Amira

v

Semi-Automated Segmentation

(Experimenter outlining objects) (Interpolation and /or

v

Export Object

3D Reconstruction

Thresholding)

Reconstruction

Microscopy Image
Browser, MIB

Semi-Automated Segmentation

(Interpolation and for
Thresholding)

v
Export Object

3D Reconstruction

Fig. 1. Flow chart showing the steps for the image analysis comparison. The first step is to adjust the contrast and convert the images from DM files
formats to TIFF. The stack of TIFFs is then analysed in each of the three programmes, and the examples of the segmentations used in each are also shown.
The final step in the process is to reconstruct the segmentations into a 3D model.
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(7) Change saturated pixels to 1% and select ‘Normalize’
and ‘Process All'.

(8) Contrast can be further enhanced by going to ‘Image’ >
‘Adjust’ > ‘Brightness/Contrast’.

(9) Manually adjust the brightness and contrast by moving
the sliders.

(10) The image parameters have to be changed by selecting
‘Image’ > ‘Properties’.

(11) The parameters for the x and y are always correctly
registered in Fjji; however, the z parameter will need to
be changed to the correct thickness of slices taken.

(12) The images are adjusted, if required, using filters (such
as denoising) found in ‘Process’ > ‘Noise’ or ‘Process’ >
‘Filters’ for all the other filter options.

(13) Save the adjusted images as TIFF by clicking ‘File’ >
‘Save as Image Sequence’.

The following steps are then undertaken in each programme
to segment each of the image stacks:

(1) Fiji/TrakEM?2 (Image Analysis Fiji)
(i) Theimage stack to be analysed is opened in Fiji, as
detailed above.
(ii) To create a new TrakEM2 file, select ‘File’ >
‘New’ > ‘TrakEM2 (Blank)’ (Supplementary file S2).

(iii) Two new windows will open. One is the object
window and the other is the analysis window.

(iv) Right click and select ‘Import’ > ‘Import Stack’ in
the analysis window to import the images.

(v) Right click in the object organizer window and
select ‘Anything’ > ‘Add New Child’ > ‘Area_List’.

(vi) Drag ‘Anything’ into the middle column to create
a new folder and then drag ‘Area List’ to create a
new object in that folder.

(vii) Rename the object by right-clicking and selecting
‘Area_List’ > ‘Rename’.

(viii)  The object will appear under the “Z Space’ tab in
the analysis window and select it to begin segmen-
tation.

(ix)  Use the brush tool to draw an outline around the
selected object on the image.

(x)  Fill the object by holding the shift button and click-
ing in the centre of the outline.

(xi) Repeat this over each slice and for each user-
defined object to be segmented.

(xii) Once the segmentation of a defined object (s) is
completed, the results can be viewed in the 3D
viewer. Right click in either of the windows and
select ‘Show in 3D’.

(xiii) The 3Dreconstruction(s) will appear in a new win-
dow.

(xiv) Themodelissaved as an .obj file and to be exported
to other packages if required.
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(xv)  3Dreconstructions created in Fiji can be analysed
in Blender.

(2) Blender v2.76 (Blender)
(i) Toinstall the Neuromorph tools, go to ‘Install from
File’ > ‘File’ > ‘User Preferences’ (Supplementary
file S3).
(i) The tools are found in the side panel in the main
interface under ‘Misc’.
(iii) To open the .obj file of interest select the ‘Scene’
tab on the right hand side and then ‘Import
Object’.

(3) Microscopy Image Browser, MIB v2.1 (Image Analysis
MIB)

MIB can be opened through Matlab or as a standalone pro-
gramme, and the information on how to do either is found on
the MIB website (http://mib.helsinki.fi/).

(i) Navigate to the location of the TIFF image stack to be im-
ported by using the ‘Directory Contents’ (Supplementary
file S4).

(ii) Highlight all the images to be analysed, right-click and
select ‘Combine Selected Datasets’.

(iii) The image stack will open.

(iv) Change the dataset parameters by going to ‘Dataset’ >
‘Parameters’.

(v) Click ‘Create’, in the ‘Segmentation’ panel and select 63
or 255 models, depending on how many objects will be
segmented, to start the segmentation.

(vi) Add a material to the ‘Segmentation’ panel by clicking
the ‘plus’ button, change the name of the material and
it will appear in the column.

(vii) In MIB, pixels can only be selected and assigned to one
material at a time, so segmentation has to be done one
at a time.

(viii) Double click on the coloured square to the left of the
material name to change the colour.

(ix) A variety of tools can then be used for the segmentation.

Manual

(1) Below the material panel is the segmentation tool drop
down list. The default when you start the programme
will be the ‘Brush’ tool, a manual segmentation tool.

(2) Use the brush tool to trace the outline of the object and
repeat this over each slice. Press Shift and F to fill the
object throughout all the slices.

(3) Hold the Ctrl button to turn the brush tool into an eraser
and remove any errors.

(4) The selected pixels will appear green on the image.

(5) Assign the selection to the ticking the correct material
in the ‘Add to’ box and pressing Shift and A.
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Table 1. Comparison of imaging programmes. Examples of the different
types of image formats and segmentation tools offered by three analysis

programmes.
Fiji Amira MIB
Image import format .tif, .dm3, tif, .png, tif, .dm3, .dm4,
.png, .bmp .bmp .png, .bmp
Object export format .obj .am, .surf  .am, .tif, .mat,
.model, .stl, .mrc,
.mod, .nrrd, .h5
Manual Brush J J J
Interpolation v v
B/W thresholding VA N4
Magic wand v J
thresholding
Watershed/SLIC Vv
segmentation
Watershed/SLIC

(1) When the ‘Brush’ tool is selected, there are two more
options of segmentation that can be found ‘Watershed’
and ‘SLIC'.

(2) The ‘Watershed’ tool combines the pixels in the image
into superpixels, based upon boundaries and changes in
contrast.

(3) The size of the superpixels is adjusted by changing the
‘N’ number, the higher the number, the larger the su-
perpixel.

(4) Click on the image using the brush tool and the super-
pixels appear on the image, as pink outlines, select the
superpixels by moving over them using the tool.

(5) The ‘SLIC’ option is a similar tool but the pixels are
grouped into superpixels based on similar contrast
and instead the smaller the N number, the larger the
pixel.

(6) The superpixels will only appear in the area of the image
seen in the ‘Tmage View’ and not over the entire image.

Interpolation

(1) Using the brush tool manually, draw on every nth slice
and then click ‘T" or go to ‘Selection’ > ‘Interpolation’
and the gaps in the segmentation will be filled in.

(2) Check and correct any errors that have occurred.

Thresholding

(1) Thresholding is the selection of pixels based on a user
inputted contrast range and there are two types, B/W
thresholding and the Magic Wand tool.

(2) Select ‘B/W Thresholding’ from the menu. Alter the
range by adjusting the two sliders until a correct se-
lection is made over the entire image.

Table 2. Timing analysis results. The table shows the results from the
timing analysis performed on a small portion of the total skeletal muscle
dataset (20 slices) in each of the programmes shown in seconds. It was
performed on Toshiba laptop with Intel® Core i7-5500U CPU, 2.40 GHz,
16 GB RAM and 64 bit.

Fiji Amira MIB
Foetal Nucleus 6.29 3.21 2.12
mitochondria 9.14 9.22 26.44
Adult Nucleus 10.52 5.35 3.07
mitochondria 37.14 4.28 62.39

(3) Click ‘All’ for B/W thresholding to be applied to the stack
of images.

(4) Chose the ‘MagicWand-Regiongrowing’ tool, change
the variation and radius of the selection tool.

(5) Click on a single pixel in the object, pixels within the
range and radius will be selected, alter the variation and
radius until the desired selection is made.

(6) Select ‘3D’ in the ‘Selection’ panel to apply the thresh-
olding to the stack.

(7) Check for any errors and correct using the brush tool.

Saving file

(1) Oncesegmentationisfinished (by whichever chosen pro-
cess) go to ‘Model’>'Save Model’ to save the model file
in the preferred format.

(2) Recommended file format for the duration of the seg-
mentation the Matlab file format (.model) is preferred
and the model will automatically save in this format.

Saving for opening in Amira

(1) Save the modelfile to open in Amira go to ‘Model’>"Save
Model As’.

(2) Select any of the ‘.am’ file types.

(3) The new model file can now be opened in Amira (see
Reconstruction under Amira).

(4) Amira v6.0 (Image Analysis Amira)
(i) Select ‘Open data’, highlight all the TIFF images
and click open toimport theimages (Supplementary
file S5).

(ii) In the new window change the voxel measure-
ments to the pixel measurements, as mentioned at
the beginning.

(iii)  In the main interface, a file will appear which cor-
responds to the image stack and a single orthoslice
will automatically appear in the viewing area on
the right.

(iv)  Rightclick on the main file and select ‘Edit New La-
bel’ to start segmentation and switch to the ‘Seg-
mentation Panel’.
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Fig. 2. Example of SBF-SEM image series. Nine consecutive images (viewed from left to right) from a stack of 93 serial images of a portion of a muscle
cell from the skeletal muscle psoas from a late foetus guinea pig. In the first image, the nucleus can be seen, labelled with an ‘N’, as well as the nucleolus,

white ‘n’, and the mitochondria, labelled with white arrows. Over each slice, of 70 nm, the structures change shape, as shown in the images. The images
were taken at 12k x magnification, 7 nm resolution and an image size of 1024 x 1024 pixels. All scale bars are 1 pm.

(v) Click ‘Add’ to add new objects to the segmentation
panel, double-click on it to change the name and
right click to change the colour and appearance.

(vi) The segmentation tools are at the bottom of the

right-hand panel.

Manual and interpolation

(4)

Select the brush symbol for the manual tool to highlight
objects.

Manfully annotate every nth slice and select ‘Interpolate’
under the ‘Selection’ tab.

Assign the selection to a label by selecting the ‘plus’ sign,
to add selection from all slices select ‘Volume’ and just
for the one slice select ‘current slice’.

To remove the selection click the ‘minus’ sign.

Thresholding

(1)
(2)

Click on the magic wand symbol to use the magic wand
thresholding tool.
A graph will appear with sliders.

3)

(4)

(5)
(6)

Select a pixel on the image and a pointer will appear on
the graph to show where on the contrast scale that pixel
appears.

An area will be highlighted and manually adjust the
sliders to change the pixels selected until the correct
selection is made.

Tick ‘3D’ to perform the action across all slices.

To view the object on 3D in the segmentation
panel choose the four-panel viewer above the viewing
window.

Reconstruction

(1

(2)
3)

Select the project panel tab once the segmentation is
complete, where there will be a secondary file connected
to the original image file with .labels extension (corre-
sponding to the new objects created in the segmentation
panel).

Right click the .Labels file and select ‘Generate
Surface’ > ‘Apply’.

Another file will appear connected to the .Labels file, a
.surf file.
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(A)

Fiji

Amira

MIB

(B)

Fetal Psoas Nucleus Volume

24 u Fiji
= Amira
MIB

Volume/pm?*

10 S

Nucleus

Fig. 3. Examples of digital reconstruction of nuclear volume. (A) Reconstructions of the nucleus from foetal psoas at different orientations from the
segmentations performed in Fiji, Amira and MIB. The reconstructions of the nuclei show no differences between the different programmes. (B) Volume

measurements of the nucleus from each of the programmes, which again are similar between each of the programmes used to reconstruct the nucleus.

(4) Right click the .surf file and select ‘Surface View’, a ren-
der of the 3D model will appear in the viewing window.

Results

Figure 2 illustrates a montage of serial-sectioned raw data SBF-
SEM images from the psoas skeletal muscle (late foetus). Nine
consecutive images are shown that are part of a larger dataset
of 93 serial images. This dataset was used to illustrate the
application of the different image analysis programmes and
protocols. From the data, the nucleus, nucleolus, chromatin
and mitochondria were all segmented and reconstructed us-
ing the tools detailed in the methods. Further information on
which tool was specifically used for each structure is included
in the following results and figures. The methods of segmenta-
tion can be further divided into manual, semiautomated and
automated categories. Manual segmentation tools require the
user to annotate the object, e.g. by colouring over every slice.
Semiautomated tools use a combination of user input and
programme predictions to highlight a structure. Automated
segmentation requires no user input, although some machine
learning is often involved; however, this method is not used in
this analysis.

A timing analysis was also performed over 20 slices for each
different method used to segment the nuclei and mitochondria
(see Table 2). Interpolation was used to segment the nuclei in
MIB and Amira, which was quicker than the manual segmen-
tation performed in Fiji, with MIB being the fastest between
all three programmes. The thresholding method in Amira was
the quickest method to segment the mitochondria. Overall

the semiautomated tools, Amira specifically, segmented the
structures fastest, when combining the nuclei and mitochon-
dria timing analysis. Note that the speed of the semiautomated
procedures will be dependent on computing ability.

Segmentation of cellular structures

The nucleus of the cell was segmented first. This was done
manually in Fiji and with the use of interpolation in Amira
and MIB. Visually, the 3D models of the nuclei are similar and
the volumes are also similar between each of the programmes
(Fig. 3). Although using interpolation speeds up the segmen-
tation process, errors did occur on the slices that were interpo-
lated and correcting these added to the time taken to segment.
Further analysis was performed to test the accuracy of the
interpolation in MIB, comparing the uncorrected interpolated
nucleus to a manually segmented one (Fig. 4). There was a
differing level of detail between each of the models. Specifi-
cally, the folds of the nuclear membrane were not as detailed
in the interpolated models as in the manually segmented one.
However, the volumes of the nuclei from the quantification
analysis were similar, with only 1.98% difference between
the corrected and the every 10th slice (1.37% difference be-
tween the corrected and the every 5th slice). Therefore, for
bulk quantification analysis, corrections may not be required.
If, however, finer details are required for qualitative analysis,
the interpolation errors will need to be corrected.

After the nucleus, the darker and dense chromatin within
the nucleus was segmented. The segmentation and the final
reconstruction can be seen in Figure 5(A). Thresholding was
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.

(D) Interpolated and Manually Reconstructed
Nuclei Volumes

150
145
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120

Volume pm?
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10th Slice
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Manual

Fig. 4. Analysis of accuracy of interpolation method for segmentation. (A), (B) and (C) each show five images with the nucleus segmented and the final
reconstruction of the nucleus, from late foetal psoas all performed in MIB. (A) Shows the nucleus segmented using interpolation when every 10th slice
has been manually segmented, (B) from every fifth slice and (C) is a nucleus which has been segmented manual. In the images, there appear to be small
differences between the segmentations, either the selection has not reached the boundary or goes over it. In the reconstructions, the nuclear folds are
not as detailed in (A) and (B) when compared to the manual reconstruction in (C). (D) Volumes from each of the segmentations. The images are cropped
from a total image size of 3000 x 3000 pixels taken at 2k x magnification and 13 nm resolution. All scale bars are 1 pm.

used in MIB and Amira to select the darker pixels that corre-
spond to the chromatin. During the thresholding of the chro-
matin in both Amira and MIB, there were some errors in the
selection. In this case, the thresholding was not restricted to a
specific structure, and the nuclear boundary was also selected.
In order for the thresholding procedure to be effective, there
also needs to be sufficient contrast within the images. Manual
alterations can be made after thresholding to ensure that the
correct selection is made although one has to be careful not to
introduce user bias in object selection.

Thenext feature tobe segmented was the nucleolus. The seg-
mentation had to be performed in this order due to the nature
of the segmentation in MIB and Amira. As mentioned earlier,
in these two programmes, the pixels can only be assigned to a
single structure. After the initial segmentation of the nucleus,
all pixels were assigned to it. Then, when the chromatin is

segmented, the thresholded pixels were reassigned from the
nucleus to the chromatin. However, when the chromatin was
thresholded, the nucleolus was also selected, as the pixels are
of a similar contrast. By segmenting the nucleolus after the
chromatin, the pixels were reassigned to the nucleolus. This
has to be kept in mind whenever segmenting a larger structure
(nucleus) and the inner detail of it (chromatin and nucleoli)
when using programmes such as Amira and MIB.

The segmented image and reconstruction of a nucleolus is
shown in Figure 5(B). As seen in the raw images, the nucleoli
appeared in a range of contrasts, with light and dark pixels.
When thresholded, only the darker pixels were selected, which
caused gaps in the model, whereas when it was manually
segmented, the entire nucleolus area was segmented. This
is one example of when thresholding can be used to show
intricate internal structures of an object.
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Fig. 5. Examples of reconstruction of chromatin and nucleoli. (A) Three single snapshots from the data series with the chromatin segmented and the
reconstructions at different orientations performed in each of the image programmes, Fiji, Amira and MIB. (B) Three single snapshots from the data series

with the nucleolus segmented and reconstructions of the nucleolus from the three programmes. The nucleoli reconstructed in Amira and MIB show more

detail of the ‘web-like’ appearance of the nucleolus. All scale bars are 1 um.

Once the nuclei and associated structures were completed,
the mitochondria were segmented. The decision was made
not to interpolate the mitochondria due to their small size
and complex nature, as highlighted in Figures 6(A) and 6B).
Instead, the mitochondria were thresholded in Amira and
MIB. On comparing, the three models there were differences
(Fig. 6C). Mitochondria consist of a range of contrasts and in
the raw images, the detail of the cristae (appearing as dark
inner membranes) can be seen. When thresholded, only the
darker pixels, the outer membrane and cristae, were selected,
which gave the thresholded models a broken appearance.
However, the location and arrangement of the mitochondria
could still be discerned and with further user input (e.g. using
the fill feature), the appearance was improved. However, thisis
further evidence that the thresholding tool is case-dependent
and often cannot be relied upon on its own but should be used
in conjunction with other segmentation tools.

A second dataset was taken at a higher resolution, higher
magnification and thinner section thickness, specifically to
attempt to reconstruct the mitochondria with greater detail.
Figure 7 presents the results from the reconstruction of these
datasets, showing that it was possible for the cristae of the mito-
chondria to be reconstructed in detail. However, importantly,
quantitative analysis of the thresholded mitochondria resulted
in a smaller volume than the manually segmented mitochon-
dria, due to only the darker pixels being segmented. There-
fore, if quantification of mitochondrial volume is required, a
manual method will have to be used to ensure that correct
measurements are made.

The final reconstructions incorporating all segmented fea-
tures of the skeletal muscle are shown in Figure 8. Although
the general appearances of the models were similar in each of
the programmes, there were some differences caused by the
methods used to segment the structures of interest. For exam-
ple, the mitochondria were more fragmented in the MIB and
Amira models as they had been thresholded compared to the
more dense structures seen with Fiji's manual segmentation.
The devised workflow from these analysesis shown in Figure 9.

Validation

The workflow was then implemented onto two other tissue
types: guinea pig cardiac muscle and a region of the optic lobe
from locust brain. This was done to test the workflow and
validate that it was applicable to other tissues and structures.

The mitochondria in the cardiac muscle were dark and
dense, with high contrast to surrounding features (Fig. 10A).
It had a different appearance when compared to the mito-
chondria in the skeletal muscle, which, as shown already,
exhibited varied contrasts. By following the workflow (3D
Reconstruction>Yes>Quantification>Yes> Contrast> Simp-
le>Threshold), it was determined that a form of thresholding,
either b/w or the magic wand in MIB or Amira, could be used
to segment the cardiac mitochondria. This was done and the
segmentation and subsequent reconstructions are shown in
Figures 10(B) and (C).

For the cardiac muscle nucleus, the same segmenta-
tion procedure was used as for the skeletal muscle. The
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(D) Foetal Psoas Mitochondria Volume
12

Volume/pm?

Mitochondria

Fig. 6. Examples showing the complex morphology of mitochondria. (A) Nine consecutive images from the late foetal psoas (viewed from left to right).
The mitochondria have been segmented individually in different colours, in MIB, and their corresponding 3D reconstructions, from Amira, can be seen
in (B). Showing how mitochondria change over each 70 nm slice, requiring observation from the user to ensure that the correct structure is selected. All
scale bars are 1 pum. (C) Three single snapshots from the data series with the mitochondria segmented and the reconstructions of the mitochondria at
different orientations. The mitochondria, reconstructed in Amira and MIB, appear broken due to the selection method used. (D) Volume measurements
of the mitochondria, which show that there is a large difference between the Fiji segmentation and the Amira and MIB segmentations, due to the broken

appearance seen in the reconstructions. The images were taken at 12kx magnification, 7 nm resolution and an image size of 1024 x 1024 pixels All
scale bars are 1 um.
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Fig. 7. Digital reconstruction of mitochondria from a dataset with thinner sectioning and higher magnification. (A) Nine consecutive images (viewed
from left to right) from a larger dataset from the foetal psoas muscle. The images were taken at high magnification (18kx), high resolution (5 nm) and
the block was sliced at 40 nm section thickness. (B) The subsequent reconstructions from a portion of the total stack to highlight the reconstruction of
the cristae of the mitochondria using the thresholding tool in MIB and Amira to reconstruct the mitochondria. Scale bar is 1 pm.

workflow was (3D Reconstruction>Yes>Quantification>
Yes>Contrast>Varied>Size> Large>Distinct Border>Yes>
Automated Method (Watershed Segmentation in MIB)). The
dataset was composed of only 100 slices, image size 1024 x
1024 pixels, and the nucleus was only present for a por-
tion of the stack. As automated segmentation can be a time-
consuming method due to computational demands, it is not
efficient for small objects or datasets. Thus, the decision was
made to use manual segmentation combined with interpo-
lation. So, the nucleus was manually segmented over every
fifth slice, interpolated in between and any errors manually
corrected (Fig. 11).

A similar dilemma was found in the dataset from the locust
optic lobe of the Lobula Giant Movement Detector 2 (LGMD2)
neuron. This tissue was vastly different from the skeletal and
cardiac muscle already shown, as it was densely packed with
a variety of cells. The dataset analysed (100 slices at 6000 x
6000 pixels) was also much larger than the muscle data. The
aim, on this occasion, was rather different: to segment out
an entire dendrite and the following workflow was followed
3D Reconstruction>Yes>Quantification>Yes>Contrast>
Varied>Size> Large>Distinct Border>Yes>Automated
Method (Watershed Segmentation in MIB). As mentioned
earlier, this method takes time but there is a semiautomated
version of the watershed segmentation combined with the
brush tool in MIB, as described in the methods. Using this
method, the dendrite was selected and selection was repeated
every fifth slice and interpolation was used (Fig. 12). This tool
could be used when analysing nuclei, however, it is best used
on larger and more complex structures that would take time
to manually segment, such as large dendrites like the LGMD?2.

Discussion

Serial block face SEM is a powerful tool for cellular examina-
tion and, when combined with image analysis software, can
provide detailed qualitative and quantitative data. Since its re-
lease in 2004, the use SBF-SEM has steadily grown. In 2016,
there were 39 articles published and so farin 2017, there have
been 24 publications using this technique. The articles were
found by searching ‘serial block face scanning EM’ in PubMed
(https://www.ncbi.nlm.nih.gov/pubmed/) and only selecting
those that use the technique for their research, not a review of
the technique. With this burgeoning interest, there has been
an increased demand for training in the analysis of data. This
has drawn attention to the need for clarity and consistency in
the reporting of methods of data analysis and interpretation,
both qualitative and quantitative. However, getting started
with the software is not easy for new researchers and there is a
risk they will underutilize their data. Here, we have explained
the terminology of many analytical features found in the pro-
grammes and provided step-by-step protocols to instruct users.

We have compared manual and semiautomated segmenta-
tion methodsin order to help researchers chose the best options
for their analysis. The results show that the semiautomated
methods are less time-consuming but are not always accurate,
as shown by the quantification results of the mitochondria
segmentations. However, this segmentation was performed
with the thresholding tools, which work best on structures
of a single contrast that are distinct from their surroundings.
Thresholding can be a useful way to highlight the finer details
of structures, such as the cristae of the mitochondria, the web-
like appearance of the nucleolus and the chromatin within the
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Fig. 8. Examples of 3D reconstructions of segmented structures. This diagram depicts examples of the assembled reconstructions of all segmented features

from two separate skeletal muscle SBF-SEM datasets. Rows (A) and (B) show results from adult soleus muscle (from X serial sections; panel A1 indicates

a snapshot SBF-SEM image). Rows C and D show results from foetal psoas muscle (from X serial sections; panel B1 indicates a snapshot SBF-SEM image).

(C) and (D) The following features are colour-coded in the reconstructions: mitochondria, light blue; nuclei, dark pink/purple; chromatin, light pink;

nucleoli, dark blue; plasmalemma, green. All scale bars are 1 pum.

nucleus. In all cases, these semiautomated tools require some
form of manual input and manual correction. A prime exam-
ple of this is when using interpolation, which is best suited to
larger structures that do not change much over each slice, like
the nucleus of a cell, a whole cell or alarge portion of the tissue.
To optimize results, each object of interest should be assessed
individually in terms of the segmentation method. The tools
mentioned in this paper, whilst commonly used, are just some
that are available. There are many other possibilities some
of which have been briefly mentioned in this paper (e.g. cre-
ation of masks, smoothening, smart watershed and graph cut
segmentation) for users more familiar with the programmes.
Using a range of tools to efficiently and accurately segment,
multiple structures in a sample will give better results than
trying to use a ‘one-method-fits-all’ approach.

Although the results shown here are derived mostly from
guinea pig skeletal muscle, the described approaches have
been repeated on other types of tissue (guinea pig cardiac mus-
cle and locust optic lobe), which validate the findings shown.
From the results, a workflow was devised, Figure 9, to aid re-
searchers new toimage analysis. It provides recommendations
for segmentation tools based on a variety of factors, such as the
contrast and size of the structure, presence of any membrane
boundaries, the size of the dataset and most importantly the
objective of the analysis. The result can be qualitative, quanti-
tative or both and knowing which is required prior to analysis
is important. Knowing the objective is not only important for
the image analysis but also prior to that, when the datasets are
collected. For example, iflow-resolution images are collected to
reconstruct a whole cell, it is no good deciding after collection
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Fig. 9. Proposed workflow to aid in decision making when choosing appropriate segmentation methods for analysis of SBF-SEM data. The majority of
these segmentation methods can be used in MIB and Amira, with some exceptions, the watershed segmentation which is not shown in this paper. The
decision to use either MIB or Amira to perform the segmentations will depend on user preference and access to the software, as previously shown, the

two programmes yield similar results.
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Fig. 10. Segmentation and reconstruction of mitochondria from cardiac muscle. (A) Shows three raw images that are five slices apart from each other,

(B) is the same raw images with the segmentation of the mitochondria shown and (C) is the subsequent reconstructions at different orientations. The

images were taken at 5k x magnification, 18 nm resolution and an image size of 1024 x 1024 pixels. Scale bars are 1 um.

that the organelles should also be reconstructed, as they may
have insufficient clarity. The resolution of the image collection
should be determined by the smallest structure likely to be of
interest. However, although decisions on how to collect data
in pursuit of biological questions are made at the time of SBF-
SEM scanning, the outcomes are only revealed upon viewing
the serially collected digital images. Indeed, this is one of the
key benefits of SBF-SEM. Therefore, if tissue is plentiful, an iter-
ative approach to SBF-SEM data collection and analysis can be
beneficial in revealing much new biological information from
complex cell/tissue structures.

Before the data collection starts, the settings of the SBF-
SEM have to be adjusted to the needs of the researcher, for
example, the accelerating voltage and pressure. The voltage
and pressure are closely linked, if one is dropped, the other has
to be dropped; otherwise, there is aloss of contrast to the image.
We have found that at a lower kilovolts and lower pascals,
the amount of charging by the electron beam is reduced and

imaging at settings aslow as 2.5 kV and a pressure between 20
and 25 pa can yield excellent results. High vacuum can also be
used to give high-resolution images; however, it is limited to
dense tissues, as the electron beam affects the resin, the image
‘jumps’ and the datasets have to be aligned. However, these
parameters can be tissue- and machine-dependent. It is likely
that different versions of SBF-SEM systems can operate at high
vacuum better than others and we recommend researchers
test a combination of kilovolts and pascals to find one that
suits their tissue and their objective.

By adjusting the data collection parameters — section thick-
ness, magnification and number of pixels — the resulting
images will have different resolution, thus altering the ap-
pearance of the final reconstructions. A thinner section thick-
ness will result in a more detailed reconstruction, as smaller
changes in structures will be imaged. A higher resolution re-
sultsin a clearer image, so a better distinction between cellular
structures and higher detail of the structures is achieved. The

© 2018 The Authors. Journal of Microscopy published by John Wiley & Sons Ltd on behalf of Royal Microscopical Society., 270, 217-234



232 E.COCKS ET AL.

(A)

(8)

Fig. 11. Segmentation and reconstruction of nucleus from cardiac muscle. (A) Shows three raw images that are five slices apart from each other, (B) is

the same raw images with the segmentation of the nucleus shown and (C) is the subsequent reconstructions at different orientations. The images were
taken at 5kx magnification, 18 nm resolution and an image size of 1024 x 1024 pixels. Scale bars are 1 pum.

resolution, magnification and number of pixels are all linked.
A higher magnification results in a higher resolution image
but this decreases the field of view. To maintain the same
field of view but still increase resolution, the number of pix-
els can be increased. However an increase in pixel number
also increases the resulting image file size, which can be dif-
ficult to handle without a high-powered computer. For the
majority of this analysis the datasets were <3000 x 3000
pixels and <300 slices, so a laptop with 16 GB RAM and 2.4
GHz processing speed could cope. However for larger datasets
(e.g. >3000 x 3000 pixels and >400 slices) a more high
powered computer, such as with 64 GB RAM and 3.2 GHz
processing speed may be needed. In addition, if the time taken
to collect an image is very high, the electron dose can have a
detrimental effect on the resin and cause subsequent section-
ing artefact. An alternative would be multiple regions of inter-
est (ROIs) at a higher magnification but lower pixel number.
However, ROIs that overlap might be affected by the increased
exposure to the electron beam, as the areas are scanned re-
peatedly. Thus, some compromise may be required to balance

the need for high-resolution images but also images free from
sectioning and imaging artefacts.

We have provided a workflow to recommend segmentation
tools and also a detailed step-by-step protocol for four pro-
grammes, one of which is recently developed (MIB). The aim is
to provide a resource for researchers to refer to when starting
their analysis. Although there have been several publications
using SBF-SEM, the detail about the segmentation methods
is limited. We carried out a survey of the recent literature
(Supplementary file S6) where SBF-SEM has been utilized and
found that although all papers stated which programme they
had used, only around half stated the specific tools utilized. Of
these, the majority simply stated the type of segmentation and
only a small number of the articles described the segmentation
process in detail (Supplementary file S6). From the literature
survey, it was also apparent that different terms were used to
describe the segmentation tools, for example, manual segmen-
tation was sometimes referred to ‘by hand’ and thresholding
as ‘intensity-based’ (Meyer et al., 2017) or ‘contrast-based se-
lection’ (Pinali & Kitmitto, 2014 ). This could lead to confusion
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(€)

Fig. 12. Segmentation and reconstruction of the LGMD2 neuron from the optic lobe of the locust. (A) Shows three raw images that are five slices apart from
each other, (B) is the same raw images with the segmentation of the LGMD2 shown and (C) is the subsequent reconstructions at different orientations.
The images were taken at 1.5kx magnification, 9 nm resolution, section thickness of 60 nm and an image size of 6000 x 6000 pixels. Scale bars

are 5 pum.

for those new to this type of analysis. An article by Borrett and
Hughes (2016) reviewed earlier publications and they also
noted that there was often a lack of information given in arti-
cles on the methods used to analyse data from SBF-SEM. From
the analysis of the literature, manual segmentation appears to
be the preferred method. However, this could be from a lack of
knowledge or confidence rather than it being the most suitable
method of segmentation. For a detailed analysis of the different
software programmes and their functionalities, the reader is
directed to Kittelmann et al. (2016).

In addition, we recognize that this is a fluid research
environment where advances in computational analysis
tools are rapid. Therefore, our provision of openly acces-
sible raw datasets enables researchers who are developing
novel/improved analysis approaches to compare the func-
tionality of new tools with those used here. All researchers
should be encouraged to deposit future SBF-SEM datasets at
https://www.ebi.ac.uk/pdbe/emdb/empiar/, or similar open-
access repositories. We have not only provided detailed
step-by-step protocols but also videos to run alongside these

protocols. We have found that when teaching others to use
new programmes, it is much easier for them to learn with
textual and visual explanations available in tandem.

In conclusion, SBF-SEM is a powerful tool for analysing
cellular structures with high resolution in x-y—z planes.
However, current publications do not always give enough
information on the data analyses involved and with the myr-
iad of programmes and tools available, it can be a daunting
task for new researchers to train themselves. By following a
logical workflow such as that provided here, it is possible to
obtain qualitative and quantitative data on multiple struc-
tures from a single dataset, maximizing output from valuable
tissue.
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S5. Amira. Image analysis in Amira.
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SBF-SEM experimentation were assessed for the detail they
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